(ofo] /LU VR GAMING & ACCESSORIES

SWITCH with 2 Games & 1 amiibo Kit

with Extra Dock

» 326B Internal Storage » Custom NVIDIA Tegra Pracessor

» 6.2 1280 x 720 Capacitive Touchscreen

» Includes Two Joy-Con Controllers & Grip

» Three to Six Hours of Battery Life » Wirelessly Link up to Eight
Systems » Expandable Storage via microSD Cards

Switch 2 Games & 1 amiibo Kit with Extra Dock

(Neon Blue & Red Joy-Con) (NISWITCHNBRB) ... 417.55

Switch 2 Games & 1 amiibo Kit with Extra Dock

(Gray Joy-Con) (NISWITCHGYCB)

417.55

Switch Pro

Controller

» Compatible with
the Nintendo Switch
» Mation Controls
» HD Rumble
» Built-In amiibo Functionality

(NIHACAFSSKAJ............. 69.99

hTc ViveVR
Headset

» 2160 x 1260 Total Resolution
» Dual 90 Hz AMOLED Displays
» Upto 11.5x 11.5" Play Area
» Two Vive Controllers Included
» Two Base Stations Included

» Link Box

» SteamVR

» Windows Compatible
(HTVIVEVR)

- 599.00

i

NINTENDO

SWITCH

Joy-Con
Charging Grip

» For the Nintendo Switch

» Combines Joy-Con
Controllers

» Play While Charging

[NIHACAESSKA) e 29.99

elgato Game Capture HD60 Pro
High Definition Game Recorder

» Capture Gameplay in 1080p at 40 fps
» Live Stream to Twitch and YouTube
» Stream Command

» Flashback Recording

» Advanced H.264 Encoding
» HDMI Pass-Through to TV
» Record Gameplay to a Windows PC
» For PS4, Xbox One, Wii U, & Xbox 360

(ELGCHDGOPRQ)............ 184.99

elgato GameCapture HD60S

High Definition Game Recorder
» Capture Gameplay in 1080p at 60 fps

» Live Stream to Twitch and YouTube
» Stream Command

» Flashback Recording

» Advanced H.264 Encoding

» HDMI Pass-Through to TV

» Record Gameplay to a PC or Mac
» For PS4, Xbox One, Wii U, & Xbox 360

(EL6CHDAO0S) S 167.95

Joy-Con
Controllers (Gray)
» Compatible with
the Nintendo Switch
» Built-In Accelerometer
& Gyro-Sensor
» HD Rumble Technology
» Up to 20 Hours of Battery Life
» Can be Used Independently or in Grip as Single Controller
» Attaches to the Switch for Handheld Mode
(NIHACAJAAAA) 79.99
Neon Red/Blue (NTHACAJAARA) ..o 79.99

y

THRUSTMASTER® HOTAS
Warthog Flight Stick and Throttle

» Replica Joystick / Dual Throttles

» Replica Backlit Control Panel w/ 5 LEDs
» 1 Programmable Action Buttons
» 7 Hat Buttons and 1 Trim Wheel
» USB Plug-and-Play

» Realistic Idle and Afterburner Detent
» 3-D Magnetic Sensor Technology

» Realistic Weighted and Metal Design
(THHOTAS)

425.00

The trend of action figures interacting with the latest hot
game titles brings toys-to-life, utilizing a third-person
camera view and in-game power-up figures. Using the near
field communication (NFC) protocol, gamers can determine
the individual figuring’s proximity and save progress data
within the figure. Available individual figures and game
packs include Disney Infinity and amiibo. Check out the B&H
Interactive Gaming Figures page for the available figures.

B&H carries a wide assortment of console and PC games,
compatible with Sony, Xbox, Nintendo and Windows
based titles for every serious gamer. Games including x XBOXONE
Minecraft, MLB 15, Madden NFL, Guitar Hero, FIFA 16,

NBA 2K16, PGA Tour, Dragonbakk Xenoverse, Need for
Speed, Star Wars Battlefront, Duck Dynasty and many

more. Check out the B&H Gaming page for the latest E
available titles.

B:H 800-947-5534 + 212-444-6740
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SONY PlayStation 4 Pro Gaming Console

Go beyond 1080p with the Sony PlayStation 4 Pro Gaming Console. With updated graphics architecture and
support for 4K gaming, the PS4 Pro provides increased detail, higher-resolution graphics. High Dynamic Range
(HDR) gaming and content is also supported, which takes advantage of increased color depth and contrast.

» AMD Radeon Polaris Architecture » 8GB of GDDRb RAM » 1TB Storage Capacity

» Blu-Ray Disc Player » Sony DualShock 4 Wireless Controller » 4K Gaming Support

» High Dynamic Range (HDR) Support » 4K Video Streaming Services Supported

» 802.11ac Wi-Fi, Bluetooth 4.0 + LE » Optional PlayStation Plus Membership

PS4 Playstation 4 Pro Console only (SOPS41T8)

GAMING CONSOLES &XEE-ES8EIRKES

P mra

PS4 Pro Gaming Console & Extra Controller Kit (SOPS41TBCK)

PS4 Playstation 4 Pro Gaming Console & Extra Controller Kit (SOPS41TBCK]

THRUSTMASTER" T300RS Ferrari

Integral Racing Wheel Alcantara Edition

» Replica Wheel of the Ferrari 599XX EVo

» 11080° Force Feedback

» Detachable Racing Wheel

» Fully Adjustable Metal Pedals

» Thrustmaster Quick Release
System

» Hand-Stitched Alcantara Wrapping

» Compatible with Sony PS3 & PS4 and PC

(THT300FRWAE)

449.99

NYKO TypePad
for PS4

» QWERTY Keyboard

» Bluetooth Connectivity

» Attaches to the
DualShock 4 Controller

» Sony PlayStation 4 Compatible

(NYFOKBDSA) .. 2989

(®  DualShock 4

Powers  Charging Station

» Charges 2
DualShock 4
Controllers

» Sony PlayStation 4
Compatible

[POPSACS) .. 18.79

SPIEL=TEK Admiral
Gaming Chair (Blue)

» Padded, Ergonomic Seating Support
» Bi-Cast Leather Fabric

» Lumbar and Headrest Pillows

» Height and Tilt Adjustments

» 4D Multi-Directional Armrests

» Large 3" Casters

» Max Load of 330 b (150 kg)

BLUE (SPGC321BBL).

www.BandH.com

THRUSTMASTER" T150
Force Feedback Racing Wheel

» Force Feedback Haptic Response
» 270-1080° Wheel Rotation
» 13 Actions Buttons
& D-Pad
» Two Wheel-Mounted
Paddle Shifters
» Large, Optimized Pedal Set
» Compatible with PS3, PS4 & Windows PCs
[THTTBORS) oo

195.99

S ONYY PlayStation VR VR Worlds
Bundle (PS4)

» Experience VR
Gaming

» Comfortable,
Adjustable
Headset » 3D Audio Technology » Plug-and-Play

» PlayStation Camera and Two Move Controllers Included

» PlayStation VR Worlds Game Disc Included

(SOPSAVRWB) ... 399.99
DIY 1TB HDD
Drive Upgrade Bundle for the
PlayStation 4
' S &
(OWCSPS4HBS10) ....... .79.75

oPLawseat. Evolution
Alcantara Gaming Seat

» Supports Most
Driving Wheels
&Pedals

» Black Alcantara
Seat Covers

» 270 b (122 kg)
Maximum Weight

» Compatible with Most Gaming Systems

299.99

COMPUTERS

S ONY DualShock 4
» Clickable 2-Point Capacitive
Touch Pad
» Micro-USB Port, Stereo Headset Jack
» Built-In Mona Speaker » Light Bar, Vibration Support

Wireless Controller (Black, 2016 Version)
» Share Button, PS Button
» Dual Analog Sticks, D-Pad,
Game Buttons
» Bluetooth 2.1+EDR Wireless Connectivity
Available in White, or Black (S03001538) ... 43.62
THRUSTMASTER® T80

Racing Wheel
» Officially Licensed
by PlayStation
» Wheel and Pedal Set
» Rubber Texture Grip
» Two Sequential Gear Shift Paddles

» 11 Action Buttons + D-Pad

» Brake Pedal Has Progressive Resistance

» Central Clamping System

(THTBORW) [ . 99.99

SONYY PlayStation

VR Headset (PS4)
» Experience VR Gaming J

» Comfortable, Adjustable
Headset
» 3D Audio Technology
» Plug-and-Play
» PlayStation VR
Demo Disc Included
349.00

[SOPSAVRHS).....ccc

SONYY PlayStation (PS4)

Camera

» Navigate, Play,
and Share

» Hands-Free System Navigation

» Head and Gesture Tracking

» Voice Commands » Live Broadcasting

(SOPS4CAMUS) e 9.0

_ F16T Formula1and GT

Simulator Cockpit

» Compatible with Major Whels and Pedals

» Dual Position Cockpit
for F1/ 6T Racing

» Adjustable Accessory
Positions

» Sliding Seat

» Gear Shifter Holder Included

» Lumbar Support Cushion Includeds

(NENLRS006)




COMPUTERS

GAMING CONSOLES & ACCESSORIES

2% XBOX ONE

Microsoft Xbox0OneS Madden NFL 18 Bundle

40% smaller than the original Xbox One, the white Microsoft Xbox One S Madden B mones
NFL 18 Bundle is compact with a built-in power supply. Due to popular demand, .
the Xbox One S can now be placed horizontally or vertically with an optional stand. ﬁ

t

» 500GB Storage Capacity » Madden NFL 18 Download
» Xbox One Wireless Controller » Ultra HD Blu-ray Disc Player

» High Dynamic Range (HDR) Support » 40% Smaller than the Original Xbox One

» 10/100/1000 Mbps Gigahit Ethernet

» 80217 Wi-Fi » Xbox SmartGlass Support

» Stream Video in 4K via Content Providers

» Integrated IR Blaster in the Front as well as an IR Out in the Back

Micresoft Xbox One Wireless Controller
(2016 Version, White)
» Built-in Stereo Headset Jack

» Impulse Triggers

» Refined Bumpers

Tt
e
® - 8.0

» Textured Grips

» Bluetoath Technology

» Up to 2X the Wireless Range . .

» Xbox One/Windows 7, 8, & 10 Compatible

Available in Black, Blue, White (MIXBOWLC) Call or Log-On
Xbox One Gears of War 4 Crimson Omen (MIWL300001) ........ Log-On

THRUSTNVIASTER" TMX Force

Feedback Racing Wheel

» 11" Ergonomic,
Rubber-Coated Wheel

» 270-900° Wheel Rotation

» 12 Action Buttons & D-Pad

» Two Wheel-Mounted
Paddle Shifters » Large, Optimized Pedal Set » Built-In Official
Xbox One Buttons » Adjustable Force Feedback System

» Officially Certified for Xbox One

[THRWPSXOW) . 199,99

THRUSTMASTER" Ferrari 458 Spider
Racing Wheel for Xbox One

» For Xbox One D
» Officially Licensed n‘

by Ferrari/Xbox One o) N
» Wheel and Pedal Set & § 4
» Two Red Rubber- T 4

Textured Grips
» Metal Paddle Shifters » Adjustable Sensitivity
» Kinect Detection LED » Central Clamping System
[THSRW) 99.99

Microsoft Kinect Sensor
for Xbox One

)

» Cortana Integration
» Use Your Voice & Gestures
» Microsoft Xbox One Compatible

(MIKSXBOBLK) oo 489

+ 0’
a

Xbox One S Madden NFL 18 Bundle
[T T RV O —

[MIXBPS)

THRUSTMASTER"® T\ Racing Wheel
Leather Edition

» Wheel, Base, and Pedal Set

» TM Leather 28 GT Wheel

» TX Racing Wheel Servo Base

» 3-Pedal T3PA Pedal Set

» Force Feedback Base

» Hall Effect AccuRate Technology

» Dual-Belt Mechanism » USB Connector » Central Clamping
System » Compatible with Xbox One and Windows

(THTXRWLEBLK) oo

THRUSTMASTER® T3PA-PRO
Add-On Gaming Pedal Set

» Floor-Mounted Position (F1 Style)
» Suspended Position (GT Style)

» AUl-Metal Pedals

» Fully Adjustable Pedals

» Pedals with Individual Pressure Settings ¥
» Spring Brake Mod Included

» Supports T-Series Racing Wheels
» Compatible with PC, Xbox One, PS3, PS4

(THT3PAPRO) 147.23

Micresoft Xbox One
Play & Charge Kit

» Blncluded Charging Cable
» Rechargeable Battery Pack
» Up to 4 Hours Per Charge
» Play & Charge at the
Same Time
» Compatible with Xbox One
Controllers

8 B0 ONE

(MIXBONEPCKIT) oo

i 279,00

Microsoft XhoxOne X

Gaming Console

v 649,99

J—7 ]

Microsoft Xhox Elite

Wireless Controller

» & Paddles and
Hair Trigger Locks

» 3 Different Sets of
Thumbsticks

» Faceted and Traditional
D-Pads

» 3.5mm Stereo Headset Jack » Xbox Elite Controller App

» Microsoft Xbox One Compatible » Windows Compatible

(MIEWLCXBIBK) ... Call or Log-On

» Native 4K Gaming | HOR10 Support » 2.3 GHz Custom 8-Core AMD CPU
» 126B of GDDRS RAM » 4K UHD Blu-ray Disc Player

» 1TB Storage Capacity » Dual-Band Wi-Fi | Bluetooth | IR Blaster

» USB 3.0 | Ethernet » HDMi 1.4b In | HDMI 2.0b Out

» DTS5.1 ] Dolby Digital 5.1 » Xbox One Controller Included

499.99

THRUSTMASTER® THSA
Add-On Shifter

» H-Pattern or Sequential Shift-Plates
» Hall Effect AccuRate Technology

» Metal Gear Stick and Construction

» 360° Adjustable Clamping System

» PC/PS3 /PS4 [ Xbox One Compatible

(THTHBAAOGBSH)

Call or Log-On

Razer Atrox Arcade Stick
Gaming Controller for Xbox One

» Premium Quality Sanwa Components
» 8 x Tournament-Grade

Sanwa Buttons
» 1x Precision 8-Way Joystick
» Internal Storage Compartments
» One-Touch Access to Internals & Storage
» 13" Detachable Screw-Lock USB Cable
» Additional Bat Top Included

(RAAASXBONE) 199.89

@ HyPERKIN' X91Retro Controller
pavwaLwvewas for Xbox One and PC

» Combines the Classic Look of a 90s-Style
Controller with Features of a
Modern Controller
» Retra Design/Modern Ergonomics . e 9 .’.

» Premium Build Rivals its ) + . °
Modern-Style Competitors m—

» Precision Analog Triggers

» 3.5mm Headset Jack

(HYMOTO28WH) ..o

B:H 800-947-5534 + 212-444-6740



& iPad Pro

The iPad Pra from Apple now has an expansive Retina display, double the CPU power of the iPad Air 2,
improved Multi-Touch technology and access to over 850,000 apps. With up to 5.6 million pixels, the iPad
Pro makes it easier to work in professional environments including editing 4k video.

» Fingerprint Identity Sensor Built Into The
Home Button

» Apple A9X CPU with 64-Bit Architecture

» 2.bx Faster Than iPad Air

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2

» Touch ID Fingerprint Reader

» iSight Camera with 8MP phatos

» Video Recording with Slo-Mo, Stabilization &
Time Lapse

»i0S 10 and iCloud

» Front 1.2-Megapixel FaceTime HD Camera

» Rear b-Megapixel iSight Camera

» Lightning Connector, AirPlay Mirroring

12.9"

» 2732 x 2048 Native Resolution

» Wi-Fi + Cellular & Wi-Fi Only Models available
» 25668, 12586B & 64GB Configurations
STARTING AT (WI-FI ONLY) 77.99

STARTING AT (WI-FI+CELLULAR).......ccoo 999.00
*Available in space gray, silver and gold finishes

10.5"

» Apple A10X SoC with M10 Coprocessor

» 2224 x 1668 Screen Resolution (264 ppi)

» 51268, 25668 & 64GB configurations

STARTING AT (WI-FIONLY).....ooooo 599.00
STARTING AT (WI-FI+CELLULAR).......ccooovv 749.00
*Available in space gray, silver, rose gold and gold finishes

9.7"

» 2048 x 1536 Native Resolution

» Wi-Fi + Cellular & Wi-Fi Only models available
» 25668, 125868 & 32Gb configurations
STARTING AT (WI-FIONLY) ..o 599.00

STARTING AT (WI-FI+CELLULAR)...........oc... 729.00
*Available in space gray and silver

I22\03 COMPUTERS

#iPad mini 4

The iPad mini 4 from Apple is just 6.Tmm thin and weighs less than

1 pound. Its smaller form factor makes it easier to hold in one hand.
This iPad mini 4 comes in a space gray, silver and gold finishes. The
tablet's 7.9" Retina Display features a native resolution of 2048 x 1536
at 326 ppi. The Retina Display’s capacitive touchscreen lets you utilize
all the multi-touch gestures of i0S 9.

» 7.9"1PS LCD Multi-Touch Retina Display
» 2048 x 1536 Native Resolution

» Touch ID Fingerprint Reader

» Apple A8 CPU with 64-bit architecture

» 1.3x faster than iPad mini 2

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2
»i0S 9 and iCloud

» iSight Camera with 8MP photos

» Video Recording now includes Slo-mo function
»i0S 9 and iCloud

» Lightning Connector, AirPlay Mirroring

Wi-Fi + Cellular Wi-Fi Only
STARTING AT 529.00 STARTING AT 399.00
& iPad

Learn, create and surf with the iPad from Apple. The LED-backlit
9.7" 2048 x 1536 Retina IPS LCD display's anti-reflective
coating reduces glare by 56% and uses a single-layer
design to eliminate internal reflectance for richer
colors, greater contrast, and sharper images. The
iPad features Apple Touch ID technology, which
uses your fingerprint to unlock your device as
well as make secure purchases in iTunes,
iBooks, and the App Store. The 1.ZMP front
and 8MP rear camera let you take high-
resolution phatos and videos as well as videochat

in HD while dual microphones reduce background noise. The iPad runs i0S 10, featuring Siri and iCloud.

» 9.7 IPS LCD Multi-Touch Retina Display

» 2048 x 1536 Native Resolution

» A9 chip with 64-bit architecture with M9 Chip
» 1.03 b and 7.5 mm thin

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2

» Touch ID Fingerprint Sensor

» Front 1.2-Megapixel FaceTime HD Camera
» Rear 8-Megapixel 1080p iSight Camera

» Lightning Connector, AirPlay, AirDrop

» Gyro, Accelerator, Ambient Light Sensor

Wi-Fi + 4G LTE
STARTING AT
*Available in space gray, silver and gold finishes

Wi-Fi Only
STARTING AT
*Available in space gray, silver and gold finishes

459.00 329.00

ACCESSORIES

.’ Authorized Reseller Apple Smart Cover

il ;

49.00

For 10.5" iPad Pro

» Thin, Minimal Design

» Magnetic Hinge

» Doubles as a Keyboard Stand

» Wake on Open & Sleep on Close

(APMQ082ZMA)

For 12.9" iPad Pro

» Thin, Minimal Design

» Magnetic Hinge

» Doubles as a Keyboard Stand

» Wake on Open & Sleep on Close

(APMQ0G2ZMA)

59.00

Apple Pencil WPPENCIL wo e

Apple Smart Keyboard (APIPPSKB) 169.00
Apple Lightning Digital AV Adapter

» Male Lightning Connector » Female HDMI Port

(APMDB26AMA) 44.95
Apple Lightning To USB Charge & Sync Cable

3.3 (APLUSBC)...............17.99 6.5 (APMDS19AMA).......... 29.00

Apple Lightning to USB Camera Adapter
» For iPad with Retina Display or iPad Mini

(APMLUCADP) 34.95
Apple Lightning to VGA Adapter

» For iPhone, iPad and iPod

» Mirror Device's Display on Bigger Screen

(APMLVADP)) 46.99

Apple Lightning to SD Card Camera Reader

» For iPad Air, iPad 4th Gen & iPad mini

» View Photos From SD Card » Supports JPEG, RAW, H.264, MPEG-4
(APMLSDCR) 29.00
Apple EarPods with Remote and Mic

» Enhanced Bass Response » Resistant to Sweat and Water Damage
(APIPODEP) 29.00
Apple Lightning to 30-pin Adapter

» Supports USB Audio

(APL3OP) ... 22.25 8" (APL3OPAD) ........ccoo.. 38.00
Apple Lightning to Micro USB Adapter

» For iPhone/iPod/iPad With Lightning

» Connects to Micro USB Cable » Charge and Sync Device
(APMDB20AMA

17.50

www.BandH.com BSH



TABLETS

I COMPUTERS

8" Tab 4 8 16GB Tablet
(Wi-Fi Only, Slate Black)

» Snapdragon 425 Quad-Core up to 1.4 GHz
» 16B RAM, 16GB Storage

» §71280 x 800 IPS Display

» 802.11b/g/n Wi-Fi, Bluetooth 4.0

» Micro-USB, microSD Slot

» Android 7.0

(LEZA2B0009) 127.99

8" Yoga Tab 3 16GB Tablet

» 1.3 GHz ARM Cortex-A7 Quad-Core

» 16B of LPDDR3 & 166B of eMMC Storage

» 8" IPS 10-Point Touch Display

» 1280 x 800 Screen Resolution » Adreno 304 Graphics
» 802.11b/g/n Wi-Fi, Bluetooth 4.0

» microSDXC Expansion Slot

» Rotating 8MP Webcam » 6200mAh Battery Capacity
» Android 5.1 Lollipop

(LEZAD90008) 149.00

/iSUS ZenPad 8.0 Z380M
16GB Tablet (Wi-Fi, Dark Gray)

» 1.3 GHz MediaTek MT8163 Quad-Core CPU

» 26B of RAM + 16GB Onboard Storage

» §”IPS 10-Point Touch Display » 1280 x 800 Screen Resolution
» Mali-450 GPU » 2MP Front + bBMP PixelMaster Rear Camera
» 802.11a/b/g/n Wi-Fi, Bluetooth 4.0

» Micro-USB, microSD Slot, AUX Jack

» Front Speakers with DTS HD Premium Sound

» Android 6.0 Marshmallow

(ASZ380MA2GR)

PEnsuncg 326B Galaxy Tab S3
9.7” Wi-Fi Tablet
» 9.7" Super AMOLED HDR Display

» QYGA (2048 x 1536) Native Resolution » 1.3 GHiz Snapdragon 410CPU
» 2.15 GHz & 1.6 GHz Dual-Core Processors » 1568 of RAM » 7.0" IPS Multi-Touch Display

» 4GB of RAM & 3268 of Onboard Storage » 1280 x 800 Screen Resolution
» microSD Expansion Slot » Adreno 306 GPU » 8GB of Internal Storage

» Dual-Band Wi-Fi + Bluetooth 4.1 » Micro-USB 2.0 Port, microSDXC Slot
» 5MP Front Camera + 13MP Rear Camera : » SMP Rear Camera + 2MP front Camera

/iSUS 326B 7580C-B1 ZenPad S
8.0” Wi-Fi Tablet (Black)

» 8" 10-Paint Multi-Touch IPS LCD Display

» 2K 2048 x 1536 Native Resolution

» Intel Atom 23530 Quad-Core Processor

» 268 of RAM & 32GB of Onboard Storage

» microSDXC Expansion up to 12868 » 802.11b/g/n Wi-Fi + Bluetooth 4.0
» 5 MP PixelMaster Rear Camera » ASUS TrueVivid Technology

» Up to 8 Hours of Battery Life » Android Lollipop 5.0”

(ASZP8SZ580C) 194.35

w GalaxyTabA 7"
8GB Tablet (Wi-Fi Only, Black)

» Fingerprint Scanner, USB-C Port ) » 802.11b/g/n Wi-Fi, Bluetooth 4.0 » Android 5.1.1 Lollipop
» Includes S Pen » Android 7.0 Nougat (SAGTA7BLE) 149.00
(SAGTS397BLK) 599.00

(SAGTS397SLV) 549.98 Galaxy TahS28”
W Wi-Fi Tablet (2016, Black)
‘W 16§B ﬁalaxy Tab_A 8._0 » 8 Super AMOLED Multi-Touch Display
Wi-Fi Tablet (Titanium) » (XGA (2048 x 1536) Native Resolution
» 8.0" TFT Touchscreen Display » (Quad-Core 1.8 GHz and 1.2 GHz Processors
» XGA 1024 x 768 Native Resolution
» 1.2 GHz Quad-Core Processor

» 36B of RAM & 32GB of Onboard Storage
» 1.56B of RAM & 16GB of Onboard Storage

» microSD Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.1
» 2.1MP Front Camera + 8MP Rear Camera

» MicroSD Expansion Slot » 802.11a/b/g/n Wi-Fi, Bluetooth 4.1

» IMP Front and 5MP Rear Cameras

» Fingerprint Scanner » 4000mAh Battery Capacity

» Android 6.0 Marshmallow > Available in Black, Gold and White
» 4200mAh Battery » Kids Mode and Multi Window
» Android Lollipop 5.0

(SAGTS280BLK) 349.99
(SAGTAB16ST) 188.70

© ematic 7" EGQIATBL

Lenovo. M8 8GB Tablet (Wi-Fi, Black)
4 §"Tab438 » 7" Capacitive Multi-Touch Display
16GB Tablet (Wi-Fi Only)

» 1024 x 600 Native Resolution
» Snapdragon 425 Quad-Core up to 1.4 GHz » 1.3 GHz NVIDIA Tegra 3 Mobile Quad-Core
» 26B of RAM, 16GB of Storage » Android 4.0 Ice Cream Sandwich 0S
» §71280 x 800 IPS Display » 16B of RAM, 8GB of Storage, 2GB Cloud
» 802.11b/g/n Wi-Fi | Bluetooth 4.0 » 802.11b/g/n Wi-Fi, Bluetooth 3.0+HS
» Micro-USB | microSD Slot

» Expandable up to 326B via MicroSD Slot

» Android 7.0 Nougat » Mini-HOMI Port, Micro-USB 2.0 Port
» Two High-Quality Speakers with Dolby Atmos » 2-Megapixel Front Camera » Red Drop-Safe Bumper
(LEZA300046) 79.99 (EMEGQ3478L) 53.12

B:H 800-947-5534 + 212-444-6740



TABLETS [elely| -0k p=3¢]

/iSUS 9.7” TenPad 35 10
64GB Tablet (Wi-Fi)

» 2.1 GHz MediaTek 8176 Turbo Six-Core

» 146B of LPDDR3 RAM » 9.7" IPS Multi-Touch Display

» 12048 x 1536 Screen Resolution » IMG PowerVR
6X6250 Graphics » 164GB of eMMC Storage

Microsoft Surface Pro 12.3”

Microsoft combines the portability of a tablet and the
performance of a laptop with the 2017 version of the
Surface Pro 12.3" Multi-Touch Tablet. Weighing just 1.73
pounds and measuring just 0.33" thin, the Surface Pro
packs a 7th-Gen (Kaby Lake) 2.6 GHz Intel Core i5-7300U

» 802.11ac Wi-Fi & Bluetooth 4.2 processor into a magnesium casing with a silver finish. Use
» 1USB Type-C / microSD / 2-in-1 Audio Jack the multi-position Kickstand and the Surface Pro Type Cover
» GPS / 6-Sensor / Fingerprint Scanner » 1Android 6.0 Marshmallow (sold separately) to turn the Surface Pro into a laptop. The updated Surface Pen (sold separately)

Titanium Gray (ASZS00MCIGR). . 289.00  Glacier Silver (ASZS00MCISU. 289.00 | Provides up to 4036 levels of pressure sensitivity

» 12.3" PixelSense 10-Point Touch Display » 2736 x 1824 Screen Resolution (267 ppi)
» 802.17ac Wi-Fi, Bluetooth 4.0 » USB 3.0 Type-A, Mini DisplayPort

» microSD Slot » Windows 10 Pro

/=SS 10.1” ZenPad 10 Z300M
16GB Tablet (Wi-Fi, Dark Gray)

RAM Storage Graphics SKUS Price
» 1.3 GHz MediaTek MT8163 Quad-Core » 2GB DDR3L RAM, 86B 25668 SSD Intel HD Graphics 620 MISPI58256 Call or Log-On
166B eMMC Storage » 10.1" 1280 x 800 IPS Multi-Touch Display 166B 5126B SSD Intel Iris Plus Graphics 640 MISPI716512 2,199.00
» 520 Mhz Malj T720MP2 » 2MP Front & 5MP PixelMaster Rear Camera 8GB 256GB SSD Intel Iris Plus Graphics 640 MISPI78256 Call or Log-On
» 8[]2“3/[]/9/” Wl'Fl, Bluetooth 4.0 » M|Cr0'USB, microSD 4GB 12868 SSD Intel HD Braphlcs 620 MISPI54128 999.00
N . . , . 4GB 12868 SSD Intel HD Graphics 615 MISPM34128 Call or Log-On
Slot, AUX Jack » Front Speakers with DTS HD Premium Sound » Android 6.0 Marshmallow 1468 1TBSSD inte s Pl Graphics 640 MISPI7161 Callor Log-On

(ASZ300MAZGR).......... 179.00

W 16GB Galaxy Tab E

9.6” Wi-Fi Tablet (Black)

» 9.6" TFT Touchscreen Display » 800 x 1280 Native Resolution

» 1.2 GHz Quad-Core Processor » 1.56B of RAM & 16GB of Onboard Storage
» MicroSD Expansion Slot » 802.11a/b/g/n Wi-Fi, Bluetooth 4.1

» 2MP Front and 5SMP Rear Cameras » 5000mAh Battery
» Android 5.1 Lollipop

(SAGTE96) 199.00

8 Tab 4 8 Plus

(Wi-Fi/LTE, Slate Black)
» 2.0 6Hz Snapdragon 625 Octa-Core » 2GB of RAM | 1668 Storage + microSD Slot Broceson RAM  Storage Graphics SKU Price

» 87 1PS 10-Point Multi-Touch Display » 1920 x 1200 Screen Resolution 24 GHzlntel Core6-63000 | BGB | 25668 5D NVIDIA 6PU MIMSBIB8256N Log-On
» Qualcomm Adreno 506 Graphics > Fingerprint Sensor, FM Tuner 24 GHzIntel Core -63000 | BGB | 1286B.SSD | Intel HD Graphics 520 MIMSBIESI28 | 1,499.00
» LT, 802.11ac Wi-Fi, Bluetooth 4.1 » USB Type-C Port and Combo Audio Jack L6GHzIntel Core7-6600 | 1668 5126BSSD | NVIDIAGeForce GTX 966M | MISBAITI6S12 | 2,799.00
» 5MP Front Camera + 8MP Rear Camera » Android 7.1 Nougat

(LEZA2H0000) 229.99

Microsoft 13.5” Surface Book

The Surface Book Multi-Touch 2-in-1 Notebook is a high-performance
laptop/tablet hybrid with power and versatility. It packs an Intel 6th gen
(Skylake) dual-core processor into a magnesium casing with a silver
finish. Use the tactile keyboard and touchpad to stay productive or
detach the screen from the dock and use the Surface Book as
a tablet. The included Surface Pen provides
added precision thanks to its 1024 levels of
pressure sensitivity.

» 13.5" PixelSense Detachable Display

» 3000 x 2000 Screen Resolution (267 ppi)
» USB 3.0, Mini DisplayPort, SD Card Slot » 802.11ac Wi-Fi, Bluetooth 4.0
» Surface Pen Included » Windows 10 Pro

Micresoft Surface Pen Micresoft Surface Pro
for Surface Pro 4 Type Cover

10.1” Tab 4 10 16GB Tablet » Bluetooth 4.0 LE Connectivity » For Surface Pro

(Wi-Fi Only, Slate Black)

» Snapdragon 425 Quad-Core up to 1.4 GHz

» 26B RAM, 16GB Storage » 10.1" 1260 x 800 IPS Display 1

» 802.11b/g/n Wi-Fi, Bluetooth 4.0
» Micro-USB, microSD Slot » Android 7.0

» Aluminum Casing 3/4 & Surface Pro
» Palm Block Technology » Full QWERTY
» 1,024 Levels of Pressure Keyboard
Sensitivity » Instant Editing » Dedicated Shortcut Keys
and Formatting Tools » LED Backlighting » Ultra-Slim

» 1-Click Access to OneNote and Cortana » Built-In Accelerometer » Magnetic Base
(LEzAzIO00) 179.99 » Works with Surface Pro 4 & Surface Boak » Large Glass Trackpad

» Works with Surface 3 & Surface Pro 3 » Folds Back Completely for use in Tablet Mode
SONY 13.3" 1668 DPT-RP1 Dlgltal Paper System (MIEYU0OOD1) 99.00 (MIFMMOOODT) ... Call or Log-On

» 13.3" Flexible Electronic Paper Display
» 1650 x 2200 Screen Resolution
» Multi-Touch Support » 16GB Storage Capacity

Microsoft .

Surface Dock

» Micro-USB Connector » 802.11ac Wi-Fi Connectivity 10.1” Yoga
MIPD900003) oo 199,99
» Secure Document Encryption [ : Tab 3 Plus
» Digital Paper App Supported » Print to Digital Paper Option Power Supply for 32GB Tablet
» Stylus Pen Included Surface Pro 3 '/
(SODPTRP1B) 699.99 (MI04000001) .............. 60.00 / (LEZATNOOO7)..... oo 289.99

www.BandH.com
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SCET Aspire Switch Alpha 12

» 868 of LPDDR3 RAM » 12" IPS Multi-Touch Display
» (HD 2160 x 1440 Screen Resolution

» Integrated Intel HD Graphics 520

» microSDXC Slot

» Detachable Backlit Keyboard Included
» 802.11ac Wi-Fi & Bluetooth 4.0

» USB 3.0/ USB 3.1 Type-C

» Windows 10 Home (64-bit)

2.3 GHz Intel Core i5-6200U Dual-Core, 256GB SSD (ACI56200U256)..............cc..ccoc..

. 599.00

» 15.6” Envy X360
Notebook

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 8B of DDR4 RAM | 1TB 7200 rpm SATA HDD
» 15.6" 1920 x 1080 IPS Touchscreen

» Integrated Intel HD Graphics 620

» SD Card Reader

» USB 3.0 Type-C | USB 3.0 Type-A | HOMI

» 802.11ac Wi-Fi | Bluetooth 4.2

» Built-In 720p Webcam, Mics, and Speakers » 360° Hinge » Windows 10 Home (64-bit)

(HEEX360W2K50)

879.00

@ 11.6” Inspiron 11 3000 Series
Multi-Touch 2-in-1 Notebook (Red)

» 1.6 GHz Intel Pentium N3710 Quad-Core

» 4GB DDR3L RAM, 5006B 5400 rpm HOD

» 11.6” 1366 x 768 Touchscreen

» Integrated Intel HD Graphics 405 » microSD Card Reader
» 802.11b/g/n Wi-Fi & Bluetooth 4.0

» USB 3.0, USB 2.0, HDMI 1.43

» Built-In 720p Webcam, Mic, and Speakers » 360° Hinge » Windows 10 Home (64-Bit)

(DEI31683270R)

389.95

@ 13.3" Inspiron 13 5000 Series
Multi-Touch 2-in-1 Notebook
» 2.4 GHz Intel Core i3-7100U Dual-Core

» 4GB of DDR4 RAM, 17B 5400 rpm 2.5 HDD

» 13.371920 x 1080 IPS Touchscreen

» Integrated Intel HD Graphics 620

» SD/SDHC/SDXC Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.0

» 360° Hinge

» Windows 10 Home (64-Bit)

(DEI53783031)

554.99

@ 15.6” Inspiron 15 5000 Series
Multi-Touch 2-in-1 Notebook

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 1668 of DDR4 RAM, 51268 SSD

» 15.6" 1920 x 1080 Touchscreen

» Integrated Intel HD Graphics 620

» SD Card Reader

» 802.17ac Wi-Fi, Bluetooth 4.0

» USB 3.0, USB 2.0, HOMI » 720p Webcam, Dual Mics, and Speakers

» 360° Hinge » Windows 10 Home (64-Bit)

(DEI557810050)

895.00

/i=>uU=" 10.1” Transformer Mini T102HA
Multi-Touch 2-in-1 Notebook

» 1.44 GHz Intel Atom x5-28350 Quad-Core

» 4GB DDR3 RAM, 1286B eMMC Flash Storage
» 10.17 1280 x 800 IPS Touchscreen Display

» Integrated Intel HD Graphics 400

» SD Media Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.0

» USB 2.0/ Micro-USB / Micro-HDMI

[ASTI02HADAGR).......ooo o

15.6” Flex5

Multi-Touch 2-in-1 Notebook
» 1.7 GHz Intel Core i7-7500U Dual-Core

» 1668 DDR4 RAM, 25668 SSD + 1TB HDD
» 15.6" 1920 x 1080 IPS Touchscreen

» NVIDIA GeForce 940MX (26B GDDRS)

» 4-in-1 Media Card Reader

» 802.17ac Wi-Fi, Bluetooth 4.1

» USB 3.0, USB Type-C, HOMI

» Windows 10 Home (64-Bit)

(LEBOXBOOOB)......ooo oo

14" Flex 4 Series

Multi-Touch 2-in-1 Notebook

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 86B of DDR4 RAM, 51268 SSD

» 14" FHD 1920 x 1080 IPS Display

» AMD Radeon R5 M430 Graphics

» 4-in-1 Media Card Reader » 802.11ac Wi-Fi, Bluetooth 4.0
» USB 3.0, USB 2.0, HDMI » Gigabit Ethernet

» 360° Hinge, Fingerprint Reader » Windows 10

(LEBOVDOOOKUS) ...

10.1” Miix 320

Multi-Touch 2-in-1 Notebook

» 1.44 GHz Intel Atom xb-Z8350 Quad-Core
» 4GB DDR3L RAM, 64GB eMMC SSD

» 10.171920 x 1200 IPS Touchscreen

» Integrated Intel HD Graphics 400

» microSD Media Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.1

. 819.99

» 1x USB 3.0 Type-C, 2 x USB 2.0 Type-A » 1 x Micro-HDMI
» 2MP Front Webcam, 5MP Rear Webcam » Windows 10 Home
(LEM32080XFOD) ... i 349,99

<ICEr Aspire Switch Alpha 12p
Multi-Touch 2-in-1 Notebook

» 2.3 GHz Intel Core ib-6200U Dual-Core

» §6B of LPDDRI RAM » 12" IPS Multi-Touch Display

» (QHD 2160 x 1440 Screen Resolution

» Integrated Intel HD Graphics 520

» 25668 SSD & microSDXC Slot

» Detachable Backlit Keyboard & Stylus Included

» 802.11ac Wi-Fi & Bluetooth 4.0

» USB 3.0/ USB 3.1 Type-C » Windows 10 Home (64-bit)
(ACI562000256)...--. oo

. 999,00

800-947-5534 + 212-444-6740




@ 15.6” Inspiron 15 5000 Series Notebook
» 2.4 GHz Intel Core i3-7100U Dual-Core

» 86B DDR4 RAM, 17B HDD

» 15.6" 1366 x 768 Display

» Integrated Intel HD Graphics 620

» SuperMulti DVD Drive, SD Card Reader

» 802.11b/g/n Wi-Fi, Bluetooth

» USB 3.0, USB 2.0, HOMI

» Windows 10 Home (64-Bit)

(DEIT51556637)

WINDOWS NOTEBOOKS [e{ely|-Vay =133

499.99

/iSUUS" 14" ZenBook UX430UA
Notebook

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 86B DDR4 RAM | 2566B M.2 SSD

» 1471920 x 1080 Anti-Glare Display

» Built-In Fingerprint Reader

» Integrated Intel HD Graphics 620

» SD/MMC Media Card Reader

» 802.11ac Dual-Band Wi-Fi | Bluetooth 4.1
» USB Type-C | USB 3.0 | Micro HDMI » ASUS Nano Bezel Design » Windows 10 Home (64-Bit)

[ASUX430UADB7)

849.00

/iU’ 15.6” $510UA Notebook

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 86B of DDR4 RAM, 12868 SSD + 1TB HDD
» 15.6” 1920 x 1080 Display

» Intel HD Graphics 620

» SDXC Card Reader

» USB 3.0, USB 3.0 Type-C, USB 2.0

» 802.11ac 2x2 MU-MIMO, Bluetooth 4.1

» HDMI 1.4 Port

» ASUS Nano Bezel Design -
» Windows 10 Home (64-bit)

799.00

(ASS510UADBT1)
@ 15.6” XPS 159560
Multi-Touch Notebook

» 2.5 GHz Intel Core i5-7300HQ Quad-Core

» 868 of DDR4 RAM, 256GB SSD

» 15.6” 3840 x 2160 Multi-Touch Display

» NVIDIA GeForce GTX 1050 GPU (4GB GDDRS)
» SDXC Card Slot

» 802.1ac Wi-Fi, Bluetooth 4.1

» Thunderbolt 3, HOMI, USB 3.0

» Windows 10 Pro (64-Bit)

(DEXPS15JYDMO)

7 15.6” ProBook 450 G4
Notebook

» 2.5 GHz Intel Core i5-7200U Dual-Core

» 86B DDR4 RAM + 2566B M.2 SSD

» 15.6” 1920 x 1080 Anti-Glare Display

» Integrated Intel HD Graphics 620

» SuperMulti DVD Drive + Media Card Reader
» 802.11a/b/g/n/ac Wi-Fi & Bluetooth 4.2

» USB Type-C/USB 3.0/ HDMI/ VGA » Windows 10 Pro

(HE45064Y9F95)

1,889.00

789.00

www.BandH.com Bsu

@ LG 15.6” gram 15.6
Multi-Touch Notebook (Dark Silver)

» 2.7 GHz Intel Core i7-7500U Dual-Core
» 166B DDR4 RAM, 51268 SSD

» 15.6” 1920 x 1080 Multi-Touch IPS

» Integrated Intel HD Graphics 620

» MicroSD Media Card Reader

» 802.11ac Dual-Band Wi-Fi, Bluetooth
» USB 3.0, USB 2.0, USB Type-C, HOMI
» Windows 10 Home (64-Bit)

(LG152970AAAS)
@ 15.6” Inspiron 15 3000 Series Notebook
» 2.5 GHz Intel Core i5-7200U Dual-Core
» 126B DDR4 RAM, 17B 5400 rpm 2.5 HDD
» 15.6" 1366 x 768 LED Backlit Display
» Integrated Intel HD Graphics 620
» SuperMulti DVD Burner
» SD/SDHC/SDXC Card Reader
» USB 3.0, USB 2.0, HDMI 1.4a
» 802.11b/g/n Wi-Fi, Bluetooth 4.0 o
» 10/100 Fast Ethernet Port
» Windows 10 Home (64-Bit)

(DEI356758408)

599.00

15.6” ThinkPad E560 Notebook
» 2.3 GHz Intel Core ib-6200U Dual-Core

» 4GB of DDR3L RAM, 5006B 7200 rpm HDD

» 15.6" 1366 x 768 Display

» Integrated Intel HD Graphics 520

» SuperMulti DVD Drive, Media Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.0, VGA, HOMI

» Windows 7 Pro + Windows 10 License

(LEE56020EV2F)

F—-) LA

14" ThinkPad E470 Notehook
» 2.5 GHz Intel Core i5-7200U Dual-Core
» B86B DDR4 RAM | 500GB 7200 rpm HDD
» 1471920 x 1080 IPS Display

» Integrated Intel HD Graphics 620

» 4-in-1 Media Card Reader

» 802.17ac Wi-Fi | Bluetooth 4.1

» USB 3.0 | USB 2.0 | HOMI

» Windows 10 Pro (64-Bit)

(LEE470H1006D)

758.00

13.3” Notebook 9 (Light Titan)
» 2.7 GHz Intel Core i7-7500U Dual-Core
» 1668 of DDR4 RAM | 2566B SSD
» 13.371920 x 1080 LED-Backlit Display
» Integrated Intel HD Graphics 620
» MicroSD Card Slot
» HDMI | USB Type-C | USB Type-A
» 802.11ac Wi-Fi | Bluetooth 4.1
» Backlit Keyboard | Fingerprint Reader
» 180° Hinge | 550 Nits Qutdoor Mode
» Windows 10 Home

(SANP90OX3NK4)
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/iSUS" 12.5” C302CA-DHM4 64GB Chromebook Flip

» 900 MHz Intel Core m3-6Y30 Dual-Core

» 46B of LPDDR3 RAM, 64GB eMMC Storage
» 12,57 1920 x 1080 Glossy Display

» Integrated Intel HD Graphics 515

» microSD Media Card Reader

» 802.11ac Dual-Band Wi-Fi, Bluetooth 4.2
» USB 3.0 Type-C, Webcam

» Chrome 0S

[ASC302CADHM4)

499.00

/iSUS" 10.1” Chromebook Flip

Designed for a Web-optimized experience, the ASUS
Chromebook Flip 10.1" Multi-Touch Convertible Chromebook
provides a user-friendly interface enhanced by the Internet.

» Rockchip 3288-C SoC

» 1.8 GHz ARM Cortex-A17 Quad-Core

» 4GB of Onboard LPDDR3 RAM

» 166B eMMC Storage » Integrated ARM
Mali-T764 Graphics » 10.1" Multi-Touch Display

» 1280 x 800 Native Resolution

» §02.11ac Wi-Fi, Blustooth 4.0 s .

» 360° Hinge » Chrome 0S

(ASC100PADBO2) 257.00

< CEr 14" 326B Chromebook 14

» 1.6 GHz Intel Celeron N3160 Quad-Core
» 4GB LPDDR3 RAM + 32GB eMMC Storage
» 1471920 x 1080 Anti-Glare IPS Display
» Integrated Intel HD Graphics 400

» 802.11a/b/g/n/ac Wi-Fi & Bluetooth 4.2
» 2xUSB 3.0 Type-A/ 1 x HOMI

» Chrome 0S

(ACCB3431C5XK)

299.00

/ISUS 11.6” C2025A Series
16GB Chromebook (Dark Blue/Silver)
» 1.6 GHz Intel Celeron N3060 Dual-Core

» 4GB of 1066 MHz DDR3L RAM

» 11.6" Anti-Glare Display

» 1366 x 768 HD Resolution

» Integrated Intel HD Graphics 400

» 166B of eMMC Storage

» S0 Media Card Reader » 802.11ac Wi-Fi & Bluetooth 4.2
» USB 3.0/ HDMI / Combo Audio Jack » Chrome 0S

(ASC202YS0208)

229.00

Google Pixelbook

» Google Assistant Built-In

» 10.3mm super-thin and 2.45 lbs lightweight
» 12.3" 2400x1600 360° Touchscreen Display
» 10 hours of use with a single charge

» Tth Gen Intel Core Processor

» Powered by Chrome 0S ” :
» Google Pixelbook Pen Support ——

(GOPBI58128)
with Core i5 / 86B / 2566B (G0PBI5825¢) .. 1199.00

999.00
with Core i7 /1668 / 5126B (60PBI716512)...1649.49

11.6” 166B N23 Chromebook

» 1.6 GHz Intel Celeron N3060 Dual-Core
» 4GB DDR3L RAM | 166B eMMC Storage
» 11.6" 1366 x 768 Display

» Integrated Intel HD Graphics 400

» 2-in-1 Media Card Reader

» 802.11ac Wi-Fi | Bluetooth 4.1

» USB 3.0 | HOMI

» Chrome 0S

(LEBOYS0003)

199.00

12.3" 32GB Multi-Touch 2-in-1 Chromebook Plus

» 2.0 GHz OP1 Hexa-Core Processor

» 4GB of LPDDR3 RAM, 326B eMMC Storage
» 12.3" 2400 x 1600 Touchscreen

» Integrated Graphics

» 802.11ac Wi-Fi, Bluetooth 4.1

» MicroSD Media Card Reader

» USB Type-C

» Chrome 0S

(SAXES13C24K1)

449.00

11.6” 16 GB Chromebook 3

» 1.6 GHz Intel Celeron N3060 Dual-Core
» 4GB of LPDDR3 RAM

» 11.6" Anti-Glare Display

» HD 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics

» 166B eMMC Flash Storage

» Micro SD Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.0

» USB3.0/USB 2.0/ HOMI » Chrome 0S

(SAXES00C13K4) 189.00

aCer 13.3°R13
64GB Multi-Touch Chromebook

» 2.1 GHz MediaTek M8173C Quad-Core

» 4GB of LPDDR3 RAM

» 3.3" IPS TFT Multi-Touch Display

» FullHD 1920 x 1080 Screen Resolution

» Integrated PowerVR GX6250 Graphics

» 646B of Flash Storage

» MicroSD Card Reader

» 802.17ac Wi-Fi &Bluetooth » 360° Hinge

[ACCB5312TK40)

434.95

<Cer 11.67 CB3-131-C38Z
16GB Chromebook

» 2.16 GHz Intel Celeron N2840 Dual-Core
» 268 of DDR3L RAM » 11.6” IPS Display
» 1366 x 768 Screen Resolution

» Integrated Intel HD Graphics

» 166B SSD » SD Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.0

» USB3.0/USB2.0/HOMI » Chrome 0S

(ACCB3131C352)

“ B:H 800-947-5534 + 212-444-6740
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COMPUTERS

( |nte| inside”

GIGABYTE" 15.6” Aero 15 Notebook

» 2.8 GHz Intel Core i7-7700HQ Quad-Core ‘

» 166B DDR4 RAM, 5126B M.2 SATA SSD
» 15.6 1920 x 1080 Thin-Bezel Display
» NVIDIA GeForce GTX 1060 (66B GDDR5)
» SD Media Card Reader
» 802.11ac Wi-Fi, Bluetooth 4.2 + LE
» USB 3.0, Thunderbolt 3| HDMI, Mini DP
» Windows 10 Home (64-Bit)
1,899.00

&

..899.00

LS

1,099.99

12S7i 15.6” 6L62M Gaming Notebook
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 86B of DDR4 RAM | 12868 SSD + 1TB HDD

» 15.6" 1920 x 1080 eDP Display

» NVIDIA GeForce GTX 1050 {26 GDDRb)

» SD Media Card Reader » 802.11ac Wi-Fi | Bluetooth 4.0
» USB 3.0 | USB Type-C | HDMI | Mini-DP

» Windows 10 Home (64-Bit)

(MSBLOZMXTADB) ...

15.6” Gaming Notebook Y520
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 86B DDR4 RAM, 128GB SSD + 1TB HDD

» 15.6” 1920 x 1080 IPS Display

» NVIDIA GeForce GTX 1050Ti 46B GDDRS

» Multi-Format Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.0/ USB 2.0/ HDMI » Windows 10 (64-bit)

/iU’ Republic of Gamers GR8 Il

Mini-Tower Desktop Computer

» 3.0 GHz Intel Core i5-7400 Quad-Core

» 166B DDR4 RAM » 5126B SSD

» NVIDIA GeForce GTX 1060 (36B GDDR5)

» Gigabit Ethernet LAN » 802.11ac Wi-Fi, Bluetooth 4.0
» USB 3.0, USB Type-C, HDMI, DP

» Windows 10 Home (64-Bit)

[ASGRBZTOB9Z) ... ..949.00

@CYBERPOWERPC Gamer Supreme Liquid Cool
Desktop Computer

» 4.2 GHz Intel Core i7-7700K Quad-Core

» 16GB DDR4 RAM, 12068 SSD + 2TB HDD

» NVIDIA GeForce GTX 1070 (86B GDDR5)

» DVI, HOMI, DisplayPort » SuperMulti DVD Drive
» Gigabit Ethernet, 802.11ac Wi-Fi

» Thermaltake Core V31 Mid-Tower Case

» USB Gaming Keyboard & Mouse Included

» Windows 10 Home (64-Bit)

[CYSLCBA20BH) ..o

..1,499.00

www.BandH.com

/iS50 15.6” Republic of Gamers Strix 6L503 Notebook
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 166B DDR4 RAM  » 15.6" 1920 x 1080 FHD Display
» NVIDIA GeForce GTX 1050 (4GB GDDR5)

» Slim 0.9” Prafile with Lightweight b Lb. Body

» 25668 SATA SSD + 178 HDD (7200 RPM)

» Aura RGB lighting keyboard with 4 isolated hotkeys
» USB 3.0, USB Type-C, HDMI, Mini DP

» Windows 10 Home (64-Bit)

(ASGL503VDD74)

1,299.00

/iS50 17.3" Republic of Gamers GL703VD Series
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 1668 of DDR4 RAM | 256GB SSD + 178 HDD

» 17.3" Full HD 1920 x 1080 Matte Display

» NVIDIA GeForce GTX 1050 GPU (4GB GDDR5)

» SD/MMC Card Stot » 802.17ac Wi-Fi | Bluetooth 4.1
» USB 3.0 Type-C | HOMI | Mini DisplayPort

» Aura RGB Lighting » GeForce GTX VR Ready

» Windows 10 Home (64-Bit)

1,299.00

@ 15.6” Inspiron 15 5000 Series Gaming Notebook
» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 1668 of DDR4 RAM, 51268 PCle M.2 SSD

» 15.6” 1920 x 1080 LED-Backlit TN Display

» NVIDIA GeForce GTX 1050 (4GB) » SD & MMC Card Reader
» 3xUSB3.0,1x HDMI 1.4 » 802.11ac Wi-Fi, Bluetooth 4.2
» 1 x Gigabit Ethernet Port » 720p Webcam, Dual Mics, and Speakers
» Windows 10 Home (64-bit)

1,049.00

(@)CYBERPOWERPC Gamer Panzer
Desktop Computer

» 4.2 GHz Intel Core i7-7700K Quad-Core

» 326B DDR4 RAM, 24068 SSD + 2TB HDD

» NVIDIA GeForce GTX 1080 (8GB GDDR5X)

» DVI, HDMI, DisplayPort » Gigabit Ethernet, 802.11ac Wi-Fi
» Phanteks Eclipse P400 Case (White)

» USB Gaming Keyboard & Mouse Included

» Windows 10 Home (64-Bit)

1,899.00

IdeaCentre Y900-34 Desktop Computer
» 4.2 GHz Intel Core i7-7700K Quad-Core

» 166B DDR4 RAM > NVIDIA GeForce GTX 1070 (868 GDDRS)

» 1286B SSD + 1TB Hard Drive » SuperMulti DVD Burner

» DisplayPart, DVI, HDMI, and VGA

» 802.11ac Wi-Fi &Bluetooth 4.0

» 6xUSB 3.0, 4 x USB 2.0 Ports

» 7-in-1Card Reader » Windows 10 Home (64-bit)

1,499.00



COMPUTERS

MOBILE WORKSTATIONS

inside”

) 14" 1Book 14u G4
Mobile Workstation

Thin at 0.87" and weighing 3.61 b, the 14" ZBook 14u G4 Mobile
Workstation from HP delivers a high level of power and graphics
capability in a compact design, allowing users to take
workstation-class power with them virtually anywhere.
» Designed for the Creative Professional

» 2.5 GHz Intel Core i5-7200U Dual-Core

» 46B DDR4 RAM, 500GB 7200 rpm 2.5 HDD

» 1471366 x 768 TN Anti-Glare Display » AMD FirePro W4190M Graphics Card (26B)
» SDXC UHS-II Card Reader » USB 3.0, DisplayPort 1.2, VGA

» 802.11ac Wi-Fi | Bluetooth 4.2 » Gigabit Ethernet Port » Windows 10 Pro (64-bit)

(HEZB14UG42L)

999.00

) 15.6” ZBook 15u G4
Mobile Workstation

Thin at 0.78" and weighing 4.18 b, the 15.6” ZBook 15u G4 Mabile

Workstation from HP delivers workstation performance and long

battery Life within a compact mobile form factor.

» Designed for the Creative Professional

» 2.7 GHz Intel Core i7-7500U Dual-Core

» 166B DDR4 RAM | 5126B PCle SSD

» 15.6” 1920 x 1080 UWVA IPS Display » AMD FirePro
WA190M Graphics Card (26B) » SDXC UHS-II Card Reader

» USB 3.0 DisplayPort 1.2 | VGA » 802.11ac Wi-F, Bluetooth 4.2

» Gigabit Ethernet Port » Windows 10 Pro (64-bit)

(HEZB15UG4134)

1,729.00

15.6” ThinkPad P51s

Thin at 0.8” and weighing 4.39 b, the 15.6” ThinkPad
P51s Mobile Workstation from Lenovo delivers the power
of a workstation and the mobility of an Ultrabook. It

is powered by a 2.7 GHz Intel Core i7-7500U Dual-Core
processor which allows you to run multiple applications
simultaneously.

» 2.7 GHz Intel Core i7-7500U Dual-Core » 15.6” 1920 x 1080 IPS Display

» NVIDIA Quadro M520M Graphics Card (26B) » SD/SDHC/SDXC & MMC Card Reader

» Thunderbolt 3 | USB 3.0 | HDMI 1.4b » 802.11ac Wi-Fi | Bluetooth 4.1 » Gigabit Ethernet Port
» Built-in 720p Webcam, Mic, and Speakers » Windows 10 Pro (64-bit)

Storage Memory SKU PRICE
50068 7200 rpm 2.5 HOD | 868 | LEP51SHBOOTK | 1,099.00
5126BPCle M.2SSD | 1668 | LEPS1S0JY004 | 1,549.00

17.3" ThinkPad P71

Thin at 1.35" and weighing 7.3 b, the 17.3" ThinkPad P71 Mobile

Workstation from Lenovo has been designed as a go-to PC for

getting jobs done. It is powered by a 2.8 GHz Intel Core

i7-7700HQ Quad-Core processor which allows you to run

multiple applications simultaneously.

» 2.8 GHz Intel Core i7-7700HQ Quad-Core » 8GB DDR4 RAM,
25668 PCle M.2 SSD » 17.3" 1920 x 1080 IPS Display

» NVIDIA Quadro M620M Graphics Card (26B) » SD/SDHC/SDXC
&MMC Card Reader » Thunderbolt 3, USB 3.0, HDMI, Mini DP

(LEP7THK0014)

1,693.99

7 15.6” ZBook Studio G4
Mobile Workstation

Thin at 0.71" and weighing 4.6 Lb, the 15.6" ZBook Studio G4

Mobile Workstation from HP has been built for creative
visionaries who require the power of a desktop workstation

in a sleek and light mobile design.

» Designed for the Creative Professional

» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 16GB DDR4 RAM, 51268 PCle M.2 SSD

» 16.6" 3840 x 2160 IPS Dreamcolor Display » NVIDIA Quadro M1200 Graphics Card (4GB)

» SD/SDHC/SDXC Card Reader » Thunderbolt 3, USB 3.0, HDMI 1.4 » 802.11ac Wi-Fi, Bluetooth 4.2

(HEZBSGA4TMP23)
(HEZB1564JD35) .

2,499.00
2,459.00

7 17.3" IBook 17 G4
Mobile Workstation

Made for mobile creative and design professionals with
demanding projects, the 17.3" ZBook 17 G4 Mabile Workstation
from HP provides desktop warkstation power, performance,
and expandability in a device designed for the road.
» Designed for the Creative Professional

» 3.1 GHz Intel Xeon E3-1535M v6 Quad-Core

» 166B ECC DDR4 RAM | 512GB SSD + 17B HOD

» 17.3" 1920 x 1080 UWVA IPS Display » NVIDIA Quadro P4000 Graphics Card (868)
» SD/SDHC/SDXC Card Reader » Thunderbolt 3, USB 3.0, HDMI 1.4, VGA

» 802.11ac Wi-Fi | Bluetooth 4.2 » Gigabit Ethernet Port » Windows 10 Pro (64-bit))

(HEZB1764NL44)

3,664.00

@ Mmsi 15.6” WE627R)
Mobile Workstation

Made for mobile creative and design professionals with demanding

projects, the 17.3" ZBook 17 G4 Mobile Workstation from HP provides

desktop workstation power, performance, and expandability in a

device designed for the road.

» 2.8 GHz Intel Core i7-7700HQ Quad-Core

» 166B of DDR4 RAM +512GB M.2 SSD

» 5.6"1920 x 1080 eDP IPS Display » NVIDIA Quadro M2200
Graphics Card (46B) » SuperMulti DVD Burner » & SDXC Card Reader

» USB 3.1 Type-C, USB 3.0 & 2.0 Type-A » 1 x HDMI & 1x Mini DisplayPort

» 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.2 » Windows 10 Pro (64-bit)

(MSWE627R1832)

1,699.00

@ 17.3" Precision M7710

Mobile Workstation
Made for mobile creative and design professionals with

demanding projects, the 17.3" ZBook 17 G4 Mabile Workstation
from HP provides desktop workstation power, performance, and
expandability in a device designed for the road.

» 2.7 GHz Intel Core i7-6820HQ Quad-Core

» 868 of 2133 MHz DDR4 RAM » 17.3” UltraSharp IPS

Anti-Glare Display » Full HD 1920 x 1080 Screen Resolution
» NVIDIA Quadro M3000M Graphics Card (46B) » 178 7200 rpm SATA Hard Drive
» SD/SDHC/SDXC Memory Card Reader » 802.11ac Wi-Fi & Bluetooth
» USB 3.0/ HOMI/ Mini DisplayPort » Windows 7 Pro + Windows 10 Pro License

[DETTTIDBARY).... 2,350.00

800-947-5534 + 212-444-6740
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23" |deacentre 510-231SH Multi-Touch

All-in-One Desktop Computer

Experience Full HD with the Lenovo 23" IdeaCentre 510
Multi-Touch All-in-One Desktop Computer. The 23" IPS
display features wide viewing angles, a 1920 x 1080
screen resolution, 16:9 aspect ratio, and 10-point touch
support. Visuals are handled by a dedicated NVIDIA
GeForce GT 940MX graphics card with 26B GDDRS VRAM.
» 2.8 GHz Intel Core i7-6700T Quad-Core

» B86B DDR4 RAM | 1TB HDD + 12868 SSD

» 2371920 x 1080 Touchscreen Display

» NVIDIA GeForce 940MX Graphics

» Slim SuperMulti DVD Burner

» 6-in-1 Media Card Reader » 10/100/1000 Mbps Gigabit Ethernet » 802.11ac Wi-Fi | Bluetooth 4.0
» Wired Mouse & Keyboard Included » Windows 10 Home

(LEST0FOCD02Y)

1,049.00

23" Ideacentre 510 Multi-Touch

All-in-One Desktop Computer
» 3.4 GHz Intel Core i3-7100T Dual-Core

» 86B DDR4 RAM, 17B HDD

» 23" 1920 x 1080 Touchscreen Display

» Integrated Intel HD Graphics 630

» SuperMulti DVD Drive, Media Card Reader

» 802.11ac Wi-Fi, Bluetooth _— o

» USB 3.0, USB 2., HDMI » Gigabit Ethernet » Windows 10
(LEFOCDOOEO)

899.01

23.8" ThinkCentre M910z

All-in-One Desktop Computer

» 3.2 GHz Intel Core i5-6500 Quad-Core » 8GB of DDR4 RAM

» 23.8" Display » 1920 x 1080 Screen Resolution

» Integrated Intel HD Graphics 530 » 500GB 7200 rpm Hard Drive

» SuperMulti DVD Burner, Card Reader » 802.11ac Wi-Fi & Bluetooth 4.1
» 6xUSB 3.0, 1x DisplayPort » Windows 7 Pro + Windows 10 License

(LEM910ZNS010) 899.00

23.8" ThinkCentre X1

All-in-One Desktop Computer

» 2.3 GHz Intel Core i5-6200U Dual-Core

» 868 of 2133 MHz DDR4 RAM

» 23.8" IPS Anti-Glare TFT Display

» Full HD 1920 x 1080 Screen Resolution

» Integrated Intel HD Graphics 520 » 25668 SATA 11l 2.5" SSD
» 802.11ac Wi-Fi & Bluetooth 4.1 » 5x USB 3.0 Type-A, 1 x DisplayPort
» 2MP, 1080p Full HD Webcam » Windows 10 Pro (64-bit)

(LEX110KE00TF) 2,199.00

/iSUS 7en AiDIN270
Multi-Touch All-in-One Desktop

» 2.4 GHz Intel Core i5-7400T Quad-Core » 8GB DDR4 RAM,
178 7200 rpm HDD » 27" 1920 x 1080 Multi-Touch Display
» Integrated Intel HD Graphics 630 » 2-in-1 Media Card Reader
» 802.11ac Wi-Fi, Bluetooth 4.1 » USB 3.0, USB 2.0, HDMI
» Wireless Keyboard & Mouse Included » Windows 10 Home (64-Bit)

[ASZN270IEUTD)

-

1,799.00

www.BandH.com

COMPUTERS

P 238" EliteOne 800 63

All-in-One Desktop Computer

The 23.8" EliteOne 800 G3 All-in-One Desktop Computer from HP
delivers an improved user experience with its thin design, powerful
processing, multi-faceted security, cable management, and collabora-
tion capabilities. This system is powered by a 3.4 GHz Intel Core i5-7500
Quad-Core processor and 8GB of 2133 MHz DDR4 RAM that allows you

to efficiently multitask as well as quickly access E
frequently used files and programs. ﬁ“.“”
» 86B of 2133 MHz DDR4 RAM

» 23.8" Full HD WLED IPS Touchscreen » 1920 x 1080 Screen Resolution

» Integrated Intel HD Graphics 630 » Slim SuperMulti DVD, SDXC Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.2 » USB 3.0, DisplayPort, HOMI » Windows 10 Pro (64-bit)

— 1

CPU Storage Graphics Memory SKU Price
i5-7500 Quad-Core 1TB HDD Intel HD Graphics 630 868 HEBOOG31JF71 | 1,039.99
i7-7700 Quad-Core 25668 SSD Intel HD Graphics 630 8GB HEBOOG31JF76 | 1,299.00
i5-7500 Quad-Core 25668 SSD Intel HD Graphics 630 868 HEB00G31JF73 | 1,109.00
i5-7500 Quad-Core 25668 SSD Intel HD Graphics 630 8GB HEBOOG3TJF75 | 1,239.00

7 27" Pavilion 27-a230 Multi-Touch
All-In-One Desktop Computer

» 2.4 GHz Intel Core i5-7400T Quad-Core

» 1268 of 2133 MHz DDR4 RAM » 27" Full HD Multi-Touch IPS Display
» 1920 x 1080 Screen Resolution » Integrated Intel HD Graphics 630
» 1B 7200 rpm SATA Hard Drive

» SuperMulti DVD Burner, SDXC Card Reader

» 802.11ac Wi-Fi, Bluetooth 4.2

» USB 3.0, USB 2.0, HOMI » Windows 10 Home (64-bit)
[HEPZ5MO4AA)

Microsoft 28" Surface Studio
Multi-Touch All-in-One Desktop
» Intel Core i7 6th Gen Quad-Core » 32GB RAM, 1286B SSD + 2TB HDD
» 28" 4500 x 3000 Touchscreen

» NVIDIA GeForce GTX 980M (4GB GDDR5)

» SDXC Card Reader » 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.0, Mini-DisplayPort » Windows 10 Pro (64-Bit)

(M143000001) 479.00

@ OptiPlex 7450

23.8" All-in-One Desktop Computer

» 3.4 GHz Intel Core i5-7500 Quad-Core » 8GB of 2400 MHz
DDR4& RAM » 23.8" Full HD WLED Display

» 1920 x 1080 Screen Resolution » Integrated Intel HD
Graphics 630 » 50068 7200 rpm SATA 2.5" Hard Drive *.

» Slim SuperMulti DVD Burner, Card Reader » 802.11ac Wi-Fi &
Bluetooth 4.2 » USB 3.0, USB 2.0, DisplayPort, HDMI » Windows 10 Pro (64-bit)

(DEO745025HP3)

@ 23.8" Inspiron 24 3000 Series
Multi-Touch All-in-One Desktop
» 1.6 GHz Intel Pentium N3700 Quad-Core
» 868 of 1600 MHz DOR3LRAM » 23.8" Full HD TrueLife
IPS Touchscreen » 1920 x 1080 Screen Resolution
» Integrated Intel HD Graphics » 1TB 5400 rpm Hard Drive
» SuperMulti DVD Burner, Card Reader » 802.11ac Wi-Fi, Bluetooth 4.0
» UUSB 3.0 Type-A, USB 2.0 Type-A » Windows 10 Home (64-bit)

(DEI034526382)
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& MacBook Pro

The MacBook Pro Laptop Computer with Retina Display from
Apple is ac powerful notebook computer with an innovative,
ultrathin, ultraportable aluminum unibody design. It is loaded
with advanced power management features and an integrated
lithium polymer battery, which work together to provide up to
9 hours of wireless web browsing.

The widescreen, LED-backlit IPS screen has a glossy finish.
With 227 pixels per inch, this MacBook Pro has a pixel

count of over 5 million. You'll be able to output to 2 external
displays at up to 2880 x 1800 via Thunderbolt 3 (Mini =
DisplayPort). Any Mini DisplayPort-compatible display will
plug in without the need for an adapter. This MacBook Pro
also adds an HDMI port so HDMI-compliant devices,
particularly HDTVs, are now natively supported as well.
Graphics are handled by integrated Intel Iris Graphics.

SEIROSRALTOWA Y my
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15.4” MacBook Pro
» 802.11ac Wi-Fi & Bluetooth 4.2
» Thunderbolt 3 (USB Type-C) Ports
» 3.5mm Headphone Jack,
Stereo Speakers
» Touch Bar | Touch ID Sensor

STARTING AT

13.3” MacBook Pro

» Intel Core i5 Dual-Core

» 868 of 2133 MHz RAM | 256GB PCle SSD
» 13.3" 2560 x 1600 Retina Display

» Integrated Intel Iris Graphics

STARTING AT

» mac0S Sierra

» Intel Core i7 Quad-Core

» 166B 2133 MHz RAM

» 15.4” 2880 x 1800 Retina Display
» AMD Radeon Pro GPU

2,599.00 1,399.00

& MacBook

» With a Retina display and a thin, lightweight
design, the gold Apple 12" MacBook provides
both portability and performance. Measuring
just 0.5" (13.Tmm) thin and weighing only 2
pounds, the MacBook is compact yet still has a
premium feel, thanks to its unibody design.

» 1866 MHz LPDDR3 RAM

» 12" LED-Backlit IPS Retina Display

» 2304 x 1440 Screen Resolution

» Integrated Intel HD Graphics 615

» Available with 256 and 51268 SSD » USB 3.0 Type-C Port
» 802.11ac Wi-Fi, Bluetooth 4.2 » Force Touch Trackpad » Mac 0S » Available in Gold, Rose Gold, Silver, Space Gray

STARTING AT

ClregiddesgaToem

1,199.00

& MacBook Air

The 13.3" MacBook Air Laptop Computer from Apple is an ultraportable
notebook computer with a thin and lightweight design.

Apple’s engineers have leveraged the lessons they learned in designing
the miniaturized iPad and applied them to the design of this 2.96-pound
computer. To say that the Air is svelte is all at once stating the obvious
and understating the truth. The system is defined by its unibody aluminum
enclosure. At its thickest point the computer is only 0.68” — it tapers
down to 0.11" at its thinnest.

» 868 of 1600 MHz LPDDR3 RAM
» PCle-Based Flash Storage
» Integrated Intel HD Graphics 6000

STARTING AT

» USB 3.0, Thunderbolt 2
» T20p FaceTime HD Camera, SDXC Card Slot
» Mac 0S X EL Capitan or mac0S Sierra

» 13.3" LED-Backlit Glossy Display
» 1440 x 900 Native Resolution
» 802.11ac Wi-Fi, Bluetooth 4.0

899.00

ACCESSORIES

’
' Authorized Reseller
Magic Mouse 2

» Wireless Bluetooth Connectivity
» Built-in Rechargeable Battery

» Optimized Foot Design

» Lightning to USB Cable Included
» Mac Compatible

[APMLAOZLLA] 79.00

’
. Authorized Reseller

World Travel
Adapter Kit

» Supports a Variety of
Regions

eiz  * » Seven Different AC Plugs
Included

» iPod, iPhone & iPad
Compatible

» MagSafe & MagSafe 2 Compatible

» Includes A Set Of Seven AC Plugs With Prongs That Fit

Different Electrical Outlets Around The World

[APWTAK) 28.49

s
' Authorized Reseller

1-Year AppleCare Help Desk Support

» Two Designated Contacts

for One Year

» Unlimited Support Incidents ’

» Hardware and Software C
Diagnosis

» Mac Computers / iPad / v
iPhone / iPod Help DeskSeppot

» AppleCare Technician

Training

(APACHDSOSX) 2,399.00

1-Year 0S Support - Alliance

» Unlimited Enterprise-Level

Tech Support

» 1 Year Access for 6 Peaple ’

» Onsite Review by C
Apple Engineer

» 05 X,i0S & 0S X Server AppleCare
Support 05 Support
» Phone/Email Support

for Integration

» Migration & Server Operation Support
» Dedicated Technical Support Manager
» 1 Hour "Server Down" Response, 24/7
» AppleCare Help Desk Support & Tools

(APD5691ZMA) 43,500.00

B:H 800-947-5534 + 212-444-6740



& iMac 5K

iIMAC ALL-IN-ONE & MAC PRO DESKTOP COMPUTERS

The Apple 21.5” iMac measures at just b mm at its edges, which is 40% less volume than the 2011 iMac.
The widescreen display features LED backlighting for vibrant, accurate color. With in-plane switching (IPS)
technology, the iMac has a wide 178° viewing angle. The iMac houses a bth-Gen Broadwell Intel Core i

Dual-Core processor with 2400 MHz DDR4 onboard RAM.

Apple weds high-res 5K visuals into its sleek bmm thin 27" iMac with Retina 5K Display. With a 5120 x
2880 native resolution, this iMac provides 14.7 million pixels, which is 7 times more than the standard HD
display. The Retina 5K display also features a wider color gamut. Using a P3-based color gamut, the Retina
5K display provides a 26% larger color space than standard sRGB displays. And with more available colors,
the images will appear more vivid and reveal greater detail.

» 802.11ac Wi-Fi, Bluetooth 4.2
» Magic Keyboard & Magic Mouse 2 Included

21.5” iMac

» 21.5" Retina 4K IPS Display

» 4096 x 2304 Screen Resolution

» Intel Core i Quad-Core

» 8B of 2400 MHz DDR4 Onboard RAM

» Integrated Intel Iris Pro Graphics 6200
STARTING AT .o 999,99

» Thunderbolt 3 + USB 3.0
» Mac 0S X

27” iMac

» 27" Retina bK IPS Display

» 5120 x 2880 Screen Resolution

» Intel Core i5 (Skylake)

» 86B of 2400 MHz DDR4 Onboard RAM
» AMD Radeon R9

STARTING AT . 1,679.99

’
' Authorized Reseller
USB SuperDrive

External Slot-Loading
Optical Drive

» USB Powered g

» Slim & Portable \/
» For Mac with a USB Part ’

» Easily Slips Into a Travel Bag

[APMMDBOALLA) oo 79,00

s
' Authorized Reseller

Magic Mouse 2
» Wireless Bluetooth g
Connectivity

» Built-in Rechargeable Battery

» Optimized Foot Design

» Lightning to USB Cable Included

» Mac Compatible

[APMLAOZLLA) . 19,00

ACCESSORIES

COMPUTERS

s
. Authorized Reseller

Magic Wireless Keyboard

e ——— T ,._qﬁ,.-_ = ~

» Numeric Keypad

» Wireless Bluetooth Connectivity
» Built-In Rechargeable Battery

» Scissor Mechanism for Keys

[APMOOSZLLA) ..o

......125.00

’
' Authorized Reseller

Magic Trackpad 2

» Force Touch
Support

» Wireless
Bluetooth Connectivity

» Built-In Rechargeable Battery
» Mac Compatible

[APMJZRLLA] ..o

i 121.00

STARTING AT oo

www.BandH.com

o 2,799.00

peripherals, such as external hard drives.

» PCle-based Flash Storage
» Dual AMD FirePro GPUs

iLife has a complete suite of digital creativity applications.
Easy enough for anyane to use, iLife will help you edit your
home movies, organize digital photos and compose origi-
nal music. iLife includes iPhoto, iMovie and GarageBand.

iWork provides three apps to keep you productive. Pages

& Mac Pro

Apple revisited the architecture of the Mac Pro’s internal components in order to maximize performance and minimize
heat. With a unified thermal core, Apple opted for a leaner, lighter, and quieter structure that was more streamlined.
The unique cylinder design stands just 9.9 inches tall with a diameter of just 6.6 inches, which allows it to be a
professional workstation that can actually sit on your desk.
The Mac Pro has six Thunderbolt 2 ports, a high-speed
interface that can move data at up to 20 Gb/s. That's four
times the speed of the USB 3.0 standard. Speaking of USB
3.0, Apple added four USB 3.0 ports to ensure you have

full native connectivity options with your USB-compatible

» Six Thunderbolt 2 Ports
» Four USB 3.0 Ports, One HDMI

allow you to make creative word documents. Numbers helps you make spreadsheets more visually insightful. Keynate allows you to create a powerful
presentation, complete with animated charts, interactive tables with cinematic effects and transitions.

» Intel Xeon » 1866 MHz DDR3 ECC RAM

1.4 Port

» Supports up to Three 4K Displays

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.0
» Unique Compact Cylinder Design
» Mac 0S X



COMPUTERS

12 Mini 63 Desktop Workstation
Made by and for design professionals, such as CAD users,
the 22 Mini 63 Desktop Workstation from HP delivers power,
performance, versatility, and reliability in a small and elegant design.
At 2.3" high, it is 90% smaller than a traditional business-class tower.
The 22 Mini has been tested for 368,000 hours and certified for over
20 professional software applications, such as AutoCAD, Vectorworks,
MicroStation, Inventor, SOLIDWORKS, Solid Edge, and Revit.
» Designed for the Creative Professional
» 3.4 GHz Intel Core i7-6700 Quad-Core » 16GB of 2400 MHz DDR4 RAM
» NVIDIA Quadro M620 Graphics Card (2GB) » 51268 Z Turbo Drive 62 PCle SSD
» 1x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.2 » 2 x USB 3.0 Type-C
&4 xUSB 3.0 Type-A » 4 x DisplayPort 1.2 » Windows 7 Pro + Windows 10 Pro License

Processor Memory  Storage GPU SKU Price

Core i7-6700 1668 51268 SSD (Quadro M620 HEZZMET7UT 1,558.06

Xeon £3-1245 1668 51268 SSD (uadro M620 HEZ2MD1UT 1,429.00

Core i7-6700 868 25668 SSD (Quadro M620 HEZ2MD60UT 1,267.23

Core i7-6700 868 1TB HDD Quadro M620 HEZ2ME16UT 1,169.00

Core i7-6700 868 25668 SSD Intel HD 530 HEZZMET5UT 1,099.00
) 1240

The 2240 Series Tower Workstation from HP delivers
powerful performance in a tower form factor and is designed for
prafessionals who require high reliability. With the capabilities
to operate in immersive work environments and handle 24x7x365
workloads, the 2230 delivers processor and graphics technologies
ina compact yet expandable tower.

» Gigabit Ethernet » Windows 7 Pro + Windows 10 Pro License

Processor RAM  Storage Graphics SKU Price
3.4 GHz Intel Core i7-6700 Quad-Core 166B | 17TB7.2k | NVIDIAQuadroK1200 | HEZ240TANTIU | 1,529.00
3.5 GHz Intel Xeon E3-1245v5 Quad-Core | 166B | 5126BSSD | IntelHD Graphics 530 | HEZ240LK969U | 1,224.79
35 GHz Intel Xeon E3-1240v5 Quad-Core | 166B | 2566BSSD |  INVIDIA Quadro K620 | HEZ240LK917U | 1,609.00
4.0 GHz Inte Core i7-6700K Quad-Core 1668 | 2566BSSD | IntelHD Graphics 530 | HEZ240TYIY64 | 1,349.00
3.4 GHz Intel Xeon £3-1230v5 Quad-Core | 8GB 18 7.2k NVIDIA Quadro K420 HEZ2401HJ36 | 1,134.00

™ 1640
The 2640 Rackable Minitower Workstation from HP delivers

powerful performance in a rackable minitower form factor and is designed
for professionals who require high reliability. The 2640 is well suited for tasks
such as intensive graphics, 30 rendering, multimedia, and gaming, as well
as science and engineering applications.
» Slim SuperMulti DVD Burner » 8x USB3.0/2x USB 2.0/ 1x RJ-45
» Tool-Less Expandable Design » Windows 7 Pro + Windows 10 Pro License
Graphics SKU Price

Processor RAM  Storage

2x2.1 GHz Intel Xeon Eight-Core | 1668 | 256 SSD No Graphic Card Installed HEZ640T4P02 2,899.00
2.2 GHz Intel Xeon Eight-Core | 166B | 256 SSD No Graphic Card Installed HEZ640TAP01 2,339.99
2.1 GHz Intel Xeon Eight-Core | 86B | 1TB7.2k No Graphic Card Installed HEZ840T4P00 2,029.00

ThinkStation P320

The ThinkStation P320 Series Tower Workstation from Lenovo is a
reliable, stable, configurable, and scalable system that also boasts
productivity features, is VR-ready, and ISV-certified. The system is
powered by a 3.4 GHz Intel Core i7-6700 Quad-Core processor and it
can deliver extra performance by increasing the clock speed up to

4.0 GHz utilizing Intel's Turbo Boost 2.0 technology.

» SuperMulti DVD | 9-in-1 Card Reader

» 1 x Gigabit Ethernet Port » 6 x USB 3.0 Type-A | 2 x USB 2.0 Type-A
» 2 x DisplayPort | 1x VGA | 1 x Serial » USB Wired Keyboard & Mouse Included
» Windows 7 Pro + Windows 10 License

(LEP32030BH34) 1,279.99

WORKSTATION COMPUTERS

1240 Small Form Factor

The 2240 Series Small Form Factor Workstation
(ENERGY STAR] from HP delivers powerful performance in a
small form factor design and is geared towards professionals
who require high reliability. With the capabilities to operate in
immersive work environments and handle 24x7x365 workloads,
the 2240 delivers processor and graphics technologies, as well
as scalability to match your business needs.
» Slim SuperMutti DVD Burner
» Gigabit Ethernet
» 8xUSB3.0,2xUSB 2.0 Ports
» Windows 7 Pro + Windows 10 Pro License

Processor RAM Storage Graphics SKU Price
3.5 GHz Intel E3-1240v5 Quad-Core | 166B | 756GBSSD+1TB7.2k | NVIDIA Quadro K620 | HEZ240LK917U | 1,609.00
3.4 GHzIntel i7-6700 Quad-Core | 868 1187.2k NVIDIA Quadro K620 | HEZ240L9K66U | 1,118.53
3.2 6Hz Intel Core i5-6500 Quad-Core | 8GB 118 7.2k Intel HD Graphics 530 | HEZ2401HJ32 899.00
7 1440

The 440 Minitower Workstation from HP delivers powerful
performance in a minitower form factor and is designed for professionals
who require high reliability. The Z440 is well suited for tasks such as
intensive graphics, 3D rendering, multimedia, and gaming, as well as
science and engineering applications.

» Slim SuperMulti DVD Writer
» Gigabit Ethernet
» Windows 7 Pro + Windows 10 Pro License

Processor Memory  Storage Display
3.6 GHz Intel Xeon E5-1650 vé Six-Core | 326B 2566BSSD | NVIDIA Quadro K620 | HEZ440X2083P | 2,409.03
3.6 GHz Intel Xeon E5-1650 vé Six-Core | 86B 1TB7.2k NVIDIA Quadro K820 | HEZ440X20830 | 2,369.04
3.5 GHz Intel Xeon Quad-Core 1668 5126BSSD | NVIDIA Quadro M2000 | HEZ440X2D84U | 2,414.00
3.5 GHz Intel Xeon Quad-Core 868 1TB7.2k | NVIDIA Quadro M2000 | HEZ440X20660 | 1,969.00

» 1840
Within the Z Series, the 2840 Rackable Minitower

Workstation from HP delivers extreme performance in a

rackable minitower form factor.

» 9.5mm Slim SuperMulti DVD-RW

» Dual Gigabit Ethernet Ports

» 8xUSB3.0,2xUSB 2.0 Ports

» Windows 7 Pro + Windows 10 Pro License

Processor RAM Storage Graphics SKU Price
2x 2.4 GHz Xeon E5-2680 vé 12868 51268 53D Quadro M6000 HEZB40T4P09X | 12,836.84
Dual 2.1 GHz Xeon E5-2620 vé 3268 | 1TBHDD+17BSSD | Quadro M4000 (BGB) | HEZBAOTAPOSI | 4,764.95
2.2 GHz Intel Xeon E5-2630 vé Ten-Core | 326B | 5126B SSD + 178 HOD Quadro M4000 HEZB4OT4POGK | 3,924.50

P Series ThinkStation P410 Workstation
with Xeon E5-1620 v4 Processor

The P Series ThinkStation P410 Workstation from Lenovo

is powered by a Xeon E5-1620 v4 quad-core processor that
operates on 3.5 GHz frequency. If you need more power, the CPU
can deliver extra performance by increasing the clock speed

up to 3.8 GHz utilizing Intel's Turbo Boost technology.

» 3.56Hz Intel Xeon E5-1607 v4 quad-core CPU

» 86B 400 MHz DDR4 ECC RAM » 1TB 7200rpm

» No Graphic Card installed » Rambo8 DVD Burner

» Windows 10 Pro 64 » 6 x USB 3.0 ports

» Onboard RAID 0, 1, 5, 10 controller

[LEPATOBOBBZH).... e 1,075.00

800-947-5534 + 212-444-6740




) ProDesk 600 G3 Microtower
Tiny Desktop Computer (Black)

» 3.6 GHz Intel Core i7-7700 Quad-Core

» 868 of 2400 MHz DDR4 RAM » Integrated Intel HD Graphics 630

» 118 7200 rpm SATA 3.5" Hard Drive

» SuperMulti DVD Burner » 1 x Gigabit Ethernet Port

» 2x DisplayPort | 1xVGA » USB 3.0 Type-A & Type-C | USB 2.0 Type-A

(HE600631FY46)

ThinkCentre M710

Tiny Desktop Computer (Black)

» 2.5 GHz Intel Core i5-6500T Quad-Core » 8GB of 2400 MHz DDR4 RAM
» Integrated Intel HD Graphics 530 » 128GB Opal NVMe PCle M.2 SSD

» 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.2

» 6 x USB 3.0 Type-A Parts » 3 x DisplayPort » USB Wired

Keyboard & Mouse Included » Windows 7 Pro + Windows 10 Pro License

[LEM7I00TOMRH)

ThinkCentre M910
Tiny Desktop Computer (Black)

» 2.9 GHz Intel Core i7-7700T Quad-Core » 86B of 2400 MHz DDR4 RAM

» Integrated Intel HD Graphics 630 » 500GB 7200 rpm SATA 2.5" Hard Drive
» 1 x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.2

» 6 x USB 3.0 Type-A Ports » 2 x DisplayPort, 1 x HDMI

» USB Wired Keyboard & Mouse Included » Windows 10 Pro (64-bit)

(LEM910010MVD)

@ Inspiron 3268 Desktop Computer
» 3.9 GHz Intel Core i3-7100 Dual-Core » 4GB of 2400 MHz DDR4 RAM
» Integrated Intel HD Graphics 630 » 1TB 7200 rpm SATA Il Hard Drive

» 9.5mm DVD+RW Drive » 1 x Gigabit Ethernet Port

» 802.11b/g/n Wi-Fi, Bluetooth 4.0 » 2 x USB 3.0 Type-A, 4 x USB 2.0 Type-A
» USB Wired Keyboard & Mouse Included » Windows 10 Home (64-bit)

(DEI326834278)

@ XPS 8920
Tower Desktop Computer

» 3.6 GHz Intel Core i7-7700 Quad-Core

» 86B of 2400 MHz DDR4 RAM » NVIDIA GeForce GT 730 (26B)

» 17B SATA 3.5" Hard Drive » SuperMulti DVD Burner, SDXC Card Reader
» 1x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.0

» USB Wired Keyboard & Mouse Included » USB 3.1, USB 3.0, USB 2.0
» Windows 10 Pro (64-Bit)

(DEX89207673B)

(i/ntel') Compute Stick

Transform your display into a fully functional computer
with the Compute Stick from Intel. This over-sized thumb drive PC offers
the performance similar to your other computer and allows you to stream
online videos, play games, work on projects, & more.
» Intel HD Graphics » HOMI, USB 2.0, USB 3.0 » 802.11ac Wi-Fi,

Bluetooth 4.0 » Micro-SDXC Card Slot » Multi-channel Audio

» Space-saving Design » Windows 10

Processor RAM Storage SKU Price
1.1 GHz Intel Core m5-6Y57 Dual-Core 4GB 6468 INBOXSTKTAW3 126.99
900 MHz Intel Core m3-6Y30 Dual-Core 4GB 646B INBOXSTKZM3W 349.99

www.BandH.com

DESKTOPS [e{e] 4210y =23

7 ProDesk 400 G4

Small Form Factor Desktop Computer

» 3.4 GHz Intel Core ib-7500 Quad-Core

» §6B of 2400 MHz DDR4 RAM

» Integrated Intel HD Graphics 630 » 256GB SATAIIl 2.5" SSD
» SuperMulti DVD Burner » 1 x Gigabit Ethernet Port

» 4 xUSB 3.0 Type-A, 4 x USB 2.0 Type-A » 1x DisplayPort, 1 x VGA
» USB Wired Keyboard & Mouse Included » Windows 10 Pro (64-bit)

(HEAD0GATGB07) ...

...659.98

459.00

... 579.00

7 260 G2 Mini Desktop Computer

» 2.3 GHz Intel Core i3-6100U Dual-Core
» 4GB of 2133 MHz DDR4 RAM
» Integrated Intel HD Graphics 520
» 5006B 5400 rpm SATA Hard Drive » 1 x Gigabit Ethernet Port
» 802.11b/g/n Wi-Fi » 4x USB 3.0 Type-A, 2 x USB 2.0 Type-A » HDM1 1.4, VGA
» USB Keyboard & Mouse Included » Windows 7 Pro + Windows 10 Pro License

(HE26062v2V84)

vezts

Small Form Factor Desktop Computer

» 3.0 GHz Intel Core i5-7400 Quad-Core
» 4GB 2400 MHz DDR4 RAM

» Integrated Intel HD Graphics 630 » 5006B 7200 rpm 3.5" Hard Drive

» SuperMulti DVD Burner » 1x Gigabit Ethernet Port » HDMI, DisplayPort, and VGA Parts
» 6xUSB3.0,2xUSB 2.0 Ports » Windows 10 Pro (64-bit)

(LEVB20STONML)..

OptiPlex 3050
Small Form Factor Desktop Computer

» 2.7 GHz Intel Core i5-7500T Quad-Core » 8GB of DDR4 RAM

» Integrated Intel HD Graphics 630 » 2566B SATA 2.5 SSD

» 1x Gigabit Ethernet Port » 802.11ac Wi-Fi & Bluetooth 4.2

» 4xUSB 3.0 Type-A, 2x USB 2.0 Type-A » 1 x DisplayPort 1.2, 1 x HDMI 1.4
» USB Wired Keyboard & Mouse Included » Windows 10 Pro (64-bit)

(DE3050CFCAC)
(DEO30BOPZAW] ..o

657.89
619.99

(inte) NUCTITBNH

Small Form Factor Desktop Computer

» 3.5 GHz Intel Core i7-7567U Dual-Core

» 2 x DDR4-2133 SODIMM Slots (Up to 326B)

» 1xM.22280 Slot | 1x2.5" Drive Bay » Intel HD Graphics 650
» TxHDMI 2.0 » 1x Gigabit Ethernet Port

» 802.11ac Wi-Fi, Bluetooth 4.2 » 1 x Thunderbolt 3, 4 x USB 3.0 Ports
» MicroSDXC Slot » Windows Compatible

(INBNUCTI7BNH) ...

/iU’ Chromebox M004U

Desktop Computer (Dark Mineral Blue)

» 1.4 GHz Intel Celeron 2955U Dual-Core

» 26B of 1600 MHz DDR3 RAM » 166B Solid State Drive

» Integrated Intel HD Graphics » Free 100GB on Google Drive for
2Years » 2-in-1Media Card Reader » 10/100/1000 Mbps Gigabit Ethernet » 802.11a/b/g/n Wi-Fi,
Bluetooth 4.0 » DisplayPort, HOMI, USB 3.0 » Google Chrome 0S

[ASCBMOOAU)......ooo o

198,19




COMPUTERS

P27150 27~ 4k Monitor
» In-Plane Switching (IPS) Technology
» DisplayPort Input + DisplayPort Output
» Mini DisplayPort + HOMI (MHL) Inputs
» 3840 x 2160 Resolution
»2,000,000:1 Contrast Ratio
» 350 cd/m? Brightness
» 178°/178° Viewing Angles
» 9 ms Response Time
» 1.07 Billion Colors » Built-In USB 3.0 Hub

(DEP2715Q) 480.00

/iS5US PB2870

28” Widescreen 4K UHD Monitor

» 3840 x 2160 4K Resolution

» 1 ms Response Time

» 300 cd/m?2 Brightness

» 1.073 Billion Color Support

» 170°/160° Viewing Angles

» 8 x SPLENDID Video Preset Modes
» 3 x Skin Tone Selection Modes

» 4 x Color Temperature Selection Modes

(ASPB2870) 394.99

BenQ, BL2711U
27" 16:9 4K UHD IPS Monitor
» In-Plane Switching (IPS) Technology
» DVI-DL/HDMI 1.4/ 2.0/ DP 1.2 Inputs
» 3840 x 2160 Resolution

» 1,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles

» 4 ms Response Time

» 100% sRGB Color Gamut

(BEBL2711U) 459.00

@ LG 38UCP9-W 38" 21:9 4K WQHD+
Curved IPS Monitor

» 38" IPS (In-Plane
Switching) Panel

» HOMI & DisplayPort
Inputs » 3840 x 1600
Resolution » Mega
Dynamic Contrast Ratio
» 300 cd/m? Brightness
» 178°/178° Viewing Angles » 5 ms Response Time (GtG)

—_— - -

(L638UCIIW) 1,696.99

yZexrite i1Display Pro

» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems
» Works On ALl Modern Display
Technologies » Field-Upgradeable
for Future Technology

» Rotating Diffuser Arm / Tripod Mount
» Basic and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy

(XREODIS3) 258.99

4K MONITORS & CALIBRATION SOLUTIONS

@ P24150 24” Ultra HD 4K Monitor
» In-Plane Switching (IPS) Technology

» DisplayPart Input + DisplayPort Output

» Mini DisplayPort + HOMI (MHL) Inputs

» 3840 x 2160 Resolution

» 2,000,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles

» 8 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub ~—onu_~

(DEP24150) 349.99

/iSUS PAI90

32" 16:9 4K/UHD IPS Monitor

» In-Plane Switching (IPS) Technology
» HOMI 2.0 & DisplayPort 1.2 Inputs

» 3840 x 2160 Resolution

» ASUS Smart Contrast Ratio

» 350 cd/m? Brightness

» 178°/178° Viewing Angles

» b ms Response Time

» 1074 Billion Color Support

(ASPA3290) 1,249.99

@ LG 320D99-W
31.5"16:9 HDR10 FreeSync IPS Monitor

» In-Plane Switching (IPS)
Technology » USB Type-C |
DisplayPort | HDM|

» 3840 x 2160 Resolution

» 350 cd/m? Brightness = B
» 178°/178° Viewing Angles - . -

» b ms Response Time » Supports HOR10

» AMD FreeSync Technology

(LG32UD99BK) 999.00

@ LG 43UD79-B 43" 16:9 4K IPS Monitor
» In-Plane Switching (IPS) Technology

» HDMI + DisplayPort +

USB Type-C Inputs

» 3840 x 2160 Resolution

» Mega Dynamic Contrast Ratio
» 360 cd/m? Brightness

» 178°/178° Viewing Angles

» 5 ms (6t6) Response Time

» 1.06 Billion Colors

(LG43UD79B) 696.99

datacolor mem Spyder5PRO
Display Calibration System

» Calibrate Laptops, Desktop Monitors
» Includes Color Probe

» 16 Calibration Choices

» 3 Ambient Light Settings

» Before and After Evaluation

» Basic Display Analysis

» Comes in a Reusable Box / Case

(DAS5P100) 189.00

@ U3818DW
37.5" 21:9 Curved IPS Monitor

» 337.5" In-Plane Switching (IPS) Panel
» DisplayPort & HDMI Inputs
» 3840 x 1600 Resolution

» 1,000:1 Contrast Ratio

» 350 cd/m?2 Brightness

» 178°/178° Viewing Angles
» b ms Response Time

» Covers 99% of sRGB Color Gamut » 2300R Curvature

(DEU3B160W)

1,126.37

NEC MultiSync EA275UHD-BK
27” Monitor

» In-Plane Switching (IPS) Technology

» DVI-D + DisplayPort + HDMI "
Inputs » 3840 x 2160
Resolution » 1000:1 Contrast
Ratio » 350 cd/m? Brightness
» 178°/178° Viewing Angles

» 6 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub

(NEEA275UHDBK) 679.99

w U28E590D 28~ widescreen
LED Backlit UHD Monitor
» Twisted Nematic Display Technology

» HDMI/ DisplayPort Inputs -
» 3840 x 2160 Resolution

» 1,000:1 Static Contrast Ratio
» 370 cd/m? Brightness

» 170°/160° Viewing Angles

» 1 ms Response Time

» AMD FreeSync Technology » 1 Billion Color Support

(SAU28E590D) 369.00

127s 27" 16:9 4K UHD IPS Monitor
» In-Plane Switching
(IPS) Technology
» HDMI1.4/DisplayPort/Mini-
DisplayPort
» 3840 x 2160 Native Resolution
» 1,000:1 Static Contrast Ratio
» 300 cd/m?2 Brightness
» 178°/178° Viewing Angles
» 6 ms Response Time » 1.07 Billion Colors
(HEZ275) 525.00

yz4x-rite ColorMunki Display
» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems

» For Virtually AU Modern Displays

» Field-Upgradeable for Future Technology
» Rotating Diffuser Arm / Tripod Mount

» Easy and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy

» Automatic Hardware Adjustment

(XRCMUNDIS) 168.99

800-947-5534 + 212-444-6740




UltraSharp

This UltraSharp Widescreen LED
Backlit IPS Monitor from Dell utilizes
in-plane switching technalogy to produce
178° horizontal and vertical viewing
angles. The widescreen display features a
16:10 aspect ratio with a 1,000:1 contrast
ratio and a 6 ms response time for crisp,
clear picture quality. The Dell monitors
comes ENERGY STAR Qualified, EPEAT

u2m7m

MONITORS

U26412M U2415

COMPUTERS

U2413

Fold Reted. and TC0 Certfed ll scresm rhes HOMI, DisplayPort, ' layPort, USB 3.0 IJE7D 418.00
» In-Plane Switching (IPS) Technology g . ¢ P ay_m'mlm ISPAYTOT, P8 .
. U2612M 1920x1200 24 300 cd/m? DVI-D, DisplayPort, VGA, USB 2.0 DEU2412M 224.95
»1,000:1 Contrast Ratio - - —
» 16.7 miilion colors 2415 1920x1200 24 300 cd/m? HOMI, DisplayPort, mini DisplayPort, USB 3.0 DEU2415 229.99
» 178°/178° Viewing Angles U2413 192001200 w 350cd/m? HDMI, DisplayPort, mini DisplayPort, DVI-D, USB 3.0 DEU413 439.99
» Tilt/ Swivel / Pivot / UP2516D 2660x1440 % 300 cd/m? HOMI, DisplayPort, mini DisplayPort, USB 3.0 DEUPZ516D 482.00
Height Adjustability UP2716D 2660x1440 27 300 cd/m? HDMI, DisplayPort, mini DisplayPort, USB 3.0 DEUP2716D 629.00

Wide Viewing Monitors
ASUS has included a blue light filter
and nearly eliminated all flicker from
within the display. By lowering blue
light emissions and eliminating display
flicker users benefit from increased

LA , VP239H-P VP247H-P VP2790-P VP228H
viewing comfort and reduced eye strain.
Addlt[;onallgi ASfUS hgs Inlc_luded t't(]f” Model Screen Size Ports SKU
own GamePlus functionality providing VP239H-P 0 HOMI D-Sub DVI-D ASVP239HP 139.99
gamers with both 0SD crosshair and -
. VP247H-P 23.6 HOMI D-Sub DVI-D ASVP24THP 139.99
timer features.

- VP2790-P i HDMI D-Sub DisplayPort ASVP2790P 209.00
»16.7 million colors - e 7 9.99
» 1920 x 1080 Resolution VP228H 15 HDMI D-Sub DVI-D ASVP228H 109.
» 250 cd/m? Brightness VP278H-P " HOMI D-Sub ASVP278HP 189.99

@ P2417H
23.8" 16:9 IPS Monitor

» In-Plane Switching (IPS) Technology
» DisplayPort + HOMI + VGA Inputs

» 1920 x 1080 Resolution

» 1,000:1 Static Contrast Ratio

» 250 cd/m? Brightness

» 178°/178° Viewing Angles

» 6 ms Response Time

» 16.7 Million Colors

(DEP2417H)

w S24D300H
24" 16:9 LCD Monitor

» Twisted Nematic (TN) Display [}
» D-Sub / HDMI Interfaces
» 1920 x 1080 Resolution

» 1000:1 Contrast Ratio

» 250 cd/m? Brightness

» 170°/160° Viewing Angles
» 2'ms Response Time » 16.7 Million
Color Support » 16:9 Aspect Ratio » Samsung Magic Angle

(SAS24D300H) 141.23

179.99

www.BandH.com

@ LG 34UM59-P
34" 21:9 FreeSync IPS Monitor

» In-Plane Switching
(IPS) Technology

» HOMI Inputs

» 2560 x 1080 Resolution
» Mega Dynamic Contrast
Ratio » 250 cd/m? Brightness
» 178°/178° Viewing Angles » 5 ms GtG Response Time
» 16.7 Million Colors

(L634UMB9P)

349.00

<NCEN GN246HL Bbid
24" 16:9 LCD Monitor

» Twisted Nematic (TN) Tech
» HDMI/VGA / DVI Inputs
» 1920 x 1080 Resolution
»100,000,000:1

Dynamic Contras Ratio

» 350 cd/m? Brightness

» 170°/160° Viewing Angles
» 1 ms Response Time » 16.7 Million Color Support

[ACG246HLO)

187.49

NEC PA272W-BK 27" LED
HDMI + (Mini) DisplayPort + DVI-D
» 2560 x 1440 Resolution

» 1,000:1 Contrast Ratio

» 340 ¢d/m? Brightness

» 178°/178° Viewing Angles
» 6 ms Response Time

» 1.07 Billion Color Support
» 14-bit Lookup Table

» 16:9 Aspect Ratio » Enhanced Color Gamut
(NEPA272WBK)

1,199.00

BenqQ, SW2700PT
27" Widescreen LED Backlit QHD Monitor

» In-Plane Switching (IPS) Technology
» DVI-DL/ HOMI 1.4/ DP 1.2 Inputs

» 2560 x 1440 Resolution

» 1000:1 Contrast Ratio

» 350 cd/m?2 Brightness

» 178°/178° Viewing Angles

» 5 ms (GtG) Response Time

» 1.07 Billion Color Support

(BESW2700PT)




2big Dock
Thunderbolt™ 3

RAID Storage | 4-in-1 docking station

SO MUCH MORE THAN STORAGE

 SD and CF card readers, USB 3.1 hub,
and DisplayPort for 4K monitors

e 2-bay RAID 0,1
e Transfer 1 hour of footage in 1 minute*

* Store up to 200K raw image files

* On average, 1 hour of 4K 30fps compressed footage creates 30GB of data

™

design by neil poulton



STORAGE ENCLOSURES & INTERNAL NAS DRIVES

Atomos Master Caddy 4K RAW
Angelbird » Unified Caddy/SSD Design
» No Assembly Required
» ECC and TRIM Support
» Up to 510 MB/s Write Speed
» Up to 550 MB/s Transfer Speed
» CNC-Machined Housing

2TB (ANAGKR2000) ... 1,499.00
1TB (ANAZKR1000) 699.00
96GB (ANAGKRE00) ... 39900

* Black NVMe M.2
Internal SSD

» M.2 2280 Form Factor

» PCle 3.0 x4 Interface

» Up to 2,050 MB/s
Read Speed

» Up to 800 MB/s Write Speed

» WD SSD Dashboard & Acronis True Image

5126B (WES51261X0C)
2566B (WES256G1X0C) oo

199.75
e 114,99

" Black Series
Internal Hard Drives
» 3.6 Form Factor )
» High-Speed 32
Data Transfer WD BLACK
» Increased Reliability

» Compact

" Black Series

» 2.5" Form Factor

» High Performance
» Dynamic Cache

SONY G Series 2.5” SATASSD
» Works with Atomos &
BMD Video Recorders
» Up to 500 MB/s Write Speed
» Up to 550 MB/s Read Speed
» 1200 Terabytes Written (TBW)
» Error Correction Code (ECC) Technology
» Data Protection Technology
» Windows & Mac Compatible
966B (S0SV6596)
48GB (SOSVGSAS)... oo

533.35
. 283,89

‘W 960 EVO NVMe M.2 Internal SSD
» M.2 Form Factor

» PCle 3.0 x4 Interface

» Up to 3,200 MB/s Read Speed

» Up to 1,800 MB/s Write Speed

» Samsung Polaris Controller

» NAND Flash Technology

» AES 256-bit Data Encryption

1TB (SAMZVSETTOBW) 467.00
500GB (SAMZVOESOOBW.......c. 234,00
25068 (SAMZVOEZS0BW.........cccc. 117,60

Internal Hard Drives

» 3.5” Form Factor
» Versatile

» Low Power

» NoTouch Ramp

" Blue Series PC Drive
Internal Hard Drives

COMPUTERS

Atomos Master Caddy 4K (1TB)
swanon 1TB SSD Designed for Atomos Products
» Unified Caddy/SSD Design » No Assembly Required
» Up to 500 MB/s Transfer Speed

[6T0605221) . 949,98

I 960 PROM.2 Internal SSD

» M.2 Form Factor

» PCle 3.0 x4 Interface

» Up to 3,500 MB/s Read Speed
» Up to 2,100 MB/s Write Speed
» Samsung Polaris Controller

» NAND Flash Technology

» AES 2b6-bit Data Encryption

2TB (SAMZV6P2TOBW) 1,204.99
TTB (SAMZVEPITOBW .. 986,99
51268 (SAMZVEPSTZBW).....occcoo. 299,99

" Blue Series

Mobile PC Drive

Internal Hard Drives

] » 2.5" Form Factor
WD BLUE

(o
WD BLUE

» Compact
» Low Power

» For Creatives, Load Technology » Wiely Compatible
Enthusiasts,
and Gamers

STARTING AT .......... 69.99 STARTING AT ... 59.00 STARTING AT ... 49.99 STARTING AT 59.00

" Gold Series
Internal Hard Drives

" Blue Series PC SSHD

Internal Hard Drives

" Red Series / Pro

Internal Hard Drives

" Purple Series
Internal Hard Drives

» PCSSHD ) » 3.5” Form Factor » 35" Form Factor ) » 35" Form Factor
» 3.5” Form Factor = » HelioSeal Technology = » Designed for 2 » Error Recovery 32
» Hybrid Drive » High Workload Rating s sl 24/7 Surveillance WD PURPLE » NASware WD RED
» Self-Learning » Vibration Protection » Supports up to 3.0 Technology
Technology » Time-Limited 64 Cameras » For Small and
» Fast, Smart, Error Recovery » For DVR & NVR Big Businesses
and Efficient
STARTING AT ... 44.99 STARTING AT ....... 88.99 STARTING AT .......59.00 STARTING AT .......55.99

@SEAG!\TE

Barracuda Series / Pro
Internal Hard Drives
» 1TB - 10TB Capacity

» Versatile

» Fast

» Dependable

STARTING AT .................49.99

www.BandH.com

@SEAG!\TE

Ironwolf Series / Pro
NAS Drives

» 178 - 10TB Capacity

» Tough

» Ready

» Scalable

STARTING AT 64.99

@ SEAGATE
Skyhawk Series
Internal Hard Drives
» 7B - 10TB Capacity

» Surveillance

» Smart

» Safe

» Secure

STARTING AT 54.00




COMPUTERS

crucial MX300 Series
SATA Il 2.5" SSD

» SATAIII 6 Gb/s Interface

» Read 530 MB/s

» Write 510 MB/s

» Acronis True
Image HD Included

» 3D NAND Technology ~~

» 9.5mm Spacer Included

2TB (CR2050MX300S) 549.99
1TB (CR1050MX300S) ... 289,99
51268 (CR525MX300ST) ..o 149.99
25668 (CR275MX3008S) ... 99.99

PINY (51311 Series
SATA Il 2.5" SSD

» SATAIII 6 Gb/s
Interface

» Write 520 MB/s

» Read 550 MB/s

» TLC NAND
Flash Memory

» Shock Proof

» Includes 2.5" / 9.5mm Drive Bay Adapter

960GB (PNSSD7CS1396)........c..cc....... 359.00
480GB (PNSSD7CST348)....c.. 199.00
2406B (PNSSD7CS1324) ... 99.00

San)isk’ Extreme Pro Series
SATA 2.5" SSD

» Read 550 MB/s

» Write 515 MB/s

» SATA 3 Interface

» Low Latency

» SSD Dashboard

» Enhanced Shock &
Vibration Resistance

» Energy-Efficient Operation

4B0GB (SASSDXPSAB0)..........e. 219,00

USB 3.1 Type-C External SSD

» Available in Black, Grey,
Silver and Gold

» 2756B - 2TB capacity

» USB 3.1 Type-C Connectivity

» Up to 480 MB/s Data
Transfer Speeds

» Rugged Design

» Two Types of USB
Cables Included

» Preformatted for Mac

» Windows Compatible with Reformatting

Call or Log-On

SSD DRIVES

\).\ Ultimate SU800

LADATA gATA 111 2.5" SSD

» SATAIII 6 Gb/s
Interface

» Write 500 MB/s

» Read 550 MB/s

» SMI Controller

» SLC Caching and
DRAM Cache Buffer

» 30 TLC NAND Flash Memory

1TB (ADASUBDOTTB) ..o 369.00
5126B (ADASUB00512C) . .
25668 (ADASUBO0256C) ... 99.95
1286B (ADASUB00128C) .....ccccc.....64.00

" Blue Series
SATA Il 2.5" SSD

» SATAIII 6 Gb/s
Interface

» Write 545 MB/s

» Read 525 MB/s

» Tiered Caching
Technology

» WD SSD Dashboard
Software Includeda

WD BLUE

1TB (WEWDSTOOTIBO) ..o 288.98
500GB (WEWDS500G1BO) ... 149.99
25068 (WEWDS250G1B0) ... 89.99

Samn)isk' SSD Plus Series
SATA Il 2.5" SSD

» SATAIII
6 Gb/s
Interface
» Read 530 MB/s
» Write 440 MB/s
» SLC Caching
» Includes Cloning Software

2406B (SASSDP240626) 84.00
120GB (SASSDP120626) ....ccccc.....64.00

G-DRIVE ev RaW USB 3.0
e With Rugged Bumper

» 500GB Capacity
» USB 3.0 and SATA
Interfaces
» Transfer Speeds up
to 425 MB/s » Shock
Resistant up to 6.6/ 2m
» 425 MB/s Transfer Rates
» Rugged and Lightweight
» Includes a Removable Bumper
» Designed for On-the-Go Access
» Formatted for Mac

(6TOGOATSD) ...oococ

19995

Mercury Extreme Pro 66
2.5" SATA Il SSD

» SATAIII 6 Gb/s Interface

» Read 500 MB/s

» Write 450 MB/s

» Silicon Mation
SM2246EN Controller

» Tier T MLC NAND Flash

» Supports RAID 0/1/10/0+1

and SPAN usage. —
» 646B Dedicated to Redundancy & Errors
1TB (OWCSD7P66960).......o ... 399.50
480GB (0WMEP7480) . ... 248.50
2406B (OWMEP7240) ... 148.50
120GB (OWMEP7120) ... 87.50

w 850 PRO Series
SATA 2.5" SSD
» Read 550 MB/s
» Write 520 MB/s
» 3D V-NAND Flash
» 256-bit AES
Encryption
» RAPID Mode
» Windows & Mac

2TB (SAMZ7KE2TOBW) 867.99
1TB (SAMZTKETTOBW)....... 56B.TY
5126B (SAMZTKESTZBW).......c...coc..... 237.99
25668 (SAMZTKEZ56BW)............................. 129.00

San)isk' Ultrall Series
SATA Il 2.5” SSD

» SATA Il 6 Gb/s
Interface s il

» Write 500 MB/s

» Read 550 MB/s

» nCache 2.0
Technology

» 1.75 Million Hours MTBF

960GB (SADSSDHIN960) ... 289.00
480GB (SADSSDHIIAB0).........c..... 159.00
2406B (SADSSDHIIZ40).......ccc..... 94,00

Lexar" USB 3.0
Portable External SSD
» USB 3.0 Interface
» USB 2.0 Compatible
» Read Speeds:
up to 450 MB/s
» Write Speeds:
up to 245 MB/s
» LED Capacity Meter
» USB Bus Powered
» Lexar Professional Workflow Compatible

2566B (LEWFSSD256) ... 92,99
5126B (LEWFSSD512) 164.00

Mercury Electra 36
2.5" Serial-ATA SSD

» Read 250 MB/s

» Write 230 MB/s

» SATA 3 Gb/s Interface

» 2.5" Form Factor

» MLC NAND Flash

» RoHS Compliant

» |dle/Seek
Acoustics: 0.0 bels

2TB (OWSSD7E36025) 748.75
4B0GB (OWME3G7480)...........c.c... 21450
2406B (OWME3G7240).......cc.o .. 128,75
1206B (OWME3G7120)......cc. ... 88,75

W 850 Evo Series
2.5" SATA Il SSD

» SATA NIl 6 Gb/s Interface
» Read 540 MB/s
» Write 520 MB/s
» Samsung MHX
Controller
» 256-Bit AES
Encryption

» TurboWrite & 3D V-NAND Technology

4TB (SAMZTSEATOBA) ... 1,556.54
2TB (SAMZ7SE2TOBA) ..o 697.99
1TB (SAMZTSETTOBA) ..o 347,99
5006B (SAMZ75E5008A) ..

25068 (SAMZTSEZSOBA)

San)isk' Ultra Series
SATA Il 2.5" 3D SSD

» SATAIII 6 Gb/s

Interface
» Write 530 MB/s
» Read 560 MB/s
» nCache 2.0

Technology
» 100 Total Bytes Written (TBW)
2TB (SASDSSDH32T) 709.99
1TB (SASDSSOH3TT) oo 399.99
500GB (SASDSSDH3500) ... 199.99
2506B (SASDSSDH3250) ..o 99.99

@< Rugged Thunderbolt
External SSD w/ USB Type-C Port
» Integrated Thunderbolt Cable
» USB 3.0 Type-C Port
» Bus-Powered
» Drop-Resistant
Upto 6.6 \
» |Pb4-Rated Resistance
» USB-C to USB-A & USB-C Cables Included

» AES 256-bit Software Encryption
» Windows & Mac Compatible

5006B (LASTFS500400) ... 329.00
1TB (LASTFS100041) .. 569.00

800-947-5534 - 212-444-6740




=1 My Book Duo Two-Bay USB 3.0 Type-C
External RAID Storage

» Two Drive Bays » USB 3.0 Type-C & USB
Type-A Interfaces » Supports RAID 0,
1,and JBOD » Configured as RAID 0

» Sequential Read Speeds of up to 360 MB/s

» 2-Port USB 3.0 Hub

» Formatted NTFS for Windows

4TB (WEWDBFBE04D).......269.99  12TB (WEWDBFBE0120).....419.99
6TB (WEWDBFBE00D)........ 289.99  16TB (WEWDBFBEO160).....599.99
8TB (WEWDBFBEO0S0) ... 329.99  20TB (WEWDBFBE0200)......799.99

G-RAID
oo Thunderbolt 2 RAID Array
» Two 3.5" Drive Bays
» 2 x Thunderbolt 2, 1x USB 3.0
Ports » RAID 0,1, and JBOD
» Preconfigured in RAID 0
» Hardware RAID Controller g
» Data Transfer Speeds up to 480 MB/s

BTB (6T0G0A08)......... o 99,95
127TB (670604093) 749.95
TOTB (GTO60A097)...... . 949,95

FROMISE Pegasus3 R4 Mac Edition
4-Bay Thunderbolt 3 RAID Array
» & Hot-Swappable Drive Bays

» 2 x Thunderbolt 3 Ports

» RAIDO, 1,5, 6,10, JBOD

» Pre-Configured in RAID 5 Mode
» Hardware RAID Controller

» Mac Compatible

4TB (PRP3REHDIOUS) ...
BTB (PRPIRAHDIZUS) ..o

e 1,765.00
e 1,654.00

@D ?7hig Thunderbolt 2
Series 2-Bay RAID (5]
» Two Hot-Swappable Drive Bays

» Thunderbolt 2 and USB 3.0 Interfaces
» RAID 0, 1, and JBOD

» Preconfigured in RAID 0

» Hardware RAID Controller

» Read Speeds of up to 440 MB/s

6TB (LAZBIG6TBT2)

8TB (LAZBIGBTBT2) .o
16TB (LASTEY160001) ..o

399.00
[—. 11 X
F—L 4 AL

» 2x3.5" Drive Bays

» 2 x Thunderbolt 2 /
1xUSB 3.0 Type-B

» RAID 0, 1, JBOD, & SPAN

» Pre-Configured as RAID 0

» Data Transfer Speeds up to 360 MB/s » Hardware Controller

» Auto-Sensing Power Supply

8TB (GLSRTBB00O)........... 599.95
6TB (GLSRTB6000) 449.95
4TB (GLSRTBA0O0O)............. 409.95

16TB (6LSRTB16000) .......999.95
10TB (GLSRTB10000) .......699.00

www.BandH.com

RAID

21 MyBook Pro Two-Bay
Thunderbolt 2 RAID Array
» Two Hot-Swappable Drive Bays

» Thunderbolt 2 & USB 3.0 Interfaces

» Supports RAID 0, 1, and JBOD

» Hardware Configured in RAID 0

» Max. Data Transfer Rate: 350 MB/s

» Formatted in HFS+

Journaled for Mac 03 X 10TB (WEWDBOTB10JS)... 639.99
16TB (WEWDBDTB16)S). 999.00  8TB (WEWDBOTBBJSL)._599.00
12TB (WEWDBDTB12JS). 799.00  6TB (WEWDBOTB6JSL). . Log-On

G-RAID

wreemeer ThUNderbolt 3 RAID Array
» Two Drive Bays r

» Thunderbolt 3 | USB 3.1 [ HOMI
» Supports RAID 0, 1, and JBOD
» Hardware RAID Controller

» Up to 440 MB/s Data Transfer Speed e es =
» Daisy Chain up to b Additional Devices

TOTB (BTOG0SE8)...... 999,95
1278 (GT0605753) 799.95
BTB (GTOB05748) ... 049,98

FROMISE Pegasus3 R6 Mac
Thunderbolt 2 RAID Storage Array
» Includes 6 x 2TB SATA HDDs

» 12TB Storage Capacity

» 2 x Thunderbolt 2 Ports

» 6 Hot-Swappable Drive Bays

» Pre-Configured in RAID b Mode

» Supports RAID 0, 1,5, 6, 10, 50

» Compatible with Time Machine in 0S X

36TB (PRP3REHD36US) oo 3,999.00
18TB (PRP3ROHD24US) ... Call oF Log-On

@D 6hig Thunderbolt 3
6-Bay RAID Array

» 6 x 4TB Enterprise-Class 3.5" HDDs
» Six Hot-Swappable Drive Bays

» 2 x Thunderbolt 3, 1 x USB 3.1

» 0/1/5/6/10/50 RAID Support

» Up to 1400 MB/s Reads and Writes

24TB (LAGBIG2ATBTS) . 2,699.00
367TB (LA6BIG36TBT3) 3,499.00
LBTB (LAGBIGABTBTS) oo 4,399.00
60TB (LAGBIG6OTBT3) ..o Call oF Log-On
7= ThunderBay 4

RAID 5 Edition

» 4x3.5" SATA Il 6 Gb/s Drive Bays
» 2 x Thunderbolt 2 Interfaces
» 7200 rpm » Supports RAID 0, 1, 4,

5,and 1+0 » Pre-Configured as RAID b
» Software Controller
Enclosure Only (OWTBATB24)..........c.cc.occccvec.
8TB (0OWTB4TB28) 877.50
12TB (OWTB4TB212).........977.50
16TB (0WTB4TB216)....1,197.50

e 129.50
20TB (OWTB4TB220).....1,347.50
24TB (OWT424)............. 1,599.75

32TB (0WT432) 1,998.75

COMPUTERS

@ 80TB G-SPEED Shuttle XL Thunderbolt 3

cemoor. RAID Array (8 x 10TB)
» Eight Drive Bays

» 2 x Thunderbolt 3 Ports

» Supports RAID 0,1, 5, 6, 10, and 50

» Pre-Configured as RAID 6

» Hardware RAID Controller

» Up to 2000 MB/s Data Transfer Speed

» Daisy Chain up to 5 Additional Devices

» Preformatted for Mac

[6TOG05BO4) ..o

@. G-SPEED Studio
cemeoe Thunderbolt 2

» 4 x 8T8 3.5" Enterprise Class Drives

» 2 x Thunderbolt 2 Ports (up to 20 Gb/s)
» RAID 0, 1,5, and 10 Compatibility

» Pre-Configured in RAID b

» 700 MB/s RAID 0 Transfer Speed

24TB (6T0603302)

T16TB (GTOG03298)......oc
T2TB (6T0GO3294).....

i 1,999.95

@D ?2hig Thunderbolt 3 Dock

» 2 x Thunderbolt 3 | 1x USB 3.1 Type-C
» 1xUSB 3.0 Type-A | 1x DisplayPort
» CompactFlash & SD Card Slots

» Supports RAID 0, 1, and JBOD

» Pre-Configured as HFS+ RAID 0

» Hardware Controller

20TB (LASTGBZ0000).........
T0TB (LASTGBI000A)........coc

12TB (LASTGB120004)

BTB (LASTGBBO00AD) ...

@D d2 Thundebolt 3

» 10TB Storage Capacity

» Thunderbolt 3 & USB 3.1 Interfaces
» Max. Data Transfer Rate: 240 MB/s
» Aluminum Unibody Construction

10TB (LASTFY100004) ..

8TB (LASTFY800040)

6TB (LASTFYB00040) ...

SONY PSZ-RATHUNDERBOLT 2

Portable RAID Array

» 2x 218 3.5" Hard Drives
» Two Drive Bays
» Thunderbolt 2 and
USB 3.0 Interfaces
» Preconfigured in RAID 0

-

—

L¢]

1,624.95
i 1,699.95
....999.95

c21,199.00
e 1,049.00

799.00

....649.00

» RAID 0, 1,and JBOD » Hardware Controller
» Transfer Speeds of up to 440 MB/s » Shock-Resistance Design

4TB (SOPSZRAATBA ..o
6TB (SOPSZRAGTBA) ...

....599.94

499.94

... 399.94

... 399.72
o bT5.74



COMPUTERS

CZ My Cloud
» Gigabit Ethernet and USB 3.0
» Dual-Core Processor
» DLNA 1.5 and UPnP Certified
» Free Desktop and Mobile Apps
» Auto Network Discovery _’
» Windows and Mac Compatible
.

2TB (WEWDBCTLOO20) ... Call or Log-On
4TB (WEWDBCTL0040) Call or Log-On
6TB (WEWDBCTLO060) ... Call OF LOG-On

PROMISE

TECHNOLOGY, INC. Apnllo cloud

» Gigabit Ethernet Port

» USB 3.0 Type-A Port for Backup

» Personal Cloud Storage

» Apple Time Machine Compatible

» Works with Apollo Cloud App

» Supports up to 10 Users

» Ethernet and Power Cables Included e =
» Supports i0S and Android Devices

4TB (PRAPOLLO)
2TB (PRAPOLLOZTB)..

299.00
199.00

logy" DiskStation 1817+
8-Bay NAS Enclosure

» 8x3.57/2.5" SATA Drive Bays
» 2.4 GHz Intel Atom
(2538 Quad-Core
» 4 x Gigabit Ethernet Ports
» 4 x USB 3.0 Ports & 2 x eSATA Ports
» RAID0,1,5, 6,10, and JBOD » Up to 1179 MB/s
Sequential Reads » AES-NI Hardware Encryption Engine
2TB (SYDS1817P2) ... -
8TB (SYDS18 7PBGB],

.849.00
... 949.99

dropo. B810i 8-Bay iscsI SAN Enclosure

» §x3.5" SATA Drive Bays » 3 x Gigabit Ethernet Ports
» BeyondRAID Technology » Hybrid Storage & Data-Aware Tiering
» Drobo Dashboard » Smart Volumes & Thin Provisioning
» Microsoft Multipath 1/0 (MPIO) » No Tools Needed for 2.5" Drive
Carriers » Windows, Mac, & VMware Compatible
[DRBBTOIBAZT ..o

1,094.00

QNRAP TS-451+ 4-Bay Home
and SOHO NAS Server

» 2.0 GHz Intel Celeron Quad-Core
» 268 of DDR3L RAM
» Up to 225 MB/s Read,
224 MBfs Write » 2 x USB 3.0
Ports & 2 x USB 2.0 Ports
» 1 x Gigabit Ethernet Ports
» RAID0,1,5,5 + Hot Spare, 6, 10
» AES 256-Bit Volume Encryption » Virtualization Ready
{ONTSABT2G) .

442.99

NAS DRIVES

21 My Cloud Mirror (Gen 2)

» 1.3 GHz Dual-Core Processor

» 512MB of RAM » 1 x Gigabité
Ethernet Port » 2 x USB 3.0 Ports

» Preconfigured in RAID 1

» Centralized, Dual Drive Storage H '

» Remote Access from PC/Tablet/Smartphone = v

» Windows/Mac/i0S/Android Compatible

4TB (WEWDBWVZ0040)
OTB (WEWDBWVZO060) ...
8TB (WEWDBWVZO080) ...

Call or Log-On
349.00
399.00

CZ My Cloud PR4100
» 1.6 GHz Intel Pentium
N3710 Quad-Core
» 4GB of Onboard DDR3L RAM
» 7 x Gigabit Ethernet Parts
» 3x USB 3.0 Ports
» RAIDO, 1,5, 10, and JBOD

BTB (WEPRA10008) ..o 199.00

16TB (WEPRA10016) Call or Log-On
24TB (WEPRA10024) ..ooooooooooeoeo.......Call or Log-On
32TB (WEPRA10032) .. 1,649.00

logy" DiskStation 1517+
5-Bay NAS Enclosure

» 5x3.5°/2.5” SATA Drive Bays
» 2.4 GHz Intel
Atom C2538 Quad-Core
» 868 of DDR3 RAM
» 4 x Gigabit Ethernet Ports
» 4x USB 3.0 Ports & 2 x eSATA Ports
» RAIDO,1,5,6,10,and JBOD
2TB(SYDSTB17P2) e
BTB (SYDSTB17PGB) oo

699.99
799.99

dropo. 36.6TB B1200i 12-Bay isCSI NAS

o -

» 12 x 3.5" SATA/SAS Drive Bays » 4 x Gigabit Ethernet Ports
» BeyondRAID Technology » Data-Aware Tiering

» Smart Volume Technology » Drobo Dashboard Management
» 3U Rackmount Form Factor

» Supports VMware vSphere 5.0 - 6.0 (ESXi)

(DRBT200MA36) . 8,499.00

QNRAPTS-251+ 2-Bay Home and
SOHO NAS Enclosure

» 2.0 GHz Intel Celeron Quad-Core

» 268 of DDR3L RAM

» 2 x Gigabit Ethernet Ports

» 2xUSB 3.0 &2 x USB 2.0 Ports

» RAID 0,1, and JBOD Support

» Read & Write Speeds: up to 225 MB/s
» FIPS 140-2 AES 256-Bit Encryption

» (NAP HD Station & HDMI Connectivity
Enclosure Only (ANTS25126) ..o

CZ) My Cloud EX2 Ultra

» 2% 3.5" Hard Drive Bays

» 1.3 GHz Processor

» 16B DDR3 RAM

» RAID 0, 1, JBOD, & Spanning Modes
» Integrated FTP & WebDAV Server

» iSCSI Target and Initiatorr

TOTB (WEWDBVBZ160) ...
12TB (WEWDBVBZ120)

BTB (WEWDBVBZBO)........cc
GTB (WEWDBVBZAD) ...

807.99

Call or Log-On

599.00
Call or Log-On
349.00

£ My Cloud PR4100
» 1B Storage Capacity
» 4 x 2TB Hard Drives
» 1.6 GHz Intel Pentium
N3710 Quad-Core
» 4GB of Onboard DDR3L RAM
» 1 x Gigabit Ethernet Ports
» 3x USB 3.0 Ports
» RAIDO, 1,5, 10, and JBOD
» Gold Plated RJ-45 Connectors

BTB (WEPRATO008Q) ..o

logy RackStation RS4017xs+
16-Bay NAS Enclosure

» 16x2.5°/3.5" SATA Drive Bays » 2.1 GHz Intel Xeon D-1541
Octa-Core CPU » 8GB of DDR4 ECC RAM » 4 x Gigabit Ethernet,
2 x 10GbE Ports » 2xUSB 3.0 Parts » 2 x PCle 3.0 x8 Slots

Enclosure Only (SYRSA017XSP)....oocooooo..5,299.99

G-Rack 12 12-Bay
SAS NAS Expansion Chassis

GTechnoloay:

P

» 12 x 4TB 3.5" Hard Drives » 12 x Drive Bays
» 2 x Mini-SAS Interface » Dual 740W Power Supplies

4BTB (6T060A926)........oo. 11,899.95
72TB (6T0604925) 12,599.95
9OTB (GTOB04926)..... 14,599.95

o) ThECUS NGB10
4-Bay NAS Enclosure

» 4x 3.5 SATAIII Drive Bays
» 1.6 GHz Intel Celeron N3160
Quad-Core » 4GB of DDR3 RAM
» 1 x Gigabit Ethernet Ports
» 1xUSB 3.0 Type-C,
3x USB 3.0 Ports
» RAIDO, 1,5, 6,10, and JBOD
» HDMI & DisplayPort Outputs
(THN4810)

4£19.99

800-947-5534 - 212-444-6740




CZ My Passport Ultra
USB 3.0 External Hard Drive

» USB 3.0 Interface » Bus Powered
» 256-Bit AES Hardware Encryption
» Up to 5 Gb/s USB 3.0 Transfer Rate
» Includes WD Backup Software

» USB 3.0 Cable Included

4TB (WEBFKT004BGD)
3TB (WEBFKT003BGD)
2TB (WEBFKT002B6D)
1TB (WEBTLG001BGD)

@ G-DRIVE mobile usB 3.0 Type-c

weamoo EXternal Hard Drive

» 118 Storage Capacity

» USB 3.0 Type-C Interface » 7200 rpm

» Up to 136 MB/s Data Transfer Speed

» Bus Powered » Includes USB 3.0 Type-C Cable

» Includes USB 3.0 Type-C to Type-A Cable

» Time Machine Compatible

1TB (6T0604876) 94.95
119.99

» Preformatted for Mac 0S 10.9

@) sencare 2TB DJIFly Drive
External Hard Drive

» 7B Capacity

» USB 3.0 Type-C Interface

» Integrated UHS-II microSD Card Slot

» Built-In USB Type-C Cable

» Windows and Mac Compatible

(SET6H2000400)

@< Rugged Thunderbolt
Portable External HD
» SATA 6 Gb/s Interface
» 1xUSB 3.0 Port
» 1x Integrated
Thunderbolt Cable
» Bus Powered \ A
» AES 256-bit Encryption
» Shock, Dust, Water Resistant

1TB HDD (LASTEV100040)
2TB HDD (LASTEV200040)

129.00
174.00

SamDisk' Extreme510
USB 3.0 External SSD

» 480GB Storage Capacity

» Sequential Read Speed up to 430 MB/’
» Sequential Write Speed up to 400 MB/s

» USB 3.0 Interface

» Bus Powered » 128-bit AES Encryption

» Rugged Rubber Bumper » Water, Dust, & Shock Resistant
» Vibration Resistant » Windows & Mac Compatible

249.99

(SASDSSDEXTWA)

www.BandH.com

PORTABLE HARD DRIVES

CZ) My Passport USB 3.0

Secure Portable Hard Drive

» USB 3.0 Interface » USB 2.0 Compatible
» Bus Powered » Data Protection

with Hardware Encryption
» USB 3.0 Cable Included
» Includes WO Backup Software
4TB (WEMP4WDBYFB)
3TB (WEMP3WDBYFB)

Call or Log-On
101.00
2TB (WEMPZWDBYFB) 79.00

1TB (WEMP1WDBYNB) Call or Log-On

G-Drive
e MODbIle Hard Drive with Thunderbolt
» 7200 rpm Speed

» Transfer Rates up to 136 MB/s
» Bus Powered via Thunderbolt/USB

» Time Machine Compatible 7
» USB 3.0and Thunderbolt ~ ©
Cables Included 2
» Preformatted HFS+ for Mac
1TB (6T0603040) 189.95

seagate (C" Backup Plus Slim Portable
External USB 3.0 Hard Drive y
» USB 3.0 Port

» Max. Sustained Read/Write
Speed: 100MB/s

» 5400rpm Disk Speed

» Seagate Dashboard for Automatic
Backup » Pre-Loaded NTFS
Driver for Mac » Free Seagate Mabile Backup App Available

1TB (SESTDR10008) 59.00
2TB (SESTDR200018) Call or Log-On

@<> Rugged Mini

Mini Portable Hard Drive

» USB 3.0 Interface

» 5400 RPM Speed

» Transfer Rate Up to 56b/s

» 47.2" Maximum Drop Height

» LaCie Private-Public Software

» Automatic Backup

1TB (LARMNU31) 89.99
278 (LARMD2)
4TB (LARMDA)

109.99
169.99

T5
Portable Solid State Drive
» USB 3.1 Type-C and Type-A Connections
» Up to 540 MB/s Data Transfer Rate
» USB Type-C & USB Type-A
Cables Included
» AES 256-Bit Hardware Encryption

500GB (SAMUPA500BAM) 197.99
250GB (SAMUPAZ50BAM) 121.99
1TB (SAMUPA1TOBAM) 397.99
2TB (SAMUPA2TOBAM) 791.99

COMPUTERS

CZ My Passport Wireless Pro
USB 3.0 External Hard Drive

» 802.1ac Wi-Fi, USB 3.0 Connectivity

» SD Media Card Slot

» Simultaneously Streams up to 8 HD Videos
» Up to 10 Hours of Battery Life

» Charge Mobile Devices » USB 2.0 Port

4TB (WEWDBSMT0040) 219.99
3TB (WEWDBSMT0030) 183.99
2TB (WEMPPW2TB) 170.99
1TB (WESSMPWL1000) 149.99

@ G-DRIVE ev RaW usB 3.0 Hard Drive
e With Rugged Bumper

©

» USB 3.0 and SATA Interfaces

» 7200 rpm > Shock Resistant
upto 9 /1.5m » USB3.0
Transfer Speeds up to 5 Gb/s

» Rugged and Lightweight

» Includes a Removable Bumper

» Designed for On-the-Go Access

» Formatted for Mac

seagate (C Expansion Portable
USB 3.0 External Hard Drive

178 (GTGDEVRAW1) 99.95
» USB 3.0 Connectivity

» Bus Powered

» Plug-and-Play Compatible

» USB 3.0 Cable Included

» Preformatted for Windows

» Mac Compatible with Reformatting

178 (SESTEA100040) 54.99
2TB (SESTEA200040) 69.99
4TB (SESTEA400040) 104.99

&> Rugged Thunderholt / USB-C Mobile HDD

» Thunderbolt / USB-C Connectivity
» AES 256-bit Encryption

» Bus-Powered

» Drop-Resistant Up to 6.5"

» Shock, Dust, and \ b
ble

Water Resistant
» Windows & Mac Compati

2TB (LASTFS200080) 199.99
4TB (LASTFS400080) 279.94
5TB (LASTFS500080) 299.99

CZ My Passport Ultra
USB 3.0 External SSD Drive
» USB 3.1 Type-C Connector

» Up to 515 MB/s Data Transfer Rate
» Bus Powered

» 256-Bit AES Encryption

» Shock Resistant up to 6.5

2566B (WEBK3E2560PS) 99.99
5126B (WEBK3E5120PS)
1TB (WEMP3WDBYFR)

189.99
359.99




Cruzer Glide

COMPUTERS

CZ43 Ultra Fit

Ultra

USB FLASH DRIVES

Sanisk

Ultra Dual

Ultra Flair

iXpand

Ultra USB

Connect USB 2.0 Wireless

S ) D (D "

USB 2.0 USB 3.0 USB 3.0 USB 3.0 / Micro-USB USB 3.0 USB 3.0/Lightning Ultra USB Type-C USB 2.0/802.11n Wireless
Retractable USB Connector Cap Design Capless USB Slider Design Designed for iPhone or iPad
86B  (SACCZ608GB)......7.65 | 1668  (SACZ4316GB)......8.95 | 166B (SAUUDI6GB)......10.95 - 1668 (SAUFU3FD16GB).....8.95 - - 3068 (SASA50326A46)...27.99
3268 (SACCZ60326B)....11.41 | 3268 (SACZ43326B)...12.99 | 3268  (SAUUD326B)....13.06 | 326B  (SADD3320)....16.99 328 (SAUFU3FD32GB)...13.95 = 3268 (SAS50326A46).16.99 | 6468 (SACWLMD64GB)...39.95
0468 (SACCZ60646B)....18.99 | 6468 (SACZA364GB)....22.30 | 64GB  (SAUUD64GB)...21.95 | 64GB  (SADD364G)....25.04 | 6468 (SAUFUSFD64GB)....20.95 | 64GB (SASDIX30C646)..... 74.95 | 64GB (SASAB064GA4). . 24.99 12868 (SACWLFD1286B)..74.95
- 12868 (SACZ431286B)...37.95 | 1286B (SAUUD128GB).....36.95 12668  (SADD31286)....43.55 | 12868 (SAUFUSFD1286)....37.99 | 1286B (SASDIX30C128)..109.95 | 12868 (SASA50128A46)....39.95 | 200GB (SACWLFD2006B)....99.99
— = 25668 (SAUUDZ56GB).....69.95 = — 75668 (SASDIX30N256)..199.95 — =
Kingston
T E C H. oLOGY
DataTraveler SE9 DataTraveler | G4 DataTraveler 100 G3 DataTraveler SE9 62 Datatraveler DT50 DataTraveler microDuo 3C HyperX Savage
L T A et
—=p .l L0 -
. b :
USB 2.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0/Lightning USB 3.1 Technology USB 3.0
Capless Design Protection Cap Capless USB Slider Design Capless Design Plug-and-Play Mac and PC Compatible Multi-Platform Compatibility
- - - Durable Metal Casing - - -
= - - - 868 (KIDT508GB)......6.99 - 0468 (KIHXS3646B)......49.39
1668 (KIDTSE916)... 1668 (KIDTIGAT6GB).......6.99 | 1668 (KIDT100G3166)........6.29 | 16GB (KIDTSE962166)......8.99 1668 (KIDT501668)......6.95 — 12868 78.83
3268 (KIDTSE93)... 3268 (KIDTIGA32GB)........12.75 3268 (KIDT10063326).......12.95 | 3268 (KIDTSE962326).....15.95 | 3268 (KIDT50326B)....12.95 | 3268 (KIDTMD3C326B)....16.95 | 25668 138.11
- - 0468 (KIDT1006364G).....22.99 | 6468 (KIDTSE9G2646).....26.85 | 646B (KIDT50646B) .. 24.01 | 646B (KIDTMD3C64GB)... 33.41 | 51268 (KIHXS35126B)....269.95
= - = 12866 (KIDTSE962128)...50.99 | 1286B (KIDT501286B) ... 49.34 | 12868 (KIDTOU03C128) . 54.00 -
SONY Pinsunc &) Transcend’
Microvault USM-X Dual-Connection FIT Drive JetFlash 810 JetFlash 790 JetFlash 700
. B S =) P G
USB 3.0 USB 3.0 Type-C/USB Type-A USB 2.0 USB 3.0 USB 3.0 USB 3.0
D‘]Smtfﬁ;xlgfﬁggw Incly d’:':ghgggg Cover Waterproof to 326" Remaovable Cap Capless Design / Slide-Out Port LED Indicator
- - - Shock/Splash/Moisture/Dust-Resistant Available in Black or White -
868 [SOMVXBGB)...... 8.99 - 368 (SAMUF32BBAM)..12.23 - - -
1668 [SOMVX16GB).....10.89 1668 (SOUSM16CA1S)....17.95 6468 (SAMUF64BBAM)...19.47 1668 (TRJF8101668).....11.99 166B (TRJF79016GBW).....8.99 1668 (TRJF700166B).......9.99
3268 [SOMVX326B).....21.78 3268 (SOUSM3ZCATS).... 24.95 12868 (SAMUF128BBAM). 36.89 3168 (TRJF8103268)...18.99 3268 (TRJF790326B).....15.99 3268 (TRJF700326B).......15.95
6468 [SOMVX646GB).... 43.99 6468 (SOUSMB4CATS).... 45.99 - - 6468 (TRJF79064GBW)....29.99 6468 (TRJF700646B)....32.95
— - — - 12868 (TRJF7901266B)...61.99 —
I§§q r PNY Y Verbatim.
JumpDrive S75 JumpDrive P20 JumpDrive C25i DUO-LINK 0TG USB 2.0 Flash Drive Metal Executive
el T
+ - L
|
USB 3.0 USB 3.0 Lightning to USB 3.0 Cable Lightning/USB 3.0 USB 2.0 USB 2.0
Metal alloy base with o ) USB 3.0 Connector ) ! Seamless Metal Enclosure
Retractable Connector mirtor finsh Built-In Flash Drive Lghting Comector Capless Slider Design Password Protecton Avalable
1668 (LELJDS7514GB)......8.95 3268 (LELJDP20326B)....22.99 3268 (LEJDC251326B).... 48.05 3268 (PNOTGFD32GB).... 54.99 268 (VEUDZGB).............. 6.52 -
3268 (LELJDS75326B)....12.99 6468 (LELIDP20646B).....39.99 0468 (LEJDC25164GB).... 74.75 0468 [PNOTGFD64GB).... 74.99 468 (VEUD4G).... 6.99 1668 (VE3SNG16GBBL)....9.93
6468 (LELIDST56468).....21.13 12668 (LELJDP201286)...69.95 12668 (LEJDC2511286)....106.79 — 868 (VEUDBGB) ... .69 3268 (VE3SNG32BB).....14.82
12868 (LELJDST5126)....37.95 - - - 1668 (VEUD16GB)...........8.99 6468 (VEMEFD64GBSL)..... 44.69
25668 (LELJDS75256).....76.99 - - - 3268 (VEUD3ZGB)........... 11.98 -
— = = — 6468 (VEUFD64GBBL)...23.94 =

B:H 800-947-5534 + 212-444-6740



MOTHERBOARDS, CPUS AND COOLING SYSTEMS RSO L atii a0 )

Motherboards

B&H carries Motherboards that support the latest generation Intel processors in the LGA2066 socket and AMD models that support X399 and
X370 chipsets that deliver CPU power, integrated graphics, RAID support, built-in surround sound and a wide selection of PCle slots and /0
ports for the user looking to custom build their ideal gaming system.

A Al R AN X -

Asus Asus Gigabyte Asus Asus Asus
Model Republic of Somers S - Republic o Gamers I270MMorter | Geming ProCarbon | GA-Z270-HD3P 1270 1270Gaming M5 | ROGStrixX299-E | TUF X299 Mark 1
Form Factor ATX Mini-ITX Micro-ATX ATX ATX ATX ATX ATX ATX
Chipset Intel 2270 Intel 2270 Intel 2270 Intel 2270 Intel 270 Intel 2270 Intel 2270 Intel X299 Intel X299
CPU Socket L6A 1151 L6A 1151 L6A 1151 L6A 1151 L6A 1151 LGA 1151 L6A 1150 L6A 2066 LGA 2066
Memory Support DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR4
Maximum Memory 646B 646B 646B 646B 3268 646B 646B 12868 12868
RAID 0,1,5,10 0,1,5,10 0,1,5,10 0,1,5,10 None 0,1,510 0,1,510 None 0,1,510
CrossFire / SLI CrossFireX and SLI None CrossFire CrossFire and SLI CrossFireX CrossFireX and SLI CrossFire and SLI CrossFire and SLI CrossFire and SLI
SKU ASRGSTRXZ27E ASNTELGA1151 MSZ270MMORTR MSZ2701GPCAR GIGAZ270HD3P ASPRIMEZ270A MS22706M5 ASROGSX299EG ASTUFX299MK1
Price 189.89 178.75 118.00 161.79 139.89 144.99 189.89 319.99 339.99
AMD Motherboards CPUs

B&H carries over 200 different CPUs
including the latest Kaby Lake, Skylake and
AMD Ryzen lines, supporting LGA2066, AM4,

& ny

Asus Asus
Model Republic of Gamers Gammgnggmun B350M Gaming Pro PRIME B350-PLUS gﬁggﬁ;‘ﬁ ffl E:t"r‘:ﬁe TR4 and many other CPU socket types.
Form Factor EATX ATX Micro-ATX ATX EATX
Chipset AMD X399 AMD X399 AMD B350 AMD B350 AMD X370
CPU Socket R4 TR4 AM4 AM4 AM4
Memory Support DDR4 DDR4 DDR4 DDR4 DDR4
Maximum Memory 12868 12868 3268 646B 646B
RAID None 0.1,10 0,1,10 0,1,10 0,1,10
CrossFire / SLI CrossFireX and SLI CrossFire and SLI None CrossFireX CrossFire and SLI
SKU ASROGZENXTRM MSX3996PCNAC MSB350MGMPRO ASPRIMEB350P ASROGCHVIEXT
Price 519.79 349.99 75.24 89.99 349.99
CPU Liquid Coolers CPU Air Coolers
BB (- mEs OF; 555 B9 RSE
! A .
NZXT Corsair Corsair Deepcool EVGA Cooler Master Deepcool Intel Thermaltake Zalman USA
Model Kraken X62 H'ﬁ‘g“;f{g‘fﬂ: Hydro H100iv2 | Captain 240 EX ClosegLL[t:mZ[?[iiqui s Model Hyper 212EV0 | Gammaxx 400 TS15A Gravity i2 CNPS9500AT
Fan Speed 2800rpm 2400rpm 2435rpm 2x 120rpm 280mm Fan Speed 2000rpm 1500rpm 3850rpm 1800rpm 2650rpm
Airflow 66.7 CFM 70 CFM 70 CFM 153.04 CFM 113.50 CFM Airflow 82 CFM 74.34 CFM 40 CFM 31 CFM NA
Sound 38 dBA 37 dBA 37 dBA 31 dba 39.5 dBA Sound 36dba 30dba 40dba 21dba 27 5dba
SKU NZRLKRX6202 COHSH115I COCW9060025 | DECP240EXWHT | EVCLC280LCC SKU CORR212E20R2 DEGAMX400 INBXTS15A THGI292MMCF | ZACNPS9500AT
Price 156.95 139.99 119.99 99.99 129.06 Price 29.99 23.89 21.19 12.99 34.95

LED Strip Lights Antec.  eneenix *@@ NZXT. @ hermaltake

LED Lighting Kit allows enthusiasts to set up lighting inside their computer cases. Using sleeved wires paired with multiple LEDs, an LED kit allows
users to hide lights between side panels and under components, creating a red glow effect and set the mood with different available colors.

www.BandH.com BSH



Mid-Tower Cases w/ Windowed Side Panel

-

POWER SUPPLIES AND COMPUTER CASES

Gaming Cases

NZIXT Corsair Thremalake Deepcool Corsair Cooler Master NZXT Deepcool
Model S340 Crystal 460X Core P3 SE Tesseract Model Carbide Series SPEC-02|  CM Storm Trooper H440 Genome Il
Motherboard ATX, Micro-ATX, ATX, Micro ATX, ATX, Micro-ATX, ATX, Micro-ATX, Motherboard ATX, Micro-ATX, ATX, Micro-ATX, ATX, Mini-ITX, E-ATX, ATX,
compatiblity Mini-TX Mini ITX Mini-TX Mini-TX compatiblity Mini-TX XL-ATX Micro-ATX Micro-ATX
Expansion Slots 7 7 7 7 Expansion Slots 7 9+1 7 7
Available Colors Black, White Black Black Black, Red, Blue Available Colors Black Black Black, White Black, White, ROG Edition
SKu NZCAS340WW1 coccootToTw COMCYDO5PKWN DETSRCTSW SKU CoccooTo51W COGCHO00KWN1 NZCAH442WW2 DEGENOMEZBKG
Price 69.99 149.99 109.99 41.99 Price 59.99 158.24 104.99 219.99
Cube Cases Mid-Tower Cases

Corsair Corsair Lian Li SilverStone Deepcool Corsair Antec Lian Li
Model Carbide Series Air 540 | Carbide Series Air 740 PC-08WX SG05-LITE Model Tesseract CC-9011077-Ww Three Hundred Two PC-TUT00
bt | M o oo | S M W | e | o | e
Expansion Slots 8 8 8 2 Expansion Slots 7 7 8 2
Available Colors Black, Sitver Black Black Black, White Available Colors Black, Blue, Red Black Black Black, White
SKU COCS540ACCBK COCARBAIR740 LIPCOBWX SISG05BBL SKU DETSRCTBF Cocoot1077Ww AN30ZMDTWRCS LIPCTUT00B
Price 129.99 149.99 379.99 39.99 Price 36.99 59.99 64.30 109.99

Power Supplies

For the user wanting to build thier PC from the ground up, or the advanced gamer who need to upgrade to more power, B&H carries a wide
assortmant of internal Power Supplies that are fully compatible with most computer cases. Whether you are looking for a unit with cables
hard-wired or a fully modular Power Supply without any permanently attached cables that simplifies installation and allows you to use only the
cables you need for a neat and clean build by improving performance by reducing airflow obstruction.

TP OPSoPDSPDS

EVGA Corsair Sea Sonic EVGA BitFenix SilverStone Thermaltake Corsair Antec Logitech
Model 5008 HX1000i Snow Silent 750 | SuperNOVA 650 G2 Whisper Strider SP-750P HX850i HCG-900 PS550
Wattage 500 W 1000 W 750 W 650 W 550 W 1500 W 750 W 850 W 900 W 550 W
Modular Non-Modular Modular Modular Modular Modular Modular Non-Modular Modular Modular Non-Modular
Povﬁecr“Fvaector No No Active Active Active Active Active Active No No
+12V Rails Single Multiple Single Single Single Single Single Single 4 Single
Certification 80 PLUS Bronze 80 PLUS Platinum | 80 PLUS Platinum 80 PLUS Gold 80 PLUS Gold 80 PLUS Gold 80 PLUS Bronze 80 PLUS Platinum 80 PLUS Bronze 80 PLUS
SKU EVBPS500 C0C9020074NA SESS750 EVNS85062 BIWG550UMAG7 SIST1500 THSP750P C0C9020073NA ANHCG900 LOPS50E12BK
Price Call or Log-On 239.99 139.98 99.99 79.00 299.99 67.99 189.99 149.99 26.99

B:H 800-947-5534 + 212-444-6740



NVIDIA GeForce GTX 1080 Ti
With a slightly overclocked core, dual

TORX fans, and based on NVIDIA's

Pascal architecture, the GeForce GTX
1080 Ti Graphics Cards provide major
improvements in performance, memory

bandwidth, and power efficiency over its predecessor, the high-

performance Maxwell architecture. It also introduces innovative
graphics features and technologies that redefine the computer as
the platform for playing AAA games and taking full advantage of
virtual reality via NVIDIA VRWorks. VRWorks Graphics includes a
simultaneous multi-projection capability that renders natively to the
unique dimensions of VR displays instead of traditional 2D monitors.

GRAPHIC CARDS

COMPUTERS

NVIDIA GeForce GTX 1060

With a slightly overclocked core and based on
NVIDIA's Pascal architecture, the GeForce
GTX 1060 Graphics Cards provide major
improvements in performance, memory
bandwidth, and power efficiency over its
predecessor, the high-performance Maxwell

architecture. It also introduces innovative
graphics features and technologies that redefine the computer as
the platform for playing AAA games and taking full advantage of
virtual reality via NVIDIA VRWorks. VRWorks Graphics includes a
simultaneous multi-projection capability that renders natively to the

unique dimensions of VR displays instead of traditional 2D monitors.

» 3584 CUDA Cores » 10 Gbps Memory Speed » DVI-D DL » 1920 CUDA Cores » 8 Gbps Memory Speed » DVI-D DL
» Pascal Architecture » 256-Bit Memory Interface » 7680 x 4320 Max Digital Resolution » Pascal Architecture » 256-Bit Memory Interface » 7680 x 4320 Max Digital Resolution
» 1168 of GODRGX VRAM ~ » DisplayPort 1.4 » HDMI2.0b » GeForce GTX VR Ready » 86B of GDDRS VRAM » DisplayPort 1.4 » HOMI2.0b  » GeForce GTX VR Ready
Brand ASUS m Gigabyte MSI Z0TAC Brand ASUS MSI EVGA EVGA ASUS
GTX 1080 GTX1080TiSC | GTX1080TiSC2 GTX 1080 Ti GTX 1080 AMP GeForce GTX 1060 = GeForce GTX 1060 | Rep. of Gamers Strix
Model ' rifurbo Edition GamingBlack Ediin _ HYBRID GamingX  Extreme Core Eiton Model  GeForceGTX1060  GeForce 6TX 1060 ™G,y SCGAMIN  OC GeForce GTX 1060
Base Clock 1480 MHz 1556 MHz 1556 MHz 1480 MHz 1670 MHz Base Clock 1569 MHz 1544 MHz 1506 MHz 1607 MHz 1620 MHz
Boost Clock 1582 Mhz 1670 MHz 1670 MHz 1683 MHz 1721 MHz Boost Clock 1809 MHz 1759 MHz 1708 MHz 1835 MHz 1873 MHz
Cooling Blower-Style i Cooler Blower-Style TWINFROZRVI | Triple Fan !ceStorm Coaling Dual Wing-Blade Single Fan Cooler Single Fan ACX 2.0 ACX2.0 DirectCU Il Cooler
Cooler Cooler Cooler Cooling Fans Cooler Cooler
SKU (ASGTX1080TIT) | (EVGTX1080SCB) | (GIGTX10808GB) | (MSX10TIGK116) (zoGTX1080TI) SKU (ASDG10600C66) | (MSGTX1060660) | (EVGTX1060365) (EV6TX106036) (AS610600666M)
Price 574.99 559.99 599.89 550.00 559.89 Price 498.89 279.89 489.89 443.99 449.89
NVIDIA GeForce GTX 1050 AMD Radeon RX Vega

Featuring an overclocked core, slightly overclocked

memory, and based on NVIDIA's Pascal
architecture, the MS| GeForce GTX
1050 Graphics Card provides major
improvements in performance, memory
bandwidth, and power efficiency over its

predecessor, the high-performance Maxwell

architecture. It also introduces innovative

graphics features and technologies that redefine the
computer as the platform for playing AAA games.

Based on AMD's Vega architecture and

featuring high-bandwidth HBM?2
memory, the Radeon RX Vega
Graphics Cards allow you to have

the full virtual reality experience.

Not only for gaming, the Radeon RX Vega

supports APIs such as OpenCL and OpenGL.

» 768 CUDA Cores » 7.1 Gbps Memory Speed » HOMI2.0b » DVI-D DL » 4096 Stream Processors 484 GB/s Memory Bandwidth
» Pascal Architecture » 128-Bit Memory Interface » 7680 x 4320 Max Digital Resolution » 8GB of HBM2 VRAM » 2048-Bit Memary Interface
» 4GB of GDDR5 VRAM » DisplayPort 1.4 » Viega Architecture
Model GeForce GeForce GeForce Dual OC GeForce GeForce Model Radeon RX Radeon RX Radeon RX Radeon RX Radeon RX
GTX 1050 Ti GTX 1050 GTX 1050 Ti GTX1050Ti = GTX1050TiD5 Vega 64 86 Vega6486 | Vegabklron8G ' Vega6sWave8G =~ Vega56 86
Base Clock 1290 MHz 1354 MHz 1303 MHz 1341 MHz 1290 MHz Base Clock 1247 MHz 1247 MHz 1247 MHz 1406 MHz 1156 MHz
Boost Clock 1493 Mhz 1455 Mhz 1417 Mhz 1455 MHz 1430 MHz Boost Clock 1546 Mhz 1546 Mhz 1546 Mhz 1677 MHz 1471 MHz
: Single Fan ' Single 90mm " N N N Closed Loop y
Cooling TWIN FROZR VI Cooler ACX2.0 Cooler Single Fan Cooler | Dual Fan Cooler Fan Cooler Cooling Blower-Style Cooler | Blower-Style Cooler | Blower-Style Cooler Liquid Cooling Blower-Style Cooler
SKU (MSGTX1050TI) (EVGTI0502RSF) | (Z0ZTP10510AT) | (ASGTX1080TIZ) | (GIGVN105TDG4) SKU (SA2127502206) (GIVRXV6486DB) | (MSRRXVGA4IRS) | (MSRRXVGAAWVE) | (MSRRXVG5686)
Price 348.89 268.89 308.89 264.89 289.99 Price 719.89 679.89 719.99 799.99 548.89

www.BandH.com




(ool | VR0 TABLET & LAPTOP CASES

TABLET COVERS

[} |
|
|
Brand Griffin Technology Gumdrop Kensington LifeProof Moshi Otter Box Otter Box Pelican
Case Survivor All-Terrain| Hideaway Case BlackBelt niiiid Case iGlaze Defender Defender Voyager Case Rugged Case Case
Material Pulsyic“acrgﬁ:z#:njgeu Silicone Rubber Polycarbonate Smﬁmf&?% Polycarbonate Saﬂtbhheet:c S{Tbhbegc Silicone Hard Shell TPU material
Screen Protector Yes Yes No Yes No Yes Yes No No No
. Black,Blue Black, Orange, Glacier, Crushed Glacier, Black,
Colors Available Pink Vellow Blue, White, Red Black Black, Avalanche Stealth Clear Damson. Black Black Pink Grey Clear
SKU GRGBA41870 G6UGSI97B KEK97442WW LINCIPAZBK MOIGIPCLR 0TDSCIPA26LC OTDCGTABNSBK PECT1030BKGY UASBPBLIC BLPA2TBC
Price 57.47 69.95 59.99 116.99 39.95 80.95 62.96 7412 79.95 2.95
. iPad, iPad Air 2, |iPad Air 2, Galaxy Note Microsoft Dot Do g ) . iPad Pro, iPad, |iPad Pro, iPad, iPad Air iPad Air 2, Microsoft ;
Available for iPad Pro Pro, Galay Tab Pro | Surface Pro iPad, iPad Air2 | Pad PrOT2Y" oo ke & iBad minis| & iPad minis iPad mini Surface Book iPad 2

)

TABLET PORTFOLIOS

brnd s WD s e | fawg | Samswg  Samswg ek U6 U6 |

: VersaVu . Bluetooth . . p
Case TriCover Tablet K1 Cover Premium 360° Hardback Case | Messenger Folio Galaxy Tab S2 Keyboard Cover StyleFolio Metropolis Case iPad Pro Case
Material Polyurethane Polyurethane Polycarbonate Stainless Steel BFua|ﬁ”|Cn C‘g’yeh[ rl)r;?d Polyurethane Polyurethane Vegan Leather Polycarbonate P[%lglcjarrl?ggea[te
Closure Folding Folding Elastic band Snap Latches Full-Width Kickstand Folding Folding Locking Clasp Detachable Stand Folding
; Black, Gold, White, Black,
Colors Available Black Black Black, Brown Black Black Blue, Red Black Black Black, Blue, Red, Blue, Red
SKU ASTCZPS8BLK NVSTK1C TAWRCIPBLK PE1065C IAID8BSFBB SABCGTS2978B SAKBCGTS2B SPSFCIPPPBG UAIPDPLOSEBK UAIPP97BK
Price 17.99 34.89 49.16 37.98 59.99 38.99 99.99 69.95 49.95 49.95
Available for | Asus ZenPad S 8.0 NVIDIA Shield iPad Pro 77-10" Tablets 9.7" iPad Pro Galaxy Tab 9.7 Galaxy Tab 9.7 12.9" iPad Pro iPad Pro iPad Pro 9.7"
SLEEVES

[ '
A |

. Sling Sleeve ICON Sleeve Herringbone Uttra Thin Waterpoof Textured Neoprene
(are plSSeries Deluxe with Tensaerlite Spiz Sleeve Sleeve AramonHKT | Wool Felt Sleeve Pouch Sleeve
; Weather-Resistant Layers of Water-Resistant PU Leather and
Material Neoprene Nylon Tensaerlite Neaprene Herringbone Neaprene Neoprene Wool Felt Sleeve Waterproof Neoprene
Interior Neoprene Plush, faux fur Faux-Fur Padded Padded Double Seamed Neoprene Foam Waterproof Padded
Closure Tipper Zipper Magnetic Snap Zipper Tipper Zipper Tipper Zipper Double Enclosure Tipper
Colors Available Black Black Heatglea[cﬁrf)é{a?é“k' Black Brown Black Black Gray, Gray/Brown Transparent Black,Pink
SKU CAPLS15B INCL60264 INCL60847 KESP12 RUHLTS13 RULPS13B SAG33211041 SESBTABT3GRY XUIPMWPC XUSN112B
Price 18.99 57.07 40.99 21.25 19.99 12.99 24.99 13.99 2.95 4.95
. 16-17" " 13" MacBook " 8-15" 10-15" " " iPad & .
Available for Tablets & Laptops 13" MacBooks Pro Retina 12" Tablets Tablets & Laptops | Tablets & Laptops 15.6" Laptops 13" MacBooks iPad mini 10" Tablets

n B:H 800-947-5534 * 212-444-6740



TABLET & LAPTOP CASES

COMPUTE

BACKPACKS

I g e g T R

EnRoute Triumph 2
Case B:glemk Jaunt Backpack City Backpack ICON Pack Urban Ellte Xenon 2 ibex Dayp al s p TXL617 XL
. B Denier Kodra .
Material Nylon Polyester Weaveelr’]gleyister Nylon Nylon Ballistic Polyester Nylon Nylon Nylon
Interior Nylon Padded Fleece Padded Plush Lined Hard shell case Padded Airflow Padding Polyester Padded
Closure Zipper Zipper Zipper Zipper Zipper Zipper Zipper Zipper Tipper
Colors Available Black Black, Blue Black, White, Grey Black, White, Red Black Black Blue Black Black
SKU CAVNB217 CAWMBP115AN INCL55452 INCL55532 PEU100BPB SAX2BP SWA731606F00 TH3202893 TATXL617
Price 22.99 26.86 68.48 155.00 189.95 45.59 89.99 89.95 59.94

MESSENGER / SLING BAGS

Epa=a kst

Laptop Essential Supply The Eco Notebook Classic
Case Saturn Messenger Bag | Messenger Case | MessengerBag = Messenger Bag Sling Bag L5200 Messenger Messenger Messenger Bag
Material Polyester Nylon Polyester Canvas Canvas Nylon Nylon Leather Fabric w/Polyurethane Nylon
Interior Padded Brushed Poly lining Padded P"’fff_fi I: efg”x Padded Padded Cotton | Herringbone Jacquard | Fuly Lined Nylon Polyurethane
Closure W zsi;sgr;hosgéiets Neoprene Tipper Zipper Snap Clips Zipper Tipper Magnetic Tipper Zipper
Colors Available Black Black Black Charcoal, Khaki Navy, Olve Black Black Green, Tweed. | g,y piown | Black, Bue, Green Black
Sandstone, Red
SKU SWA748814F00 CAVNM217 HEH1D25UT HEHX2034CHR MOMECMEY RUSB11B PALS200SBPG SAMLLBBR THM2B13MGR TIECCMBMBLK
Price 79.99 30.84 21.65 89.95 34.72 15.99 79.95 119.99 45.00 179.00

BRIEFCASE & SHOULDER BAGS

FY L 1] LN )R

; Laptop Checkpoint : q _ Red Series Magma Columbian . Stravan
Case MyZndEten Attache Friendly Case [itinkRaclEs=ential IEHERR 107062 Tech Convertible Bag.  Leather Case T Deluxe Attache
Material Nylon Nylon Nylon Polyester Hard Shell V'Yaartg r;“agshet Polyester Leather Polyester Nylon/Neoprene
Interior Paed Padded Foam Paing Patided Molded EVA olded n Paed Padded Padded Tricot Plush Lining
Closure Tipper Zipper Zipper Tipper Tipper Easy Open Latch Tipper Buckles Tipper Zipper
Colors Available | Black, Blue, Green Black Black Black Black Black Black Brown Black Black
SKU THM2BBCT3HBL CAVNA216 GAGAVLTOF LE4X4OET7328 0YDLMBPC13 PET070CC RUCLBZB SA4HT98 SWM156CBG THTSDA113
Price 39.95 18.99 Call or Log-On 24.60 20.99 57.89 49.95 109.99 69.99 69.95
; up to 10-18" upto 17" up to e " up to upto16.6” 16" 13-15"
Available for 13" Notebooks Notebooks Notebooks 15.6" Notebooks 1315 MacBooks 133 15.4" Notebooks Notebooks Notebooks Notebooks

www.BandH.com BSH



COMPUTERS

.’ Authorized Reseller USB superDI’iVe

External Slot-Loading

Optical Drive

» USB Powered

» Slim & Portable

» For Mac with a
USB Port

[APMMDBBALLA) ..o, 79.00

@ LG GP65NG60
Portable USB DVD Burner and
Drive (Gold) ) N

» 14mm Thick v
» USB 2.0 Interface

» Read/Write Speed 8x DVD, 24x CD
» Windows and Mac Compatible

(L6GP65NGAD) 29.95

/iSU=" DRW-24B1ST
Internal SATA 16X DVD Disc

=
=4

» 16X DVD Disc Writing Speed

» 0TS for Enhanced Burning Quality

» Permanently Delete Data with E-Hammer
» E-Green Reduces Power Consumption

“Gw). Mercury Pro External
USB 3.0 Blu-Ray Reader/Writer

» Max 12x/16x BD-R Read/Write Speed
» Max 16x DVD+R Read
and Write Speed

» Max 48x Q_/'./
i |

CD-R Read
and Write Spee
129.75

(OWCMR3UBDR16)

@ LG WH16NS40

» BD-R16x » DVD+/-R 16X
» Read & Write Blu-ray,

DVD and CD Discs e
i e
» 3D Blu-Ray Title
Playback

[LOWHIONSAD). oo 69,99

Proneer BDR-209DBK
16x Blu-Ray/CD/DVD Writer

» Write Speed of )

8x: DVD+ Discs - —
» bx: DVD-RW Discs -
» 2hx: CD-R Discs

» USB 2.0 Interface
» Includes Downloadable CyberLink Software

OPTICAL DRIVES AND BURNERS

OPTICAL DRIVES & BURNERS, DUPLICATORS

/iSUS' EBW-12D15-U Lite
Ext. Blu-Ray Drive with USB 3.0
» 16x BD-R Write Speed
» 16x DVD+/-R

Write Speed
» 40x CD-R Write Speed
» USB 3.0 Interface
» Includes CyberLink Power2Go 8 Software

[ASBWIBDTXU) .o 99.99

@ LG GP6ONB50

» DVD+ 8X » CD 24X

» M-Disc Support

» USB 2.0

» Supports Double
Layer DVD=+ R Discs

(L6GP4ONB50) 28.36

Proneer BDR-XS06

» Slot Loading Mechanism » USB Bus-Powered
» 12868 Quad Layer Blu-ray Media » 1006B
Triple Layer Blu-ray Media
» Optimal Storage
Capacity o "]
» 4MB Buffer Memory Size
» Auto-Quiet Mode, PureRead, & PowerRead

/iSUS' SDRW-08D2S-U/B

» DVD 8x / CD 24x
» Up to 160 ms DVD Access Time
» 140 ms CD Access Time

» USB 2.0
» Windows &
Mac Compatible
(ASDRWOBDZS) ..o 31.98

@ LG GP65NB6D

14mm Thick DVD Writer Drive
» USB 2.0 Interface

» DVD 8x
» CD 24x

N
~
=3
-3

(LGGP65NBGD)

Proneer BDR-XD05B

Blu-Ray, DVD & CD Writer

» Reads & Writes BD-XL TL,
QL BD-R & BD-RE

» Reads BD-ROM

» bx BD-R
Read/Write Speed

» Connects and Powered via USB 3.0

(PIBDRXD05B) 88.99

(AS24B1STABK) 21.99 [PIBDR20IDBK) ..o 62.99 [PIBDRXS06) . 119.95
DUPLICATORS

merosaszos (D-DVD-127 EPSON PP-100AP vy 5 Target

CD/DVD Duplicator Discproducer Autoprinter ™" 24X DVD/CD Duplicator

» 24x/48x Standalone
1:7 CD/DVD Duplication
» Standalone Operation
» LCD Display & Control Panel
» Prassilech Zulu 2
Disc Mastering Software

(MIQDDVDI2T) e 599.00

FRIMERA Bravo 4052

Disc Publisher

» 50-Disc Capacity

» Inkjet Printing at
4800 dpi

» 1 x High Speed
Recordable Drive

[PRBRAVOADDZ) ..o 1,825.00

» Windows Compatible
» 100-Disc Capacity

» Print Up to 95 Discs

an Hour

» USB Interface

» Color Inkjet Printer
» Max Printing Resolution: 1440 x 1440 dpi
(EPPP100AP) 1,950.00

PRIMERA Bravo SE-3 Disc Publisher
» Create/Burn DVD and CD Media
» Prints On DVD and CD Media

» 4800 dpi Color Inkjet Printer

» Holds up to 20 Discs

» USB 3.0 Connectivity

» Includes USB 3.0 Cable

[PRBSESDP)...coo 1,359.00

CDS, DVDS & BLU-RAY DISCS

» Burns Approximately 50 DVDs / Hour
» SATA Internal Interface
» USB 2.0/3.0 Compatible
» Up to 24X Read Speed
» b x DVD Writers

» 1 x DVD-ROM Drive

» Intuitive LCD Display

(EZDSTDVDLGB)

463.21

StarTech-om USBDUP12

1:2 Standalone USB 2.0 Flash

Drive Duplicator and Eraser

» 3x USB Flash Drives

» b4 MB Buffer Size

» 1.5 GB per Minute
Data Transfer Rate

(STSAUSBDUP1Z) .

i 98.10

v 3 Target
" 24X DVD/CD Duplicator
» Burns Approximately 30 DVDs / Hour

» SATA Internal Interface
» Up to 24X Read Speed
» 3 x DVD Writers

» 1 x DVD-ROM Drive

» Intuitive LCD Display

(EZD3TDVDLGB) ..o

Aleratec 1:10 USB 3.0 Copy Cruiser

Mini Thumb Drive Duplicator

» SuperSpeed USB 3.0
technology

» Easy-to-Use Aleratec
Software Suite

(ALCCM110)

B&H carries a wide assortment of optical recordable media, including CD, DVD, Blu-Ray and M-Disk.

maxaeil.

BlurayDisc

< wvetain gmree 22 BTDK D2 JVEC dEE sonvy N

800-947-5534 + 212-444-6740




WIRELESS MINI & SLIM
Apple Magic Mouse 2

» Wireless Bluetooth Connectivity ﬁ
» Built-in Rechargeable Battery
(APMLAOZLLA) oo 79,00

Lenovo YOGA Wireless Mouse
» 2.4 GHz RF or Bluetooth 4.0

» 1600 dpi Optical Sensor

» 4 Buttons and Adaptive Touch Display
(LEGX30K69565) .o 54,99

Microsoft Surface Mouse

MICE & TRACKBALLS, KEYBOARDS

WIRED MINI & SLIM

Verbatim Commuter Series
Mini Travel Mouse

» Wired USB Connection

» Optical Sensor » Compact Design

» Retractable Cord

(VEMTPMCSB) 7.9

Adesso iMouse W2
» Water, Oil, and Dustproof
» 800 dpi Optical Sensor
» Three Scrolling Buttons

COMPUTERS

STANDARD

Kensington Suretrack Any
Surface Bluetooth Mouse

(KEK72437AM) 38.71

Logitech M510 Wireless Mouse
» 2.46Hz RF Wireless Connection
(LOMBTOBL) . 1997

Macally 3-Button
USB Optical Mouse

(A2 . 093

w ) (ADIMOUSEW2) ..o ..29.95
g ) il Buetuoh D1E <& »r TRACKBALLS & TRACKPADS
S IR —— Call or Log-On WIRED GAMING & ERGONOMIC Kensington SlimBlade Trackball
Razer Mamba Gaming Mouse » Multl-Funct!on Ball » Media Mode
Wirelsss with Charding Dock » Heads-Up Display » USB 2.0
WIRELESS GAMING & ERGONOMIC tre1ess with Lharging Loc (KEK72327U8) oo 89.95
» 16,000 dpi 56 Laser Sensor
Razer Mamba Gaming Mouse » Nine Programmable Buttons Kensington Expert Mouse
» Wireless with Charging Dock » Tilt-Click Scroll Wheel Wired Trackball
» 16,000 dpi 56 Laser Sensor (RAMCERGM) 149.99 » DiamondEye Optical Tracking Technology
RAMCERGM) ... 149.99 » i i
( ] Corsair M65 PRO RGB Mouse [KEzcggbl]Rlng for Comfortable l]peratmn74 99
ASUS Republic of Gamers » 59" Wired USB Connection N '
Spatha Mouse » 12,0000 dpi Precision Apple Magic Trackpad 2
» Wired USB / RF Wireless Connection » 46 Laser Optical Sensor » Wireless Bluetooth - =
» Darkfield Laser, Works on Glass » Eight Programmable Buttons » Built-In Rechargeable Battery
(ASROGSPATHA) ...... 159.99 (COCH93KTINA) S 59.99 (APMJZR2LLA) 121.00
STANDARD MINI
Apple Magic Wireless Keyboard with Numeric Keypad Apple Magic Keyboard
» Wireless Bluetooth Connectivity » Bluetooth » Scissor Mechanism for Keys
» Built-In Rechargeable Battery _— L = » Low Profile, Compact Design
(APMOOBZLLA) - 125.00 [APMLAZ2LLA) 95.99
Microsoft All-in-One Keyboard IOGEAR Slim Multi-Link Bluetooth
» Wireless Connectivity via USB Keyboard with Stand
» Customizable Media Hotkeys » Bluetooth 3.0 Wireless Technology
» Integrated Multi-Touch Trackpad (I0GKB4328) .. 29.99
(MIN9ZOO0O).. ..29.95 . . .
Logitech Bluetooth Multi-Device
7)) AZIO Large Print Keyboard Keyboard
(a] » USB » Tri-Color Backlight » Wireless Distance of up to 30°
(2 4 » Membrane Switch Type » Connect Three Devices Simultaneously
< (AZKBBOBU) ..o 26,99 (L0920006342) 43.49
o
o
E ERGONOMIC GAMING
Y Microsoft Natural Ergonomic 4000 AZIO MGK1

» USB » Zoom Slider
» Multimedia & Internet Hot Keys
(MIKBNEADOO) ..o 3499

Microsoft Microsoft Sculpt

» USB RF Receiver

» Cushioned Palm Rest » Thumb Scaop

(MISEKBB) .....oooo o 129.95

Matias Ergo Pro

» Split Keyboard with 17" Bridge Cable

» 3% USB 2.0 Ports » Anti-Ghosting Circuitry
(MAFKA03Q) oo 199,95

www.BandH.com

[AZMGKT)........

» Braided USB » White LED Backlight
» Kailh Blue Mechanical Key Switches

(RAOMGKB).....

Razer Ornata Backlit Keyboard
» Wired USB Connection » Customizable Green Lighting
» Razer Mecha-Membrane Switches

59.99

(RABWCVZKBBG)

Razer BlackWidow Chroma V2
Mechanical Gaming Keyboard
» Programmable Backlit Keys » 10-Key Rollover

64.99 -

169.99




COMPUTERS

=. Microsoft Windows10Pro/Home g ...

—

Install the 64-bit Windows 10 operating system from Microsoft on

your notebook or desktop to enhance it with a hybrid Start Menu,
Microsoft Edge web browser, and Cortana personal assistant. Without
leaving the Windows desktop to access your apps. Windows 10
combines the best features of prior revisions to remain compatible
with nearly all your peripherals. Furthermore, it offers a similar design

to the previous version of Windows.

Windows 10 Pro
64 Bit/OEM DVD (MIFOC08930)...139.95
32 Bit/OEM DVD (MIFac08970)...133.78
32/64 USB Drive (MIWP10FD) .. 189.99

S8 AVG AntiVirus 2017

» Helps Block Viruses and Trojans

» Helps Block Ransomware
and Malware

» Helps Block Malicious Links

» Scans Downloads Before
They're Completed

» Data Encryption &
Passward Protection

» File Shredder » 24/7 Support

3 Users, 2-Year License (AV17T24EN3) 34.95

7\ Adobe Acrobat

» Compare Files Tool

» Digital IDs

» Tahbed Viewing

» Edit, Export, & Scan
PDFs

» Drapbox, Box, &

OneDrive Access
» Windows Compatible
Pro (ADAPROTTWIN) ..o 449.00
Standard (ADATIWIN...........ccccois 299.00

(=- Logitech C920 HD Pro
Webcam
» HD 1080p Video
At 30 fps
» Wide 78° Diagonal
Field Of View
» Carl Zeiss Glass Autofocus Lens
» Omni-Directional Dual Stereo Microphones
» UVC H.264 Compliant » Plug-And-Play

(Lowcc920) 58.09

(<- Logitech' C310 HD Wehcam
» Widescreen Video at
720p HD Resolution
» Still Phatos at 5SMP
» Built-in Mic » RightLight
&RightSound Tech
» Logitech Vid HD Software
» Windows Compatible
» MAGIX Photo/Video Editing Software

(Lowcesto) 29.95

Windows 10 Home
64 Bit/OEM DVD (MIKw900140)....92.99
32 Bit/OEM DVD (MIKW900186)....99.95
32/64 USB Drive (MIWH10FD) .. 109.98

McAfee Antivirus 2017

» Blocks Viruses, Malware,
and Ransomware

» Prevents Harmful Downloads
and Phishing

» Firewall Security

» Protects Your Identity
and Privacy » Keeps Your
PC Running Smoothly » Windows Compatible

& MCAFEE

ARTIIS

[MC2017AV1PC) 14.95

COREL WordPerfect Office X8
Home & Student Edition

» WordPerfect Word Processor

» (Quattro Pro Spreadsheet
Program » Presentations
Slideshow Creator

» WordPerfect Lightning
Digital Notebook

» WordPerfect Address Book

» WordPerfect XML Project Designer

[COWPOXBHSB) 79.99

Micresoft LifeCam Studio

for Business

» CMOS Sensor Technology

» 1920 x 1080 Sensor
Resolution » Up to 30 Frames
Per Second » 5 Megapixel
Still Images » 75° Diagonal
Field of View » 720p HD Video Chat

» Auto Focus from 0.3 to 32.8" » 360° Rotation

(MILCSTOBOWCE) ... 69.99

(=- Logitech €270 HD Webcam
» Captures Video at
720p HD Resolution
» Widescreen at an
Aspect Ratio of 16:9
» Still Photos at a of 3MP Res
» Compatible with Most IM Programs
» RightLight & RightSound Technology
» MAGIX Photo/Video Editing Software

(LowcBC270) 20.95

SOFTWARE & WEBCAMS

Micresoft 0Office Home 2016
» Microsoft Word
» Microsoft Excel

Office
» Microsoft PowerPoint st
» Microsoft OneNote
» OneDrive Cloud Storage

T
STUDENT EDITIONS
Mac 1-user License (MIGZAO0850)............Log-On
Windows 1-user License (MI79604589)..... 149.95
BUSINESS EDITIONS

Windows 1-user License (MIT5002776)..... 229.00

Bitdefender Antivirus for Mac

» 3-user, 1-year licensed
download version

» Designed for Mac

» Worry-free Security

» 24(7 Guard Duty

» Web Protection

(BIAM3U1Y) 39.00

|| Parallels Desktop 13 for Mac

» Travel Mode

» One-Click Performance
Tuning » Use Cortana for
Both Windows & Mac Apps

» Supports Windows 10

» Ready for

Mac0S Sierra

» Supports Linux & W 02
Google Chrome 0S

[PAVISMDCP) .o T4.99

Microsoft LifeCam Cinema
Second » 73° Diagonal
Field of View

» CMOS Sensor Technology
» 1280 x 720 Resolution
» Up to 30 Frames per

» 720p HD Video Chat

» Auto Focus » 360-degree Rotation

» Wideband Microphone

[MILCXC). o 492

CREATIVE Livel Cam Sync

HD Webcam

» 720p Online Video
Chatting @ 30 fps

» 3.TMP Still Images

» Noise-Cancelling Mic

» Supports Password Pratection Controls
» USBZ.0Plug &Play » PC, Mac, Linux Compatible

(CRLOW) . 19299

Micresoft (ffice 365
» Word » Excel e
» PowerPoint » OneNote
» OneDrive Cloud Storage
» Access (PC Only) 1] Office 365
» Publisher (PC Only) iy
» Use on Mobile Devices 5=
» OneDrive + 20 GB
of Storage
» 60 Minutes of Skype
Calls Per Month

Premium (MI66Q00091).................. Call or Log-On

> Norton Security Deluxe 3.0
(5-Device, 1-Year)

» Virus and Spyware
Protection

» Safeguards Identity &
Transactions

» Secures PCs, Macs,
and Mabile Devices

» Windows and Mac

» Android and i0S Compatible

(SYNSP201751) 44.99

W FileMaker Pro16

» Layout Objects Windows & Cards

» Improved Ul Interface
for Windows

» Copy & Paste Value Lists

» Enhanced cURL Options

FileMaker
» JSON Functions
» External Script Steps

| l
I
» Field-Level Text Encryption '

» OAuth 2.0 Support » Windows & Mac Compatible
(FIFMP16) 323.99

Microsoft LifeCam HD-3000 L2

» 720p HD Video Recording

» 16:9 Widescreen

» Noise-Cancelling Microphone

» MovieMaker & Photo Gallery
Software

» USB Connector

» Windows Compatible

» L2 for Landscape 2.0

(MIHD3000L2) 39.95

e|gat0 CamLink g

» Have it appear as a
webcam in your
favorite apps

» Up to 1080p @ 60 fps

» HDMI| USB 3.0 » Real-Time, Full-Screen
Feedback » DSLR, Camcorder, & Action Cam
Compatible » Mac & Windows Compatible

(ELT0026600) ..o 129,95

800-947-5534 + 212-444-6740




2-in-1Dancing
“XCELLOD‘" Water Speakers

» Stereo Speaker System

» USB-Powered

» Water and Lights Dance
to Your Music

» Optional Dancing Beads
Included

(XCOWS3008) ..o 19.95

(@audioengine A2+ 2.75"
Powered Desktop Speakers
» 2.0 Powered
Speaker System
» 3/, Silk Dome
Tweeters
» 60W Total
Peak Power
(AUSAZPB)

249.00

€<- Logitech 7506 5.1
Surround Sound Speaker System
» For Gaming, Computers,

MP3 / DVD Players
» 5.1 Channel

Surround Sound
» T5W RMS Power
» Audio-In 3.5mm / Headphone / RCA Jacks
(LOZB06) oo 89.95

BkOSS SB40 Full size
Communication Headset
» 20 Hz - 20 kHz Frequency
Response
» Noise-Canceling Microphone
» Soft Leatherette Ear Cushians
» Large, Closed Ear Cups
» Adjustable Headband

(KOTBA755) .o 2813

SUS STRIXT.1

USB Gaming Headset
» True 7.1 Surround Sound

» 10 Neodymium ‘

Magnet Drivers

» Plug-and-Play USB
Audio Station » 130mm Leather Cushions

» Foldable Ear Cups » Windows & Mac Comp

189.99

[ASTRIX71)

plantronics
Backbeat Pro 2 SE

Wireless Headphones

» 40mm Dynamic Drivers

» On-Demand Active
Noise-Canceling (ANC)

» Bluetooth & NFC Technology

» Up to 330" Transmission Range

(PLBBP2SEGG) 249.99

www.BandH.com

SPEAKERS, GAMING HEADSETS

CA-2014

Cyber Acoustics Computer Speakers

» Stereo Sound

» Front-Panel Power
and Volume Control

» Integrated 3.5mm
Audio Cable

» Headphone Jack

(CYCA2004) oo 13,56

harman,/kardon SoundSticks Il
2.1-Channel Desktop Speakers

» Up to 40W of Total Power
» § Full-Range Transducers
» 6" Down-Firing Subwoofer
» 1 x 3.5mm Auxiliary Input
» Touch Controls for
Volume and Mute
(HASS3AMA) .ooooo oo

.Call or Log-On

@ AX510
Stereo Soundbar

» For Dell
UltraSharp
and Professional

Series Monitors
» Low Profile Design » 10W of Total Power

[DEAXBT0) . 28,99

71 sennHEISER GAME ONE

Gaming Headset

» Plush Velvet Ear Pads

» Cushioned Headband

» Naise Cancelling Mic

» Volume Controls on
Right Ear Cup

(SER06080) Call or Log-On

..46.07

SONY PlayStation Gold

Wireless Headset ‘
.78.89

@ msi Ds502

Gaming Headset

» Large 40mm Drivers

» Closed Ear Cup Design

» Virtual 7.1 Surround Sound
» Vibration System

» In-Line Audio Controller

» LED Lighting
(MSDSH02HEAMS).............

» 7.1 Virtual Surround Sound

» Hidden Noise Canceling
Microphone

» Headset Companion App

» PC & Mac Compatible

» Mabile Devices Supported

[SOPS4HSG)............

M4V Companion 20
Multimedia Speaker System

» Dual Speakers with
Full, Natural Sound
» Advanced Ported
Design for Low-Notes
» Control Pod with Volume
and Mute Control
(BOC2OMS) ..o 249.00

CA-3090

Cyber Acoustics ngh Quallty Sound

» Pair of Impeccably
Clear Speakers

» Subwoofer w/ Bass
Volume Control -

» For Gaming Computers, 4 -
MP3 / DVD Players
(CYCA3090) o 2973

SonaVERSE UBR
Soundbar

» 6W RMS Power
» Dual Drivers
» Fits Under

Computer Monitor
» USB-Powered
» Angled Upward for Desk Use
(GOSVUBRTBKEW)........oooooo. 29.95

YAMAHA CM500 Headset

with Boom Microphone

» Boom Microphone

» Circumaural Closed-
Back Headset

» Flexible Headband

» Noise-Attenuating
Earcup

(YACMB00) oo

Micresoft Xbox One

Stereo Headset

» Unidirectional Microphone
» Game/Chat Balance Buttons
» Volume Control, Mute Button
» Included Xbox One
Headset Adapter
» Stereo Headset, Over-the-Ear Design
(MIXBONESHSB).......o oo D145

Razer Kraken USB
Over-Ear PC Headset
» Virtual 7.1 Surround Sound

» 1.3" Neodymium Drivers

» Unidirectional Analog Mic

» Closed Ear Cup Design

» Extended Gaming Comfort

(RAKUSBOEHSBK) .....ccccccocc 50.00

COMPUTERS

CREATIVLE Inspire T10
Speaker System
» 2.0 Audio System

» Dedicated Tweeters

» BasXPort Technology
» Headphone Jack

» Auxiliary Input

(CRITI0)..occc 48.99

CA 3602 3-piece

Cyher Acoustics Flat Panel Subwoofer
and Satellite

» Subwoofer Delivers
Thunderous Bass E
» For Gaming,

Computers, MP3 / DVD Players
» Combo of Four Satellite Drivers

(CYCA602) o 39299

CA-2880

cyber Acoustics USB Powered Speaker

» Dual 1.5"
Neodymium
Full-Range Drivers

» Chrome 3.5mm Input » USB-Powered

» Attaches to Laptop via Clip

» Desktop Volume Control & On/0ff Switch

[CYCAZ880) oo 15,59

Gamlng Headset

» Hi-Fi Capable 53mm
Dynamic Drivers

» Detachable Microphone

» Padded Leatherette Headband

» Aluminum Construction

Black (KIHXH3CLWR).........ccocooovocc .......79.99

White (KIHXH3CLW) ..o 79.99

with Condenser Mic

» USB Connection to Computer
» Integrated Headphones and

Microphone
» Windows and Mac 0S

Compatible "\
(CAUD) o 39.00 o=

Razer Kraken7.1V2

Headset

» 50mm Neodymium
Magnet Drivers

» Digital USB Connection

» Circumaural,
Interchangeable Ear Pads

» Fully Retractable Mic

[RAKTIVZDUSBG) .o




COMPUTERS

AMIPLIF| AFi AmpliFi Router

» Single Router Base Station ==

» 802.11a/blg/nfac
Wi-Fi Network Stds.

» Dual-Band 2.4 GHz

NETGEAR

Orbi Wireless Router .
» 802.11afb/g/n/ac Wi-Fi
Standards » AC3000 Wi-Fi
Data Speeds » 4 x Gigabit -

WHOLE HOME SMART WI-FI

WIRELESS NETWORKING

LINKSYS Velop AC-6600 3pk
» Tri-Band Whole Home Mesh Wi-Fi System

» 802.11a/b/g/n/ac
i
|1

Wi-Fi Standards
» Up to 6600 Mbps Wi-Fi

eerO Pro Wi-Fi System
(3 eeros)
» TrueMesh Technology ‘
Powered Wi-Fi = sen
» Gigabit Network Speeds
» Wireless-AC Tri-Band Technology
» Replace Wireless Router & Range Extender
(EEBO10301) 499.00

5.0 GHz Frequencies Ethernet Ports. USB 2.0 Port o » 1x2.4GHz /2 x5 GHz !
» 4 x Gigabit LAN Ports » 1 x Gigabit WAN Port » 6 x High-Performance Antennas » 6 x Antennas & High Powered Amplifiers
(AMAFIROUTER) ...ooooo o 311.99 (NERBKSOTOONA) ..o 399.00 (LIVELOP3) 499.97
WIRELESS ROUTERS
TP-LINK LINKSYS TP-LINK
Archer C2300 EA9400 Archer C7 AC1750
» 802.11ac Wi-Fi Network » 802.11ac Wi-Fi Network » IEEE 802.11 afb/g/n/ac
» Up to 2300 Mbps Wi-Fi Data » Up to 5000 Mbps Wi-Fi Data Throughput Standards » Upto1.75
Throughput » Dual-Band 2.4 GHz & 5 GHz » Tri-Band Wireless Technology » 8 x External Ghps Total Bandwidth
» 3 x Dual-Band Antennas Non-Detachable Antennas » 8 x Gigabit LAN » 2.4 GHz [ 5 GHz Frequencies
» & x Gigabit Ethernet LAN Ports Ports » Gigabit Ethernet WAN Port » 4x10/100/1000 Mbps LAN Ports
(TPAC2300) 169.99 (LIEA9400B1) 279.95 (TPARCHERCY) 79.99

Synology' RT2600AC wireless
Dual-Band Gigabit Router

» 802.11ac Wi-Fi Standard

» 2600 Mbps Wi-Fi Data

» Dual-Band 2.4 GHz / b GHz

» x4 MIMO High-Gain Antennas

D-Link DIR-878 AC1900
Dual-Band Gigabit Router
» 802.11ac Wi-Fi Network
» Up to 1900 Mbps Wi-Fi

» 2.4 GHz /5 GHz (Dual-Band)
» & x External Antennas

(SYRT2600AC) oo 149.39 (DLDIR878) 119.99
«J UAP-AC-PRO J UAP-PRO

PR UniFi Access Point YBIOUT! UniFi Access Point

» 802.11 a/b/g/n » 802.11 a/blg/n
Wi-Fi Standards Wi-Fi Standards

» Range of up to 400° @ » Range of up to 400°

» 2 x Ethernet Ports » 2 x Ethernet Ports

» Integrated Omni Antennas » /4 dBi Omni Antennas -

(UBUAPACPRO) ..oooooo oo 149.00 (UBUAPPRO) ..ooooooo 199.97

TP-LINK AP500AC1900
Dual Band Gigabit Access Point
» 802.11a/b/g/n/ac
Wireless Standards
» 2.4 /5.0 GHz Dual Band
» 1 x Gigabit Ethernet Port
» 3 x Dual Band Detachable Antennas
» Upto 1.9 Gbps Data Throughput

(TPAP500) 164.00

vfrer]re WAPS71-A-K9 Dual
CISCO Radio Access Point

» §02.11ac Wi-Fi Network Protocol

» 7 x Gigabit LAN Ports

» Dual Band 2.4 GHz & b GHz

Frequencies
» 6 x Internal Antennas
» Up to 1.9 Gbps Wireless Data Rate

(CIWAPS71)

269.95

LIN<KSYS WAP300N
Wireless-N Dual-Band Access Point
» 802.11a/b/g/n Wi-Fi Compliant
» Up to 300 Mbps Data Throughput
» Dual Band 2.4 GHz &
5 GHz Frequencies
» 1 x Fast Ethernet Port
» Dual Detachable Antennas
(LIWAP300N) 69.00

afver]oe WAP371 wireless-Ac/N
CISCO  Dual Radio Access Point with
Single Point Setup

» 802.17a/blg/nfac )
Wi-Fi Bands \:“ '
» 2.4 GHz and b GHz Frequencies | e

» 3x3 MIMO Tech
» Integrated 2 dBi Antenna

[CIWAPSTIAK).....ccccc 176.99

WIRELESS ACCESS POINTS

NETGEAR R7000
Nighthawk AC1900 Smart-Router
» Wireless 802.11ac

1900 Router
» 2.46Hz & 56Hz Dual Band
» bx Gigabit Ethernet Ports

[NERTO00T00PA) ... 179.99

/iU GT-AC5300 wireless
Dual-Band Gigabit Router
» 802.11ac Wi-Fi Network
» Up to 5300 Mbps Wi-Fi
Data Throughput
» 1% 2.4 6Hz [ 2 x5 GHz
» 8 x External Antennas
[ASGTACH300) ... 399.99

LINKSYS WRT3200ACM

Dual-Band Wireless Router

» 802.11a/b/g/nfac Wi-Fi
Network Standard
» Up to 3200 Mbps Wi-Fi

Data Throughput » Dual-Band 2.4 / 5 GHz
(LIWRT3200ACM) ..o 249.99

J UAP-AC-LITE

UBIQUITI

-------- UniFi Access Point
» Range of up to 400°
» Ethernet Ports

» 80211 afbfg/n
» Integrated Omni Antennas

Wi-Fi Standards
(UBUAPACLITE) 78.99

J UAP-AC-HD-US wave 2

YBIQUT! Enterprise UniFi Access Point

» 802.11ac Wave 2

Wi-Fi Standards
» 2x Ethernet Ports
(UBUAPACHDUS) ... .293.99

» kb Spatial Streams
» UniFi Controller Software

TP-LINK EAP245
» Wireless-AC1750
Dual-Band Gigabit e,
Ceiling Mount Access Point\v
» |EEE 802.11ac/n/g/b/a Network
» Up to 1750 Mbps Data Throughput
» 2.4 GHz /5 GHz (Dual-Band)
» Internal Omni-Directional Antennas

(TPEAP245) 83.23

¢# UAP-AC-M-PRO-US
YBIOUT UniFi Access Point

» 802.11 a/b/g/n/ac Wi-Fi Standards
» Range of up to 600°

» 1x10/100/1000 Ethernet Port

» UniFi Controller Software

(UBUAPACMPRUS)....c.cocccc 169.99

/i=SU=S N-300 3-in-1 Router/
Access Point/Range Extender
» 802.11n Speeds up to 300Mb/s
» 7 x Detachable 5 dBi Antennas
» 2.4 GHz Operating Frequency
» 1xRJ-45 Port for 10/100 Base
T for WAN
» 4 xRJ-45 Port for 10/100 Base T for LAN
(ASRTN12D1) 29.99

LINKSYS LAPAC1200

Dual-Band Access Point

» |EEE 802.11a/b/g/n/ac :
Network Standards B/

» Maximum Data Rate: 1,200 Mbps i

» 2.4 GHz /5 GHz Concurrent Frequencies

» Internal Antenna » 802.3at PoE Comaptible

» Gigabit Ethernet Port Speed

(LILAPACT200) ..o 148.00

“ B:H 800-947-5534 + 212-444-6740



WIRELESS NETWORKING

U NBE-5AC-19 NanoBeam ac
UBIQUT High-Performance airMAX
» airMAX Technology » Atheros e
MIPS 74Kc, 720 MHz Processor —
» 128MB DDR2, 8MB Memory {
» 1x10/100/1000 Ethernet Port

(UBNBESAC19US) 99.00

() NanoStation5 outdoor
YBIQUT CPE Router
» Atheros ARZ313 S 180MHz Processor
» 16MB SDRAM, 4MB Flash Memory
» 10/100 BASE-TX Ethernet Interface ’
» 2 x 14dBi Dual Polarity Antennas
Sy

(UBNSM5) 81.99

U PBE'5AC'5UU PowerBeam

» Atheros MIPS 74Kc, 720 MHz
Processor » 128 MB DDR2,

8 MB Flash Memory % j
» 450+ Mb/s Transfer Speed
[UBPBEBACH00U] o 289.99

EnGenius ENH500 High-Powered,
Long Range 5 GHz Outdoor Bridge
» 600mW High Power Long Range
» Up to 1 mile Coverage » Wireless

N300 Speed » 2 Fast Ethernet Ports
» Internal 13 dBi Directional Antenna
(ENENHS500) Call or Log-On
KIT (ENNENHSOOKIT) oo 158.99

TP-LINK RE200
Wireless-AC750 Range Extender

» Expand Wireless Coverage

» 5 GHz 433 Mbps Plus 2.4 GHz /

300 Mbps » Compatible with
802.11b/g/n and 802.11ac

» Range Extender Button
(TPRE200)

'

29.99

LINCSYS Max Stream AC1900
Dual-Band Range Extender

» 802.11b/gla/n/ac -
» Up to 1900 Mbps

» 2.4 6Hz / 5 GHz (Dual-Band)

» Gigabit Ethernet Port

» MU-MIMO, Spot Finder Techn.

(LIRE7000) 129.97

TP-LINK 11-WA855RE

Wireless Range Extender
» 802.11b/g/n

» Up to 300 Mbps

» 2.4 GHz

» 7 x External Antennas

» 1x10/100 Mbps LAN Ports

(TPWABS5RE) - 19.00

NETGEAR EX6100
AC750 Wi-Fi Range Extender

» AC750 Wi-Fi Performance

» 1 x Gigabit Ethernet Port [

» IEEE 802.11 a/b/g/nfac Standards A
» Dual Band 2.4 & b GHz Frequencies =
» WPA/WPA2-PSK Encryption .
[NEEXBTOONAS)...oooo 69.99

TP-LINK TL-WN725N
Wireless N Nano USB Adapter
» |EEE 802.11b/g/n Compatible
» Up to 150Mbps Data Speeds
» USB 2.0 Connectivity

» 2.400-2.48356Hz Frequencies
» Internal Antenna

(TPTLWN725N)

LIN<KSYS WUSB6100M
Wireless-AC600 MU-MIMO
USB Wi-Fi Adapter
» Wi-Fi Speeds of up to 600 Mbps
» Dual-Band 2.4 GHz /5 GHz
Connectivity
» Plug & Play Installation
» MU-MIMO Technology

[LIWUSBBTOOM) e 39.97

TP-LINK TL-WN722N
High Gain Wireless USB Adapter

» Wireless N Speeds
Up to 150 Mbps
» Compliant with IEEE 802.11n
» USB2.0 » 64/128-bit
WEP /WPA/2/PSK/2-PSK

(TPTLWN722N) 13.45

/iSU=S AC1900 pcle
Dual-Band Wireless Adapter

» 802.11ac Wi-Fi Standard

» Broadcom TurboQAM
Hardware » Flexible
Extended Antenna Placement

» 5th Generation 8
02.1ac Chipset

(ASPCEACS8) 92.99

WIRELESS BRIDGES/OUTDOOR

WIRELESS RANGE EXTENDERS

WIRELESS ADAPTERS

COMPUTERS

i/ NBE-M5-16 GHz16dBi
UBIQUIT NanoBeam airMAX
» airMAX Technology
» Atheros MIPS 74Kc, 560 MHz \
Processor » 64MB DDRZ, 3
8MB Flash Memory » Ethernet Port

(UBNBEMb16) 61.99

EnGenius EnStationd Long-Range
Wireless 5 GHz Outdoor Bridge

» IEEE 802.11a/n Standards

» Up to 300 Mbps Data Rate

» b GHz Operating Frequency <l

» 64MB Memory / 16MB Flash Memory

» Up to 26 dBm Transmit Power

(ENSTATIONS) 89.99

» airMAX Technology ¥
» Atheros MIPS 74Kc, 720 MHz
Processor » 128MB DDRZ,
8MB Flash Memory » Ethernet Port

(UBNBESAC16) 81.99

v

EnGenius ENS202 High-Powered,
Long-Range 2.4 GHz Outdoor Bridge
» 400mW Power Delivers Long-Range

Coverage » Up to 300 Mb/s Wireless

Speed » Backward Compatible to

802.11b/g » Dual Polarity 8 dBi vl

Directional Antenna )

(ENENS202) ..o Call or Log-On

TP-LINK RE4501750

Wi-Fi Range Extender )

» |EEE 802.17b/g/n Wi-Fi Network ¥
Standards » Gigabit Ethernet Port )

» 3 x External Antennas :

» Dual Band 2.4 GHz & 5 GHz

» Up to 1750 Mbps Data Throughput

(TPRE450) 89.99

/1SS RP-AC68U
AC1900 Wi-Fi Repeater
» 802.11a/b/g/nfac Wi-Fi

» Dual-Band 2.4 GHz & b GHz

» To 1900 Mbps Data Throughput

» b x Gigabit Ethernet Ports

» 4 x Internal Antennas

[ASRPACBU) .....cccocc 159.00

LIN<KSYS RE6350AC1200
Wi-Fi Range Extender
» 802.11ac Wi-Fi Technology
» AC1200 Wi-Fi Speed
» Dual Band 2.4 GHz &

5 GHz Connectivity ~~
» Spot Finder Technology

(LIRE6350) 59.99

% belkin N60D

Dual-Band Wi-Fi Range Extender
» 802.11a/b/g/n Network Standards

» 1 x RJ-45 Ethernet Port |

» Dual Band 2.4 GHz / 5 GHz l l
» Up to 300 Mbps Data Throughput :

» Windows & Mac Compatiblees

(BEF9K1122) 59.97

TP-LINK 450 Mbps

2.4/5GHz Wireless N Dual Band

PCI Express Adapter

» Max Transfer Speed: 450 Mbps

» Dual Band 2.4 & 5.0 GHz

» Backward Compatible with
802.17a/b/g

(TPTLWDN4800) 39.99

e

MSUIS USB-AC68 AC1900
Dual-Band USB 3.0 Wi-Fi Adapter
» 802.11a/b/g/n/ac Wi-Fi

Standard » 2.4/5 GHz

Dual-Band Frequency
» 3x4 MIMO Design
» Beamforming Technology
» USB 3.0 Type-A Interface

[ASUSBACA8) 86.99

EDimAax EW-7811UN

Nano USB WiFi Adapter

» USB2.0 » Compliant with APS
|EEE 802.11b/g/n Standard

» Data Rate Up to 150 Mb/s

» Increases Wireless Coverage by 3x

» Green Power Saving & Internal Antenn

(EDEW7811UN) 7.99

LINCKSYS AE6000
Wireless-AC Dual-Band USB
» |EEE 802.11a/b/g/n/ac Standards
» Wireless AC Compatible
» Up to 430 Mbps Data
Transfer Speeds
» Selectable 2.5 GHz / 5 GHz Frequencies
» 1xInternal Antenna

(LIAE6000) 27.95

www.BandH.com BSH



COMPUTERS

NETWORKING

! UniFi Managed PoE+
YBIGUT! Gigabit 8 Port Switch

with SFP e
» Process All Ports at

Line Rate / No Loss » Up to 10 Gbps Non-
Blocking Throughput » 20 Gbps Switching
(UBUSB150W) 186.86

otfrer]ee $6200-26P
CISCO 26-Port Switcher

» 24x Gigabit Ethernet Ports
» Supports Upto 12
PoE Ports
» 2 x Combo mini-GBIC
Ethernet Ports » QoS Support

[CIS620028P).....oce 372.95

D-Link DGS-1008
8-Port Gigabit Ethernet Switch

o -

2000Mbps
» Total of Eight
Gigabit Ethernet Ports » QoS Traffic
Prioritization » Power-Saving Features
(DLDGS108) 29.99

«J UniFi Managed poE+
UBIQUITl Gigabit 24 Port Switch
O e
» Process All Ports at Line Rate / No Loss
» Up to 26 Gbps Non-Blocking Throughput
» b7 Gbps Switching Capacity

(UBUS24250W) 369.99

afrer]ee S6300-10
CISCO 10-Port Switcher

mini-GBIC
Ports » 8x 10/100/1000 PoE+ Ports

» (oS Support » IPv4 [ IPvé Support
» Advanced Security Management

(CIS630010) 203.80

TP-LINK TL-561008PE
8-Port Desktop Switch

.’ Authorized Reseller  Thunderbolt to
Ethernet Adapter

» Supports 10/100/1000BASE-TNetworks
» Small & Compact

(APMDA63LLA) 28.99

LINKSYS USB3GIG
USB 3.0 Ethernet Adapter
» Gigabit Ethernet
Speeds
» Upto328°
(100 m) Range
» Up to 30 W Power
» Fast, Easy Setup and Installation
(LIUSB3616) 20.42

(ONN©T TWIN10G-TB2

10GbE Dual-Port 10 Gigabit

Ethernet Thunderbolt 2 Adapte

» 2 x Thunderbolt 2
Connectors

» 7xRJ-45 Connectors

» Adds 106bE Connectivity

» Supports Wake-on-LAN, Transparent Failover

[SOTWINTOG) - 482.99

NETWORK SWITCHERS

? US-8-60W uniFis-port

» 8 x RJ-45 Gigahit Ethernet Ports

» 4 x Auto-Sensing BUZ.M,%;
PoE Ports Y

» 8 Gbps Non-Block Throughput

(UBUSBOOW) ..o 107.11

ofrer]rs $6200-08
CISCO 8-Port Eathernet Switch

» 8x 10/100/1000
Ports
» 2x Combo mini-GBIC Ports
» (oS Support » IPv4 [ IPvé Support
» Advanced Security Management

(CIS620008) 84.95

NETGEAR ProSafe
5-Port Desktop Switch

¢! UniFi Managed PoE+
YBIQUT 16-Port Gigabit Switch
» Process AL

Ports at Line Rate Smy o
» Upto 18 Gbps Non-Blocking Throughput
» 150W Maximum Power Consumption

(UBUS16150W) 282.98

otfrer]es SG110D
CISCO 8-Port Network Switch
» § x Ethernet Ports
» Fanless Design
» 802.3/3u/3ab/3z/3x
Network Standards » 16 Gbps Switching
Capacity » 11.9 Mpps Forwarding Capacity

(CIS6110D08) 51.95

& TReNDneT TEG-S506
5-Port GREENnNet Switch

» |EEE 802.3x Full Duplex Flow Control
» Power Conserving Design

(TRTEGS506) 17.99

» § x Port Gigabit : » b Ports
Ethernet Ports » 10/100/1000
» 8 x PoE Compliant Ports Mbps Gigabit
» IEEE 802.3af/at Compliant Ethernet
» 30 Watts PoE Power per Port » Up to 2000 Mbps in Full-Duplex Made
(TPTLSGTO0BPE......o 129.99 (NEGS105NA) 34.99
NETWORK ADAPTERS

" Authorized Reseller USB Ethernet
Adapter
» USB 2.0 to 10/100BASE-T

Fast Ethernet L
» For MacBook Air
» Mac 0S Xv.10.4.8

or later

[APMC704LLA) 29.00

a' USB 3.0 Type-Cto
XCELLON' Gigabit Ethernet Adapter
» Supports 10/100/1000BASE-T Networks
» USB 3.0 Type-C Interface o
» Integrated 7.3"
USB Cable

» LED Status Indicators &
» USB Bus-Powered
(XCUSBEC) 22.95

PROMISE " SANLink2

TECHNOLOGY, INC.
20 Gb/s Thunderbolt 2 to 10G
Base-T Ethernet Bridge Adapter

» Full Duplex @ 10 Gb/s

» Auto-Negotiate -
with 1 Gb/s

» Daisy-Chain Support » Dual Thunderbolt 2

Ports » Dual 106Base-T Ethernet Ports
(PRSL2TB210E) oooooo oo . 541.52

" TU3-ETG uss 3.0
XCELLON™ to Ethernet Adapter
» Supports 10/100/1000BASE-T Networks
» USB 3.0 Type-A

Interface » Integrated

7.1" USB Cable

» LED Status Indicators > -
)

(XCUSBEA) 19.95

kanex KU3CGBT
USB-C to Gigabit

Ethernet Adapter
» Connect your MacBook/ £
Chromebook or any other I:‘

USB-C ready computer
directly to Internet ‘

(KAKU3CGBT) 16.50

PROMISE" SANLink2
Thunderbolt 2 to 8 Gb/s FC

» Dual 8 Gb/s Fiber Channel Ports

» Dual 20 Gb/s
Thunderbolt 2 Ports
» Daisy-Chain Support

» Includes Thunderbolt Cable
» Mac Compatible

(PRSL2TBBBA).......ccccce .797.28

& TRENDnet TU2-ET100
USB 2.0 to Ethernet Adapter

» USB 2.0

to 10/100Mbps
g .
»
(TRTUZET100) 14.99

TP-LINK T6-3468
Gigabit PCI Express
Network Adapter

» 1 Gigabit Port

» 10/100/1000Mbps Half-Duplex
» 20/200/2000Mbps Full-Duplex
» 32-bit PCl Interface

» LED Status Indicators
(TPTG3468) 12.25

‘%' belkin USB Type-C to Gigabit
Ethernet Adapter
» Gigabit Ethernet
Functionality via USB
» Supports 10/100/1000
BASE-T Networks
» Plug-and-Play Solution
» Bus Powered - No External Power Supply

(BEF2CUO40BTB) ...ooo Call or Log-On

B:H 800-947-5534 + 212-444-6740



Aetiorntec WirelessN
ADSL Modem Router

» 802.11b/g/n » 4x Ethernet
LAN Ports » Wireless Security
» Firewall » Automatic Configuration
» Remote Management
(ACGTZBAWNDT) oo 59.99

NETGEAR C7100VNighthawk
DOCSIS 3.0 Cable Modem and Router
» Compatible with XFINITY Voice
» 802.11ac Wi-Fi Network Std.
» Dual-Band 2.4 GHz & b GHz
» Up to 1900 Mbps Wi-Fi
Data Throughput
(NECT100VIOON) oo 279.99

A R R 1s SBG6900-AC Surfboard
Cable Modem

» 802.11ac Wi-Fi Network Standard
» Up to 1900 Mbps Wi-Fi Data

» Dual Band 2.4 GHz/5 GHz Support
» DOCSIS 3.0 Compatible

TP-LINK AV2000
2-Port Gigabit Passthrough
Powerline Starter Kit

.

» HomePlug AV2 Technology . **
» |EEE 1901, 802.3/3u/3ab
Standards » 2 x Gigabit -
Ethernet Ports per Adapter

(TPTLPAO2OPK)......ccc 91.70

LIN<SYS Powerline AV
4-Port Network Adapter Kit
» High Speed of up to

200 Mbps
» 128-bit Encryption
» Connects to Any Device with Ethernet
» Pairs with Any Linksys E-Series Router

(LIPLSKAOONP) 69.99

CABLE MODEMS

NETWORKING

COMPUTERS

(M) mororora MBB600
DOCSIS 3.1 Cable Modem
» 1Compatible with Comcast Xfinity

» Supports DOCSIS 3.1 Cable Standard
» Downstream Speed up to 3.8 Gbps

» Upstream Speed up to 1 Gbps

TP-LINK TC-7620
DOCSIS 3.0 Cable Modem
» Compatible with Most Major ISPs

» Eliminate Monthly Fees

» 16 Downstream / 4 Upstream Channels
» |Pv4 & IPvé Dual Stack

(TPTC7620) 69.95

LINCKSYS (CM3024

24x8 DOCSIS 3.0 Cable Modem

» F-Type Female 750 Connector

» RJ-45 Gigabit Ethernet Port

» Up to 960 Mbps Downstream and
Up to 122 Mbps Upstream Data Rate

» b x Status LED Indicators

(LICM3024) 114.50

(ARSBG6901) “15305  (MoMBBs00n0) 158.00

NETGEAR CM700High (M) mororora MB7220-10

Speed DOCSIS 3.0 Cable Modem 8x4 343 Mbps DOCSIS 3.0 Cable Modem

» Up to 1.4 Gbps Download Speeds » Coax Cable Connector

» 32 x Downstream Channels » Gigabit Ethernet Port

» 8 x Upstream Channels » Operating Status LED Indicators

» DOCSIS 3.0 Certified » Cable & Power Lightning Protection

» Pvé Support » Up to 343 Mbps Downstream Data Rate

[NECM700T00NS) - 129.00 (M0B722010) 53.90
POWERLINE ADAPTERS

TP-LINK TL-PAS030P KIT

HomePlug-AV1000 3-Port

Gigabit Powerline Kit

» HomePlug AV2 Compliant A

» Up to 1000 Mbps e

» 802.3u/ab » 3 x Gigabit S
Ethernet ports » 984" (300 m) Range

(TPABO3OPKT) 59.99

NETGEAR PLW1010
Wi-Fi Network Adapter
and Access Point

» Homeplug AVZ Compliant

» 802.11ac Wi-Fi Protocol

» 1x Gigabit Ethernet Port

» Up to 5,382 sq ft / 500 sq m Coverage

(NEPLW1010) 99.99

() INS-8023AF-0
YBIOUT! 802.3af Passive PoE to
802.3af Outdoor Adapter
» Transforms PoE devices /
into 48V, 802.3af- s
compliant products
» Works with 802.3af switches
(UBINS8023AF0) 18.99

» 10/100/1000 Mbps
Data Rate

» 15W or 30W
Power Selector ™

» 802.3at Compliant

» Plug-and-Play Compatible

(AXB9D0334) oo Call or Log-On

www.BandH.com

«J POE-24-12W-G
YBIQUT! poE Adapter PoE Adapter
» Provides grounding
» Protection against surge,
clamping, maximum surge
discharge, and peak pulse current
» Provides protection against ESD attacks

(UBPOE2412W6) 13.99

AXISa T8120

Power over Ethernet Midspan

» 15.4 W of
Maximum Power
» |EEE 802.3af Compliant \
-
2L L
(AX5026204) 59.00

TP-LINK TLPAT010KIT
AV1000 Gigabit Powerline

Starter Kit g ey
» HomePlug AV2 / 8 §“\\§

IEEE 1901 Compliant ’
» 802.3 / 3u / 3ab Standards
» Gigabit Ethernet Port per Adapter

(TPTLPAZOTOKT) .o 4499

ZyXEL PLA5256KIT AV1000

Powerline Homeplug Kit
» Enhanced 1000 Mbps

Data Transfer Rates . , o 4

» 2 Gigabit LAN Ports ey
» AC Pass-Through Design -
» |EEE 1901 HomePlug AV Compatible

(ZYPLABZBOKIT) .. 59.99

TP-LINK TL-PA010KIT
AV500 Nano Powerline
Adapter Starter Kit
» HomePlug AV standard

compliant
» High-speed data transfer

rate of up to 500 Mb/s » Miniature design

(TPTLPAADTOK)...oo 38.60

ZyXEL PLA5206 KIT

Powerline Ethernet Adapter Kit

» Includes 2 x Powerline ‘0
Network Adapters ! g
» HomePlug AV2 N AW
Compliant » Up to - /
1800 Mbps Data Transfer Rates /
(ZYPLAB456KIT) 84.95

J INS-8023AF-I

802.3af Indoor Adapter

» Transforms PoE devices

into 48V, 802.3af-

compliant products == |
» Works with 802.3af switches

(UBINSB023AFI) 19.00

ﬂ intellinet T81 34 6UW Midspan

» Works with 802.3af/at Compliant Devices

» Provides 30W of Power » Uses Existing
Catbe/6 Cabling

» Power and Data
Transfe » LED
Indicator Lights

» Includes Power Cord

(IN560566) 37.70

«J POE-24-24W-G
PEIUT PoE 1A Gigabit Adaptor
» 1 x Gigabit LAN/1 x PoE Part
» Remote Reset Capability
» 80+% Efficiency
» 65 kHz Switching Frequency
» |EC-320 C6 AC Connector

(UBPOE2424W6) 15.49

TP-LINK TL-POE150S

Power Over Ethernet Injector

» |EEE 802.3, 3u, 3af Compliant

» 1x10/100/1000M
LAN Port

» 1 x Power Socket
(DC IN)

» 1x10/100/1000M PoE Port

(TPTLPOE150S) 19.99




COMPUTERS

UVP uniFi VoIP Phone
UBIAUT with Touchscreen
» 5" Full Color, Multi-Touch Display
» Powered by Android
» 1.2 GHz Dual-Core Cortex A9 Processor
» 4GB Storage / 1 6B RAM
» UniFi Phone App Communication Software
» Auto-Provisioning Management Feature

(UBUVP)

€3 ooma’ HD2 Handset
Cordless Handset

» Color Display

» DECT 6.0 Support

» Picture Caller ID

» Caller ID and Call Waiting

» Voicemail » Intercom » Baby Monitoring
» Signal/HD/Do Not Disturb Indicators

(00HD2HS)

Jabra’ Speak 710 speakerphone
» Supports Bluetooth & USB Connectivity
» Bluetooth 4.2 Standard

» Up to 98" Wireless Range

» Pair up to 8 Personal Devices

» Supports Multiple Bluetooth Profiles

» Micro USB Charging Interface

» Omni-Directional Microphone » Up to 15 Hours Talk Time

(JAJST1037049)

299.99

% Duet Executive Desktop Speaker-
EN phone for VoIP and Telephone

VOIP

wvtech VCS754 Erisstation SIP
Conference Phone with Four Wireless Mics
» Sincludes 4 x DECT 6.0 Wireless Mics
» Integrated Base Speakerphone

» 2 x Fixed Microphones in Base

» Up to 8 Hours Talk Time per Mic

» Up to 70 Hours Standby per Wireless Mic ‘
» USB Connectivity » Supports up to Three SIP Accounts

(VTVCS754)........

322.00

plantronics Voyager Focus B825-M

Bluetooth USB Headset (Microsoft)
» Bluetooth & USB Connectivity » Up to 12 Hours
Talk Time » Up to 150" Roaming Range
» Bluetooth v4.1
» SoundGuard Hearing Protection
» Avaya / Cisco / Skype Compatible
-

(PLBBZEMHS)...... 279.95
B825 UC Bluetooth USB Headset (STANDARD) (PLBB25VFHS)...... 279.95

Jabra’ Speak510+

Bluetooth & USB Speakerphone
(Microsoft Lync Compatible)

» Unified Communications Compatible

» Supports up to 8 Trusted Devices

» Bluetooth Class 1 & 2 Compatible

» Bluetooth AZDP Support "

(JAST0BTUSPMS) 179.95

’

% POLYCOM

FLXUC500

revo USB Conference Phone

vifvar]re SPAS0LG 4-Line IP Phone with
CISCO 2-Port Switch PoE & LCD Display
» 4-Line Business Class IP Phone with PoE
» Features 2-Port & LCD Display

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Great Voice Clarity by Wideband Audio

[CISPAB046)

g GRANDSTREAN GXV3240
IP Multimedia Phone for Android
» 4.3" Capacitive Touchscreen Display

» 480 x 271 Pixel Resolution

» Runs on Android 4.2 Operating System
» Mega Pixel CMOS Camera

» Integrated 802.11n Wi-Fi

» Integrated QoS Functionality
» RJ-9 Headset Jack / USB / SD / Mini-HDMI

(6RGXV3240)

plantronics Calisto P620
Bluetooth Wireless Speakerphone
» Bluetooth v2.1 + EDR

» Mini USB Adapter

» Works with Computers and

Smartphanes

» PC Wideband: Up to 6800Hz
» 360° Room Coverage » Compatible with Windows and Mac 0S

[PLP20)

% PoLycom Soundstation 2
Expandable Conference Phone

» Patented Polycom Acoustic Clarity

» 3x Cardioid Intelligent Microphones

» 360 Degrees of Pickup from 10" Away
» Conferences with up to 10 Participants
» Resists Interference From Mabile Phanes

» Backlit Display » Connect to Mobile Phones and PCs

% Smart Spider use
HOENIX» Conference

» Compact and Discrete e » Built-In Tweeter and Mid-Woofer Speakers
» Integrated Mic and Speaker — » Integrated Echo Cancellation
» Echo Cancellation and - » Full Duplex Technology
Noise Suppression 2 » For Conference Rooms and Small Offices
» USB Connection » 3.5mm Speaker Output » For Meetings and Online Collaboration
» RJ-11 Jack for Phone and Bridging » Extended Response For Foreign Languages
[PHMT202EXE] . 199.95 (RETOFLXUC500) . 329.30 (POSS2ED)
plantronics CT14DECT6.0  ClearOne.CHAT 150 ~—~, BlueParrott B350-XT
Cordless Headset Phone USB Speakerphone Noise-Canceling Headset
» DECT 6.0 for Interference > Designed for Use » Flexible Boom Microphone
Free Wireless with PC » Cuts 96% of Background
» Up to 10 Hours of Talk Time > Integrated Noise Cancellation Noise » Bluetooth 4.0

» Hands-Free Convenience
» Up to 300 ft. Range from
Charge Base

[PLCT14RHS) 89.82

OPolycom Communicator
Desktop Speakerphone

» USB-Powered Speakerphone
» High-Fidelity Wideband Audio
» 7 High-Quality Microphones
» Play CD / Presentation

Audio
» Acoustic Clarity Technology

(PO2200440401) e 129.99

[CLCT50SP).....

» Full Bandwidth Frequency Response
» Listen and Speak Simultaneously
» Three Built-in Microphones

plantronics (€$530
Over-the-Ear Wireless Headset
» Wireless Range Up to 350°

» 4 Different Wearing Options

» Premium Wideband Audio Quality

» One-Touch Call Answer/End

» Conference in 3 Additional Headsets

» Headset Weighs Only 0.74 0z

[PLCS530HS)...

v 11457

with Multipoint Technology
» NFC One-Tap Pairing
» Wideband Audio and 128-Bit Encryption

(VX203475) 129.00

plantronics (S$510
Wireless Headset System

» Lightweight 2.5 0z Headset

» Hands-free Operation to 350 ft

» Sleek Contemporary Design

» One-touch Control

» Advanced Wideband Technology

» Auto-answer Feature » Noise-canceling Mic

[PLCSB10) . 189,95

Speakerphone
l » Smartphone and

Tablet Conferencing
» Four Microphones

Beamforming Array
» Large Pickup and Broadcasting Range

(PHMT503)

599.00

plantronics SaviW740
Multi Device Wireless Headset

» Manages PC, Mobile & Desk Phone Calls
» Headset to Mobile Phone Audio Transfer
Hands-free Operation
to 350 ft (100 m)
» Three Customizable
Wearing Styles

(PLW740) 225.96

800-947-5534 + 212-444-6740




HUBS/KVM SWITCHES/POWER SUPPLY/MOBILE CHARGING STATIONS

a’ 5-Port Powered USB
XCELLON™ 3.0 Aluminum Hub

» 4xUSB 3.0 Ports

» Dedicated USB Charge Port

» AC Powered

» 1 x LED Indicator per Port

(XCUSB5PCH) 37.95

10-Port USB 3.0 Slim Hub ({CSH107H3HC) . 69.95
SAMHO HyperDrive

Thunderbolt 3 USB-C Hub
» 2x USB 3.1 Ports
» Thunderbolt 3,

HDMI Ports

» USB Type-C » SD and MicroSD Card Slots
(OMSAGNZBBGR)......... .o 99.95

USB-4311B

a’XCELLOI'I 4-Port

Portable USB 3.1 Hub
» 4xUSB 3.1 (Gen 1) Ports
» Up to b Gbps Transfer
Speed per Port
» Hot-Swap & Plug-and-Play

(XCUSB43118) 14.95

SFAMHC HyperDrive

USB 5-in-1 Hub

» Port Expansion
via USB Type-C

» Pass-Through USB Type-C Part

» 2xUSB 3.0 Ports » SDXC & microSDXC Slots

®rocear: 2-Port USB
KVM Switch

» USB Keyboard
& Mouse
» V6A Display ‘
» Integrated Cables
106€S220) 16.49

(@ TRenpner  2-Port USB
KVM Switch

» Share a single i
monitor, keyboard, \ '

mouse, microphone [ ==

& speakers
» Hot-Key and Push-Button Switching
(TRTK207K) 17.00

HUBS

|

COMPUTERS )
@ rocearr HUB-C (@ TRenDner  4-Port USB 3.0 Hub
Connect up to 4 USB 3.0 Devices » 4x USB 3.0 Ports
Data Transfer Rate "= » Integrated <
ofplo5Ohis. g USB Cable {j}‘}' ' 2
Hot Swappable e o = » Bus Powered
Plug-n-Play » 4.5 W of Total Power
Bus Powered - No External Power Require » Compatible with USB 2.0/1.1
(I0GUH3C14) 17.17 (TRTU3H4E) 13.99

TP-LINK UH700

USB 3.0 7-Port Hub
» 7xUSB 3.0 Ports —
» Up to b Gbps

Transfer Speed per Port
» AC Powered » USB 3.0 Micro-B Cable Incl.

KINGWIRN KW-HUB-9U3
Multi-Port USB 3.0 Hub

with IQ Charging Ports

» 9x USB 3.0 Ports

» 2xUSB 3.01Q Charging Parts

» 2.4A Output Current on each 1Q Port

(KIKWHUB9U3) 39.95

(SAGNZ18GR) 49.95  (1PUH700) 26.03
KVM SWITCHES

@ racears 4-Port USB Cable
KVM Switch

» USB Keyboard
&Mouse

» VGA Display

» Integrated Cables

(I0KVMCS4P) 37.99

2 Port HDMI USB
SHG KVM Switch

» Share an HDTV

with 4 USB/HDMI

Computers » Share a -

USB Keyboard & Mouse » Share a Microphone
» Supports 3840 x 2160 @ 30 Hz Resolutions

SICEKV061281) 129.45

@erirrin PowerDock Pro
Charging Station
» Five-Bay USB Charging
Station » Charge 5 Phones
and Tablets at Same Time
» Charge Most Other USB Devices
» Fits Phones & Tablets Even with Cases

(GRNA41117) 99.86

B ELKIN. Storeand

Charge Station |

» Stores and Charges up ‘
to 10 Devices w

» Fits Most Cases up to 1.18” Thick

» Holds Laptops or Chromebooks up to 13"

» Built-In Cable Management

[BETSCSAC) 199.99

)

MOBILE CHARGING STATIONS

UNINTERRUPTIBLE POWER SUPPLY (UPS)

@ rocear: 2-Port Cable
KVM Switch with HDMI

» Manage 2 Computers

» Integrated KVM A
Cables

» 2xUSB 2.0/ 1xHDMI/ 2 x Audio Ports

(106CS62HU) 59.99

belkln Rackmount Console
9” Widescreen Single Rail

» Single Rail System
» 1U Compact Design
» Up to 1440 x 900 Video
Resolutions
» PS/2 & USB Support for Input Devices

(BEFTDC10TH) 699.95

®roceare 8-Port USB PS/2
Combo KVMP Switch
» Connects Directly

to 8 Computers @}J I

» Supports 2-Level Cascade
(128 Computers) » USB and PS/2 Support

(IOVKBPSUC) 275.12

ATEN 19" 16-Port

LCD USB KVM Switch

» Rack Mountable

» LED Illumination Light

» Dual Interface » Auto PS/2 & USB Interface
Detection » Two Level Password Security

» Auto Scan Feature

(ATCL1316N)

7-Port USB Charging Station

Ruma with Qualcomm Quick
Charge 2.0

» Charge up to Seven
Devices at Once
» Up to 2.4A per Port
» Up to 15.2A Total Power Output
(xucsraca) 74.95

LUXOR LLTM30-B 30 Tablet

Charging Rolling Cart

» Charges Up to 30 Devices at
Once » Two Storage Shelves
Hold 15 Devices Each

» Two 15-Outlet Vertical Power
Strips » 1" Rubber-Coated Dividers

(LULLTMBOB) ... 508.95

il i iSese

Brand CyberPower CyberPower
Model BX1 5l]llM LX13256 BR15006 BX1000M BEI.ZEM BE65061 BN9I]UM SE4256
VA / Watts 1500VA / 900W 1000VA / 600W 1500VA / 865W 1000VA / 600W 425VA [ 255W 650VA / 390W 6900 VA/480W 425VA [ 255W
Additional Protection RJGS RJT1/RJ45 and Coax RG6 RJ-45/USB RJ-45 & Coax None None UsB RJ-45
Outlets Quantity 10 9 10 8 6 8 9 7
SKU APBX1500M CYCP1000AVRL APBR15006 APBX1000M APBE426M APBE65061 APBN900M CYSE4256
Price 169.99 109.95 169.95 129.99 44.09 74.95 99.99 49.95

www.BandH.com BsH



COMPUTERS

Computer Cables

CABLES

After countless hours of researching and comparing, you've finally purchased the computer you wanted. Whether it was a laptop or a desktop
computer, you'll want to use the full advantage of all the ports. It can be quite daunting to know which cables to use. For starters, most ports
on your computer will have female connectors. Female connectors are ports that you plug into. Cables will usually have male connectors,

which plug into the female connectors on your computer.

There are also different types of ports. Thunderbolt and USB are used to transfer data while DisplayPort, DVI, and VGA ports are used to output
video to an external display, such as a monitor or an HDTV.

Thunderbolt

Access high-speed peripherals and high-res displays via one simple port
that carries DisplayPort and PCle data. Thunderbolt™ gives you two chan-
nels on the same connector with 10 Gbps of throughput in bath directions.
Thunderbolt 2 pushes that to 20 Gbps by bonding the two channels togeth-
er. While Thunderbolt and Thunderbolt 2 share the same connector as mini
DisplayPort, Thunderbolt 3 utilizes the reversible USB Type-C connector.
Thunderbolt 3 also has a maximum throughput of 40 Gbps and has dual-
bandwidth DisplayPort 1.2 so you can connect to two 4K displays simulta-
neously. Thunderbolt and Thunderbolt 2 are usually found on Mac systems,
and Thunderbolt 3 has been seen on Mac and Windows computers.

DisplayPort / Mini DisplayPort

DisplayPort and mini DisplayPart are usually found on Mac com-
puters, but can be found on some PC computers as well. Display-
Port is a digital display interface that supports video, audio, and
other forms of data in a single cable. DisplayPort is the older,
bigger version while mini DisplayPort is the smaller version that
shares the same design as Thunderbolt.

4

Comprehensive PEARSTONE
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USB / USB-C

USB stands for Universal Serial Bus and it lives up to its name since it can
be found on practically every modern computer. You'll notice that USB will
usually have a number next to it. This number is the release name, but can
also be associated with the data transfer speed they support. For example,
USB 2.0 supports up to 480 Mbps while USB 3.0 supports up to 5 Ghps.
USB 3.1 supports up to 10 Gbps. Most computers use the USB Type-A ports
while the USB Type-B port can be found on computer peripherals, such as
printers. The micro-USB port is usually found on mabile devices, such as
smartphones and tablets. USB Type-C is becoming mare popular, thanks to
its reversible connector.

DVI

DVI stands for Digital Visual Interface. It transmits uncompressed
digital video. The DVI connector is given one of three names, de-
pending on which signal it uses. DVI-I means it integrates both
digital and analog signals into the same connector. DVI-D means
it only supports a digital signal, single or dual link. DVI-A means it
only supports an analog signal.

EED BELKIN.

kanex @moecear

Ethernet

Most laptops have given up the Ethernet jack in favor of Wi-
Fi, but desktop computers and workstations still embrace the
wired Internet connection. Most computers utilize the RJ-45
LAN jack, which plugs into your computer and your router. The
Ethernet jack usually supports 10/100 Mbps Fast Ethernet or
10/100/1000 Mbps Gigabit Ethernet. If you have a 10/100 Mbps
Fast Ethernet jack, a Cath cable should be good enough. Catbe
is an enhanced version of Cat5 and supports 10/100/1000 Mbps.
Cat6 further improves upon Catbe and supports 10 Gigabit Eth-
ernet in certain cases.

VGA

Known as Video Graphics Array, VGA has been around since the 1980s.
While most computers now use more modern technologies, like HOMI
and DisplayPort, certain laptops still sport the analog interface as
an addition, which is useful for backwards compatible with older
projectors and monitors. VGA is usually seen as a 15-pin connector.
On laptops and smaller devices, a mini-VGA connector can be found.

To view a full listing
of all Computer Cables

OR VISIT OUR WEBSITE
BANDH.COM/W15105

800-947-5534 + 212-444-6740



EPSON' Perfection V600

Photo Scanner

» Optical Density: 3.4 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi
» Max Resolution: 12800 x 12800 dpi
» Scans Prints, 35mm & Medium Format Film
» Maximum Scan Area: 8.5 x 11.7

» DIGITAL ICE Scratch & Dust Removal

(EPPV600)

Call or Log-On

Canon CanoScan 9000F Mark Il

Film & Document Scanner

» Optical Resolution: 9600dpi (Film)
» Optical Resolution: 4800dpi (Docs)
» Color Depth: 48/24-Bit
Internal/External

» Scan 35mm Negatives & Slides

» Scan Film, Slides, Documents, Photos .
» Scan Medium Format Film » OCR & PDF Creation Software
Included » My Image Garden Software

(CACSIOOFM2S) ..o

199.99

Fujitsu fi-7160

Document Scanner

» Optical Resolution: 600 dpi

» Scan Speeds of 60 ppm & 120 ipm

» 80-Sheet Automatic Document
Feeder » Duplex Scanning

» Maximum Document Size: 8.5 x 220"

» Minimum Document Size: 2.0x 2.1”

» Output Color Depth of 24-bit

» Double Feed Detection Sensor

(FUFI7160DS)

. 858.90

brother ImageCenter ADS-2800W
Wireless Desktop Scanner -

» Optical Resolution: 600 x 600 dpi
» Interpolated Resolution: 1200 x 1200 dpi
» Scan Speed: 30 ppm Simplex

60ipm Duplex » Scan Size:

Max 8.5 x 196", Minimum: 2 x 2.76”
» 50-Sheet Automatic Document Feeder
» 3.7 Color Touchscreen; USB Port
» Kofax VRS & TWAIN Compatible » USB 2.0, Ethernet, & Wi-Fi
(BRADS2800W)....... 419.99

Fujitsu ScanSnap S1300i

Document Scanner

» Compact Size

» Scan Speed: 12ppm

» Scan Resolution: 600dpi

» Automatic Duplex Scanning

» USB-Pawered For Increased Portability
» Scan Directly To The Cloud

» Scan To Commonly Used Programs

(FUS13001) o 26422

www.BandH.com

SCANNERS

EPSON Perfection V550

Photo Scanner

» Scans Prints, 3bmm &
Medium Format Film

» Optical Resolution: 6400 dpi
» Max Resolution: 12800 x 12800 dpi
» Optical Density: 3.4 Dmax

» Color Depth: 48-bit » Maximum Scan Area: 8.5x 11.7"

» Built-In Transparency Unit: 2.7 x 9.5”

» DIGITAL ICE Scratch & Dust Removal » USB 2.0 Connectivity

(EPVA50). ... Callor Log-On

Canon CanoScan LiDE220
Color Image Scanner

» Optical Resolution: 4800 x 4800 dpi
» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Five EZ Buttons & Scan to Cloud

» Letter-Size Scan Speed, 300 dpi: 10 sec

» Color Depth: 48-bit Internal / External

» Advanced Z-Lid & Upright Scanning

» ENERGY STAR Certified and RoHS Compliant

(CAL220) .o

78.99

FujiTsu ScanSnap iX500
Wireless Desktop Scanner

» Color Scan Speed: 25 ppm

» Create Searchable PDFs

» Maximum Scan Area: 8.5 x 34"

» Optical Resolution:
600 x 600 dpi

» b0-Sheet Automatic Document Feeder

» Scan to Mobile Devices & Cloud Services

» Double-Feed Detection

(FUIX500)......ccc 429.95

brother ImageCenter ADS-2000e
High-Speed Desktop Document Scanner

» Optical Resolution: 600 x 600 dpi

» Interpolated Resolution: 1200 x 1200 dpi
» Speed: 24 ppm Simplex/48 ipm Duplex
» Scan Size: Max. 8.5 x 34", Min. 2x 276"
» 50-Sheet Auto Document Feeder
» 2-in-1 Mode & Continuous Mode
» USB Direct; Android Device Support
» Kofax VRS & TWAIN Compatible » USB 2.0 Connectivity
(BRADS2000E)

Canon imageFORMULA DR-C240

Office Document Scanner

» Optical Resolution: 600 dpi

» Scan Speed: 45 ppm B&W

30 ppm Color

» Maximum Scan Area: 8.5 x 14"
» Minimum Scan Area: 2.0 x 2.8”
» Color Depth: 24-bit

» Automatic Duplexing at up to 90 ipm
» 60-Sheet Automatic Document Feeder

(CADRC24D) ...........

596.00

COMPUTERS

EPSON Perfection V850

Pro Scanner

» Scans Prints, Film, and Slides

» Optical Resolution: 6400 dpi

» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Maximum Scanning Area: 8.5 x 11.7"
» DIGITAL ICE Scratch & Dust Removal
» SilverFast SE 8 Software Included

» USB 2.0 Connectivity

(EPV850)

- 999.00

Canon CanoScan LiDE120
Color Image Scanner

» Optical Resolution: 2400 x 4800 dpi
» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Color Depth: 48-bit Internal / External
» Letter-Size Scan Speed, 300 dpi: 16 sec

» Four EZ Buttons & Advanced Z-Lid

» Scan to Cloud Function » Powered via USB Port
» ENERGY STAR Certified and RoHS Compliant

(CAL120)

plustelc SmartOffice PS286 Plus

Document Scanner

» Duplex Scanning in Color/Grayscale/B&W

» Scans Paper Documents and Rigid Cards

» Automatic Document Feeder (50 Pages)

» Create Searchable PDF & MS
Office Files

» Scan To Folder / Network
Email / FTP / Printer

» Scan Speed: 25 PPM » Daily Duty Cycle - 1500 pages

[PLMOPS286) . 216,35

Canon imageFORMULA DR-C225

Office Document Scanner

» Scan Documents and Cards

» Optical Resolution: 600 dpi

» Scan Speed: 25 ppm /50 ipm

» Color Depth: 24-bit

» Duplex Scanning

» Maximum Scan Area: 8.5 x 14"
» Long Document Mode: 118.1”

(CAIFDRC225SC)

EPSON FastFoto FF-640
High-Speed Photo Scanning System

» Scans Photos and Documents

» Optical Resolution: 600 dpi

» Maximum Scan Size: 8.5x 120"

» Minimum Scan Size: 2x 2°

» 4x 6" Scan Speed: 60 ppm/300 dpi
» Document Speed: 45 ppm at 300 dpi
» Single-Pass Duplex ADF

» FastFoto Software with Smart Photo Fix » USB 2.0 Connectivity

(EPFF40) v 649.99




COMPUTERS

PORTABLE SCANNERS / LABEL MAKERS

plustelc MobileOffice S410
Portable Scanner
» 600 dpi
» Document Size:

Max 8.5 x 36" Min: 2x 2"
» Scan Speed: 9 Sec per A4 Page at 300 dpi
» Supports Rigid Embossed Cards
» Two Single-Touch Buttons: PDF & Sean
» USB Powered

[PLMOS410)

105.54

Canon imageFORMULA P-2151l Scan-tini
Personal Document Scanner
» 600 dpi Optical
Resolution
» Color Scan Speed
10 ppm /20 ipm
» Color Depth: 24-Bit
» Min Document Size: 2.0 x2.8" » Max Document Size: 8.5 x 39.4”
» 20-Sheet Automatic Document Feeder » Duplex Scanning
» Built-In Card Scanner » Power Over USB » USB 3.0 Connectivity

(CAP21511) 224.00

PORTABLE SCANNERS

< ScanSnap iX100
FU"TSU Wireless Mobile Scanner
» 600 dpi Optical

Resolution
» Min Document Size: 1x 1"
» Max Document Size: 8.5 x 34"
» Scan Speed: 5.2 Secands per Page
» Automatic Stitching of Two-Page Spread
» USB Rechargeable Li-lon Battery » Battery Life: 260 Scans
(FUIX100WMS) 195.95

brother DS-620 Mobile

Document Scanner

» 600 x 00 dpi b . -

» 8 ppm Black and Color

» Scan Documents up
t08.5x 32

» OCR Software

» USB-Powered, No Outlet Necessary

» Scan to Email, Folder, PDF

» Weighs Under 1 tb

(BRDS620)

........ .95.99

DYMO LabelWriter 450 Turbo

USB Label Printer

» Thermal Printing Technology

» Prints 71 Labels/Minute

» Windows & Mac
Compatibility

64.99

v

(DYLWA50T)

brother PT-P700
PC-Connectable
Label Printer

» Print Resolution: 180 dpi

» Create Labels up to 1" Wide & 11.8" Long
» Thermal Print Technology

» Automatic Cutter

» Print Speed of 1.2" per Second

» USB Port for PC Connectivity > Runs on AC or Battery Power
» Windows and Mac Compatible

[BRPTP700) 62.99

LABEL PRINTERS

EPSON WorkForce DS-30

Portable Scanner

» USB-Powered:
No Outlet Required
» Lightweight
Design Ideal For Travel
» Scan Directly To Popular Cloud Services
» Includes OCR Software For Windows/Mac
» Mac & PC Compatible > Includes Travel Case
(EPDS30)

149.99

[ ] Magic Wand

Portable Scanner

» 900 dpi » 8.27" Scan Width

» 98" Maximum Scan Length

» Scan Almost Any Flat Surface

» Battery Operated

» Stores Images on microSD Card

(VUMWPSBS) 41.95

DYIMIO LabelWriter 4XL
Label Printer
» No Ink or Toner Required
» Labels up to 4™ (10.16cm) Wide
» Windows XP, Vista &

Mac Compatible

163.90

(DYLW4XLB)

brother (0L-800

High-Speed Professional
Label Printer

» Prints on Labels up to
24" Wide

» Prints up to 93 Labels
per Minute

» Up to 300 x 600 dpi
Print Resolution

» Built-In Automatic Cutter

99.99

(BROLBOO)

{Eg; . 3Target 24X
DVD/CD Duplicator

» Burns Approximately 30 DVDs / Hour
» SATA Internal Interface

» Up to 24X Read Speed

» 3 x DVD Writers

» 1x DVD-ROM Drive

» Intuitive LCD Display

» Na Cool Down Period

(EZD3TDVDLGB)

296.18

OPTICAL MEDIA PRINTERS

DYIVIO Rhino 5200
Labeler Hard Case Kit

» Lithium lon Battery Included

» Easily Print Labels On The Job

» Print Labels Up To 19 mm Wide

» Backlit For Low Light Installations

» Pre-Programmed Symbol Library

» Slip-Resistant Rubber Grip > Print Bar Codes
» Complies W/ ANSI/TIA/EIA-606-A Standards
(DY1756589)

Call or Log-On

brother PT-D210
Portable Label Maker
» Standalone Operation
» Print Resolution: 180 dpi = &0,
» Works with TZe Tape Family ;
) . . o

» Max Tape Size: 0.47" x 26.2 <
» Max Print Speed of 0.8” per Sec. j b
» Prints up to 2 Lines &

30 Label Memory  » 1-Line LCD Display & QWERTY Keyboard
» Thermal Print Tech. & Manual Cutter » Runs on 6 x AAA Batteries

(BRPTD210) 35.82

EPSON Discproducer
Autoprinter
» Windows Compatible
» 100-Disc Capacity
» Print Up to 95 Discs an Hour
» Max Printing Resolution

1440 x 1440 dpi
» All-In-One Software » USB Interface
» Reliable Media Handling Tech  » Compact Rugged Construction
(EPPP100AP) 1,950.00

[

 morosoaros (1D-DVD-123
DVD/CD Duplicator
» 24x/48x Standalone 1:3 Duplication
» Standalone Operation
» LCD Display & Control Panel
» Includes PrassiTech Zulu 2

Disc Mastering Software
» LCD Screen Provides The Status

0f The Recording Process
(MIQDDVD123)

800-947-5534 + 212-444-6740




Budlee Create 3D

Printing Pen

» Simplified & Intuitive
Controls

» Two Speeds &
Two Temp Settings

» Lightweight,
Aluminum Design

» Ambient Light Bar

(3D00DCREUS) e 84.95

@ makerBot: Replicator+
Desktop 3D Printer

» 11.6x 7.6 x 6.5 Build Volume
» 100-400 Micron Layer Resolution
» Single Extruder Nozzle
» Uses 1.75mm MakerBot
PLA Filaments » Print from USB,
Ethernet, or Wi-Fi » Flex Build Plate with Grip Surface
» Open Print Chamber » Factory-Leveled
» Supports CAD, STL, and more
(MAMP07825)

..2,499.00

> da Vinci 2.0 Duo
-~ &
Ayzp'ﬁ 3D Printer
» Build Volume: 5.9 x7.8x 7.8”
» 100-Micron Layer Resolution
» Dual Extruders
» Uses 1.75mm ABS Filament
» 2.6" Display Panel
» Print via USB 2.0 Connectivity
» STL, 3w File Formats Supported
» Partially Enclosed Build Chamber » Mac & Windows Compatible
(XY3F20AXUSOB) 399.00

S Robox

¥ 3D Printer

» Build Volume: 8.3 x5.9x 3.9

» 20 Micron Layer Resolution

» Dual Nozzle, Single Material
Extruder » Different Nozzles
for Fill & Detail » Uses Robox SmartReel Filament

» Uses PLA, ABS, PVA, Nylon, PET, & More » USB, microSD, Wi-Fi
Connectivity » Robox AutoMaker Software Included

» Windows, Mac, & Linux Compatible

(RORBX01)

Call or Log-On

MdTTEI o FOMM 3D Scanner

» Max Height & Diameter
Scan: 9.8x7"

» Max Weight Scan: 6.6 bs

» HD CMOS Sensor
with Two Lasers

» USB 2.0 Interface

» Mac & Windows Compatible

(MAMFSIVIR) 499.00

3D PRINTERS & SCANNERS

CRE! 3D Pen
Starter, Black/Silver

» One CreoPop 3D Pen

» 3 Ink Cartridges (Red, Orange, Cyan)

» Uses Light-Sensitive Photopalymer Inks
» Charges via USB

» Operates Cordlessly After Charging

» No Hot Parts; Safe for Children

» Accepts Wide Variety of Inks

(CRSKUOD1) .. Call or Log-On

€ FLASHFORGEUSA (reator Pro
3D Printer

» Build Volume: 8.9 x5.7x5.9" (
» 100 Micron Layer Resolution

» Dual Extruders for 2-Color Printing
» Uses ABS & PLA Filament

» Print from SD Card or USB

» Integrated LCD Screen

» Sturdy Metal Frame

» Mac, Windows, & Linux Compatible

(FL3DFFGNPRO) Call or Log-On

- da Vinci 1.0 All-in-One
-~ i
ﬂﬂ”'ﬁ 3D Printer & Scanner

» Build Volume: 7.9 x 7.9 x 7.5”

» 100-Micron Resolution

» Scan Volume: 5.9 x5.9”

» 250-Micron Scan Resolution

» Uses 1.75mm ABS & PLA Filament
»STL, .3W, .DAS File Formats Supported
» 2.6 Four-Line Display Panel

» Windows & Mac Compatible

(XY3ST0AXUSOC) 499.00

DREMEL 3D -
Q.IDEA BUILDER iDDIgfﬂ\tB::lder 3040

» Build Volume: 10x 6 x 6.7

» 100-Micron Resolution

» Only Uses Dremel 1.75mm
PLA Filament

» Pre-installed Single Extruder

» 4GB of Internal Storage, USB Port =

» Removable Build Plate » 3.5" Full-Color IPS Touchscreen

» Wi-Fi, Ethernet, & Mobile App Support » Fully Enclosed Workspace

(DR3D4001) 1,209.00

> 3D Scanner Pro
-~ i
Wﬂfb Handheld 3D Scanner

» Head, Object, and Full Body Scanning

» Intel RealSense Camera

» Scan Volume: Max 39.3 x 39.3 x 78.7"

» Min:2x2x2" » Scanning Distance: 5.9-9.84"

» Operating Range: 3.93-27.55" » Scan Resolution: |
1.0-2.5mm > Image Size: 640 x 480 (@ 30 fps

» Qutputs STL, 0BJ, and PLY Files

» Supports Windows 8.1 & Above

(XY3SH1AXS00K) 195.00

COMPUTERS

> da Vinci
> fa 3D Pen

» Create 3D Printed Objects
» Computers or CAD
Software Not Needed
» Create Large &
Small Objects » Move Along Surfaces or Draw Upwards
» Fused Filament Fabrication Technology
» 11 Available PLA Filament Colors
» Lightweight & Mobile

(XY3NTOXXUSE) e 33.95

€ FLASHFORGEUSA Dreamer
3D Printer

» 9.1x5.9x5.5" Build Volume
» 100-Micron Resolution
» Dual Extruders for

2-Color Printing
» Compatible with ABS, PLA

& PVA Filament
» Print from SD Card, USB, or Wi-Fi » Mutli-Language LCD screen
» Multiple User LED Pixel Strips » Self-Calibrating Build Platform

(FL3DPRINTERD) 1,063.91

S Tiertumne UpBoX+
3D Printer

» Build Volume: 10 x 8 x 8"

» 100-400 Micron Layer Resolution
» Single Extruder Nozzle

» Uses ABS, ABS+, & PLA Filament
» Print from USB and Wi-Fi

» Heated Print Bed » Enclosed Print Chamber

» STL, UP3, and UPP Files Supported > Fully Automatic Leveling
» Windows, Mac, i0S, & Android Compatible

(TIUPBOXP)

..1,899.00

AFINIA 3D H400
3D Printer

» 4.7x4.7x 47" Build Volume

» 150-350 Micron Layer Resolution

» Single Extruder Nozzle

» Uses 1.75mm ABS and PLA Filaments
» Print from USB 2.0 and Wi-Fi

» Heated Print Bed » Enclosed Print Chamber

» Auto-Nozzle Height Detection

» Factory-LeveledWindows, Mac, and i0S Compatible

(AFH400) 599.00

AFINITA 3D EinScan-SE

3D Scanner with Turntable

» Scans Using Fixed or

Auto Modes ’?W
» Fixed Scans are Stationary  1H/

» Auto Scans Use a

Rotating Turntable
» Auto Scans Stitched Into One Object
» Scan Dimensions Min: 1.2x 1.2x1.2" » Max: 27.6x 27.6 x 27.6"
» <0.J/mm Accuracy » White Light Source » Windows Compatible
(MIEINSCANSE) .1,199.00

www.BandH.com BsH



COMPUTERS

LASER PRINTERS

RICOH SPC250DN

Color Laser Printer

» Print Resolution: 2400 x 600 dpi
» Print Speed: 21 ppm

» Maximum Print Size: 8.5 x 14"
» Mabile Device Printing o

» Automatic Duplexing; USB Host Part --\'-'1!,
» 250-Sheet Input Tray & 1-Sheet Bypass

» USB 2.0, Ethernet, & Wi-Fi Connectivity

(RISPC250DN)

129.99

brother HL-L8360CDW

Wireless Color Laser Printer

» Print Resolution: 2400 x 600 dpi

» Print Size: Max. 8.5x 14", Min. 3 x 5" -
» Print Speed: 33 ppm (Simplex)

» Automatic Duplex Printing

» Mobile Printing Capability

» 2.7" Color Touchscreen; Front USB Port

» 50-Sheet Multipurpose & 250-Sheet Trays

» USB 2.0, Ethernet, and Wi-Fi with NFC

(BRHLL8360CDW) 399.99

brother HL-L2340DW
Monochrome Laser Printer
» Max Resolution: 2400 x 600 dpi
» Max Document Size: 8.5 x 14"
» Print Speed: 27 ppm

» Automatic Duplex Printing

» One-Line LCD Display

» One-Sheet Manual Bypass

» Input Capacity: 250 Sheets » USB 2.0 and Wi-Fi Connectivity

(BRHLL2340DW) 109.00
7) LaserJet Pro M402n
Monochrome Laser Printer
» Print Resolution: 600 x 600 dpi e

» Maximum Print Size: 8.5 x 14"

» Minimum Print Size: 3 x "

» Print Speed: 40 ppm

» Mabile Printing

» 7-Line Backlit LCD; USB Host Port
» 100-Sheet & 250-Sheet Input Trays » Monthly Cycle: 80,000 Pg
» USB 2.0 and Ethernet Connectivity

(HEM402N)

269.00

Canon imageCLASS MF414dw

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 1200 x 600 dpi

» Maximum Print Size: 8.5 x 14”

» Print Speed: 35 ppm

» Scanner Glass Size: 8.5 x 11.77

» 3.5" Color Touchscreen LCD; Direct USB

» 50-Sheet Multipurpose & 250-Sheet Trays
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(CAMFA14DW)

399.00

COLOR LASER PRINTERS

) LaserJet Pro M477fdw
All-in-One Printer

» Print, Scan, Copy, Fax
» Print Resolution: 600 x 600 dpi e
» Print Speed: 28 ppm b
» Optical Scan Res.: 1200 x 1200 dpi |
» Maximum Document Size: 8.5 x 14"
» Auto Duplexing » 4.3" Color Touchscreen; USB Host Port
» USB 2.0, Ethernet, and Wi-Fi with NFC

(HEM4770DW) 629.00

brother MFC-9330CDW
Wireless Color Laser Printer = &

oy

» Print, Scan, Copy, Fax
» Print Resolution 600 x 2400 dpi
» Automatic Duplex Printing =
» Wi-Fi. Ethernet, AirPrint, Cloud Print
» Print/Scan with USB Drive
Mobile Device » Input Capacity
261 Sheets » Scan Resolution 1200 x 2400 dpi
» Monthly Duty Cycle 30,000 Pages » Internal Memory 192 MB

(BRMFC9330CDW) 360.00

MONOCHROME LASER PRINTERS

brother MFC-L2700DW
All-in-One Laser Printer
» Print, Scan, Copy, Fax

» Resolution: 2400 x 600 dpi

» Max Print Size: 8.5 x 14"

» Automatic Duplex Printing

» Flatbed Max Scan Size: 8.5 x 11.7"
» 3b-Sheet ADF & 250-Sheet Input Tray
» Monthly Cycle: 10,000 Pages » USB 2.0, Ethernet & Wi-Fi
(BRMFCL2700DW)

169.99

7 LaserJet Pro M227fdn

All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 1200 x 1200 dpi
» Maximum Print Size: 8.5 x 14"

» Print Speed: 30 ppm (Simplex)

» Flatbed Scan Area: 8.5 x 11.7"

» Mabile Printing Support

» 35-Sheet ADF; Automatic Duplex Printing » USB 2.0 and Ethernet
269.00

(HELJPM227FDN)

xerox @, WorkCentre 3215
All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 4800 x 600 dpi

» Print Size: Max. 8.5x 147, Min. 3 x §”
» Print Speed: 27 ppm

» Optical Scan Resolution: 1200 x 1200 dpi
» 250-Sheet Input Tray / 40-Sheet ADF -
» Monthly Duty Cycle: 30,000 Pages

» USB 2.0, Ethernet, & Wi-Fi Connectivity

(XE3215N1) 290.99

xerox @,) WorkCentre 6027
All-in-One Color LED Printer
» Print, Scan, Copy, Fax

» Print Resolution: 1200 x 2400 dpi

» Print Speed: 18 ppm

» Maximum Scan Resolution: 1200 dpi

» Maximum Document Size: 8.5 x 14”

» Mabile Printing Capability

» 15-Sheet ADF & 150 Sheet Input Tray » USB, Ethernet, & Wi-Fi

(XE6027NI) 429.00
brother MFC-L8900CDW

Color All-in-One Laser Printer

» Print, Scan, Copy, Fax fﬁ,——

» Print Resolution: 2400 x 600 dpi

» Print Size: Max. 8.5x 14"

» Automatic Duplexing in All Modes
» Flatbed Scan Area: 8.5 x 14”

» Mobile Printing Support; Front USB
» 57 Color LCD; 70-Sheet ADF

» 50-Sheet Multipurpose & 250-Sheet Trays

(BRMFC8900CDW) 529.95

brother DCP-L2540DW

Wireless All-in-One Laser Printer

» Print, Copy, Scan

» Print Resolution: 2400 x 600 dpi
» Automatic Duplex Printing

» Optical Scan Res.: 600 x 2400 dpi
» Flatbed Scan Size: 8.5x 11.7"

» USB 2.0, Ethernet, & Wi-Fi Connectivity

(BRDCPL25400W)

159.00

7) HP LaserJet Pro M426fdw
All-in-One Laser Printer
»
» Optical Scan Res.: 1200 x 1200 dpi
» Maximum Document Size: 8.5 x 14"

» Automatic Duplexing » 3.0" Color Touchscreen; USB Host Port
» 350-Sheet Tray Capacity & 50-Sheet ADF » USB, Ethernet, Wi-Fi

[HEM426DNW) 449.00

W Xpress M2020W
Monochrome Laser Printer
» Max Resolution: 1200 x 1200 dpi

» Maximum Document Size: 8.5 x 14"
» Minimum Document Size: 3 x 5"

» Print Speed: 21 ppm

» First Print Out Time: 8.5 Seconds

» Input Capacity: 150 Sheets

» Monthly Duty Cycle: 10,000 Pages
» ENERGY STAR Certified » USB 2.0 and Wi-Fi with NFC

(SAM2020W) 109.61

» Print, Scan, Copy, Fax
» Print Resolution: 600 x 600 dpi
» Print Speed: 40 ppm

“ B:H 800-947-5534 + 212-444-6740



Canon PIXMA MX922
Wireless Color All-in-One Inkjet Office Printer

P

» Print, Scan, Copy, Fax g
» 9600 x 2400 Color dpi =
» 15 ipm Black, 10 ipm Color
» Wi-Fi, Ethernet, AirPrint
» Cloud » Auto Duplex
» 2400 x 4800 dpi

Optical Scan Resolution
» ADF for Multipage Scan, Copy, Fax » Print on CD, DVD, Blu-ray

(CAMX922) . 168.30

L R LI}
=)

) OfficeJet Pro 6978
All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» HP Instant Ink Program Ready

» Print Resolution: 600 x 1200 dpi

» 20 ppm Black / 11 ppm Color

» Optical Scan Resolution: 1200 dpi

» Maximum Document Size: 8.5 x 14"

» Automatic Duplexing; Mobile Printing » 225-Sheet Input Tray &
35-Sheet ADF » USB 2.0, Ethernet, & Wi-Fi Connectivity

(HE8978) e 179.99

EPSON' WorkForce Pro WF-3720
All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Print Resolution: 4800 x 2400 dpi
» Max Print Size: 8.5 x 47.2"

» Optical Scan Res.: 1200 dpi

» Flatbed Scan Area: 8.5x 11.7

» Duplex Printing; Wi-Fi Direct

» 250-Sheet Paper Tray & 35-Sheet ADF
» USB 2.0, Ethernet, and Wi-Fi with NFC

(EPWF3720) e 149.99

EPSON' WorkForce WF-7110

Wireless Color Inkjet Printer

» PrecisionCore Printhead

» Resolution: 4,800 x 2,400 dpi
» Automatic Duplex Printing

» Max Document Size: 13 x 19"
» Two 250-Sheet Paper Trays

» 2.2 LCD Screen

» Monthly Duty Cycle: 20,000 Pages
» Wi-Fi & Ethernet Connectivity

(EPWF7110)

e 199.99

brother MFC-J9850W

All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 6000 x 1200 dpi

» Duplex & Borderless Printing

» Scan Res.: 2400 x 1200 dpi -

» Max Document Size: 8.5 x 14" P

» 2.7 Color Touchscreen; 20-Sheet ADF » 100-Sheet Input Tray and
1-Sheet Bypass » Accepts Super High-Yield INKvestment Ink

» USB 2.0, Ethernet, and Wi-Fi with NFC

(BRMFCJ9850W)

e 179.99

www.BandH.com

INKJET PRINTERS

Canon PIXMATS9020
Wireless All-in-One Inkjet Printer
» Print, Scan, Copy i
» Print Resolution:
9600 x 2400 dpi
» Max. Print Size: 8.5 x 14"
» Print Speed: 15 ipm
Black / 10 ipm Color
» Optical Scan Resolution: 2400 x 4800 dpi » 6-Color Ink System
Duplex Printing » 5.0" Touchscreen LCD; SD Card Slot
(CATS9020W) ..........

189.99

7 OfficeJet 200
Mobile Inkjet Printer

» Max Resolution: 4800 x 1200 dpi
» Max Print Size: 8.5 x 14"
» Min Print Size: 3 x 4"

» b0-Sheet Auto Feeder

» 2.0" Hi-Res Monachrome

Graphics Display =
» Monthly Duty Cycle: 500 Pages
» Optional Li-lon Battery Pack » USB 2.0 and Wi-Fi Connectivity

(HE0J200)...............

279.99

EPSON' WorkForce Pro WF-4730
All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 4800 x 1200 dpi

» Max Print Size: 8.5 x 47.2"

» Print Speed: 20 ppm

» Optical Scan Resolution: 1200 dpi
» Flatbed Scan Area: 8.5 x 11.7"

» Duplex Printing; Wi-Fi Direct

» Two 250-Sheet Trays & 35-Sheet ADF » USB, Ethernet, and Wi-Fi
(EPWF4730) 199.99

EPSON Expression Home XP-440

Small-in-One Inkjet Printer

» Print, Scan, Copy

» Print Resolution: 5760 x 1440 dpi

» Max Print Size: 8.5 x 44"

» Optical Scan Resolution: 1200 dpi

» Flatbed Scan Area: 8.5x 11.7"

» Input Capacity: 100 Sheets

» 5D Card Slot & Photo Editing Tools » Creative Print App; Scan and
Share » USB & Wi-Fi Connectivity; Wi-Fi Direct

(EPXPAAO) ..o 99.99

brother MFC-J69350W

All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Print Resolution: 4800 x 1200 dpi

» Maximum Print Size: 11 x 17°

» Scan Resolution: 2400 x 1200 dpi

» Flatbed Scan Area: 11.7x 177

» Automatic Duplexing; 50-Sheet ADF

» 100-Sheet Multipurpose & 500-Sheet Trays » 3.7" Touchscreen
LCD: INKvestment Inks » USB 2.0, Ethernet, and Wi-Fi with NFC

(BRMFCJ69350W) ... 322.99

COMPUTERS

) OfficeJet Pro 8710
All-in-One Inkjet Printer

» Print, Scan, Copy, Fax
» Resolution: 4800 x 1200 dpi
» Maximum Print Size: 8.5 x 14"
» Borderless Printing;

Automatic Duplexing
» Max. Flatbed Scan Size: 8.5 x 11
» 2.65” Color Touchscreen; 50-Sheet ADF
» 250-Sheet Input Tray » USB 2.0, Ethernet, & Wi-Fi Connectivity

(HE0JB710) e 199.99

) OfficeJet Pro 7740
Wide Format All-In-One Inkjet Printer

» Print, Scan, Copy, Fax

» Print Res.: 4800 x 1200 dpi

» Max Print Size: 11.7 x 17"

» Borderless Printing &
Automatic Duplex

» Optical Scan Res.: 1200 dpi

» Flatbed Scan Area: 11.7x 17

» 500-Sheet Capacity & 35-Sheet ADF » USB 2.0, Ethernet, & Wi-Fi

(HE0JP7740) _Callor Log-On

EPSON' WorkForce WF-2760
All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 4800 x 1200 dpi

» Max Paper Size: 8.5 x 47.2"

» Borderless and Automatic
Duplex Printing

» Optical Resolution: 2400 dpi

» Copy Speed: 11 cpm Black/5.5 cpm Color

» 2.2” Monochrome Graphic Display » USB, Ethernet, and Wi-Fi

[EPWF2760) 129.99

EPSON Expression Premium XP-640
Small-in-One Inkjet Printer
» Print, Scan, Copy
» Resolution: 5760 x 1440 dpi
» Max Print Size: 8.5 x 11"
» Duplex, Borderless, &

CD/DVD Printing
» Max Scan Resolution: 2400 dpi
» Scan Size: 8.5x 11.7" » 2.7" Touchscreen; Mabile Device Printing
» SD Memory Card Slot; USB Port » USB 2.0 and Wi-Fi Connectivity

(EPXP64OAIOP)

_.Callor Log-On

brother WorkSmart Series MFC-J460DW

Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Print Resolution: 6000 x 1200 dpi

» Duplex & Borderless at
upto85x11”

» Scan Resolution: 2400 x 1200 dpi

» Max Document Size: 8.5 x 14"

» 1.8” Color LCD; USB Host Port » Mobile Printing Support

» 100-Sheet Tray & 20-Sheet ADF » USB 2.0 and Wi-Fi Connectivity

(BRMFCJ460DW)




COMPUTERS

Canon PIXMAPR0-100

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi
» Print 8 x 10" in 51 Sec.
» §Ink Cartridges
Including 3 Monochrome
» Wi-Fi, Ethernet, AirPrint,
PictBridge » Print Sizes up to 13 x 19"
» (D, DVD, Blu-ray Printing » Print Studio Pro for Phatoshop, DPP
(CAPP100) S 379.99

PIXMA PRO-10 (CAPP10)

Canon PIXMAiP8720

Wireless Inkjet Photo Printer

» Print Res.: 9600 x 2400 dpi
» Upto 13 x 19" Print Size

» 14.5Black ipm

» 10.4 Color ipm ——
» 6-Color Ink System with Gray o =N
» Prints Borderless 4 x 6" Photo in 36 sec

» Can Print on CD, DVD, and Blu-ray Discs

» Auto Power On and Off Settings » Wi-Fi 802.11 b/g/n

(CAIP8720) S 244.95

EPSON' SureColor P400

Wireless Color Inkjet Printer

» Max Res.: 5760 x 1440 dpi

» Max Print Area: 13 x 129"

» Borderless Prints to 13 x 19"
» Roll Media up to 13" Wide

» Epson MicroPiezo AMC Print Head
» AccuPhoto HG Imaging Technology » 8 UltraChrome HG2 Pigment-

Based Inks » Advanced Media Handling & Disc Printing
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSPA40D)

Call or Log-On

EPSON Expression Photo XP-960

Small-In-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Res.: 5760 x 1440 dpi

» Max Print Size: 11 x 17"

» 6-Color Claria Photo HD Ink Set
» Print Speed: 8.5 ppm Black / 8 ppm Color

» Auto Duplex Printing & Copying » Scan Resolution: 4800dpi
» Max Scan Size: 8.5 x 11.7" » Memory Card Slot & USB Port
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPXP960) e 299.99

PHOTO PRINTERS

Canon imagePROGRAF PR0-1000
17” Professional Photographic Inkjet Printer
» Max Resolution: 2400 x 1200 dpi
» Max Print Size: 17 x 22"
» Speed: 17 x 22"
in 4 Min 10 Sec
» Borderless at up to 17" Wide
» FINE Printing Technology » L-COA PRO Image Pracessing Engine
» 12 LUCIA PRO Pigment-Based Inks » 3.0" Color LCD
» Canon PRINT App, PIXMA Cloud Link » USB 2.0, Ethernet, & Wi-Fi

(CAPP1000)....

1,299.99

Canon PIXMAiP7220

Wireless Color Photo Printer

» 9600 x 2400 Color dpi
» 15 ipm Black
10 ipm Color
» Borderless Photos
upto85x11”
» Wi-Fi & AirPrint
» Auto Double-Sided Printing
» CD & DVD Printing » Full HD Movie Print
(CAIP7220).....

84.99

EPSON' SureColor P600

Wireless Color Inkjet Printer

» Max Resolution: 5760 x 1440 dpi
» Max Printable Area: 13 x 129"

» Borderless Prints up to 13 x 19"
» Accepts Roll Media up to 13" Wide
» 9 UltraChrome HD Pigment-Based Inks
» Auto-Switching Black Ink Technology » Tilting 3.5" Color LCD

Touchscreen » Advanced Media Handling & Disc Printing
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSP0O).....

Call or Log-On

EPSON' Artisan 1430

Wireless Color Inkjet Printer

» 5760 x 1440 Optimized dpi
» 2.81S0 ppm Black
and Color » Borderless
Prints up to 13 x 19"
» Print from Mobile Device
» Wi-Fi » PictBridge
» Print Directly on CD & DVD
» Individual Ink Cartridges

(EPAT430) ... 349.99
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Canon

o

Toner for Laser Printers

Ink for InkJet Printers

Canon PIXMAiP2820
Inkjet Photo Printer \ ‘

» Color Print Resolution: —
4800 x 600 dpi

» §ipm Black &
4 ipm Color

» Printupto 8.5x 14" -‘_

» Can Print on US #10 Envelopes £

» Works with Plain and Glossy Paper » Quiet Mode

» 60-Sheet Automatic Document Feeder » USB Connection

(CAIP2820)

=

Canon PIXMAiP110
Mobile Inkjet Photo Printer

» Max Res: 9600 x 2400 dpi

» Max Print Size: 8.5x 23

» Print Speed: 9 ipm Black

5.8 ipm Color

» Borderless 4 x 6" Photo 53 Sec.
» Borderless Printing up to 8.5” Wide
» 50-page Auto Document Feeder

» USB 2.0 & Wi-Fi » Wireless PictBridge & Mabile Printing

(CAIPT10) [ 199.75

Canon PIXMAiX6820

Wireless Inkjet Printer

» Print Res.: 9600 x 2400 dpi
» Upto 13 x 19" Print Size
» Prints Borderless

4x 6" Photo in 36 sec
» 802.11 blg/n

Wi-Fi Connectivity » 150-Sheet Automatic Feeder
» 14.5 Black ipm & 10.4 Color ipm » 5-Color Ink System
» Auto Power On & Off Settings » Ethernet Port

(CAIX6820) [ 187.00

EPSON' PictureMate PM-400

Personal Photo Lab

» 5760 x 1440 dpi

» Print 4.0 x 6.0 Photo in 36 Seconds

» Print from Memory Cards al
» Borderless Prints ﬂ;f il 1
» 2.7" Color LCD Preview Display |

» Support for SD Cards .

» USB 2.0 and Wi-Fi Connectivity

» Capacity: 50 Sheets Plain Paper
(EPPM400) e 249.99

INK, TONER & CARTRIDGES

Ink for Large Format Printers

n B:H 800-947-5534 + 212-444-6740

To view a full listing of all
Ink, Toner & Cartridges

[=]:=

or visit our website
BandH.com/w15100




EPSON' SureColor P800

17” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Print Size: 17 x 22"

» Print Speed: 8 x 10" in 113 Sec.

» Borderless Printing up to 17" Wide
» Epson MicroPiezo AMC Print Head
» 9 UltraChrome HD Pigment-Based Inks

» Auto-Switching Black Ink Technology » Advanced B & W Made
» Opt. Adapter for 17 W Roll Media » USB 2.0, Ethernet, & Wi-Fi

(EPSCPO0SE)

EPSON' SureColor 75270
36” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 36

» Speed: 22 x 34" Plot in 5 Seconds
» Handles Media up to 59 mil Thick
» Holds Roll Media with 2" or 3" Cores
» 5-Color UltraChrome Pigment Ink Set
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT5270SR)

Designjet T120
24” Color Inkjet ePrinter

» Resolution: 1200 x 1200 dpi l

» Print Speed: 40 A1
Prints / Hour

» Ethernet, Wi-Fi
AirPrint, ePrint

» Print Sizes Up To 22x34” (D)

» Roll Printing Up To 24” Wide

» Compatible With Media up to 280gsm

(HET12024)

...999.00

Canon imagePROGRAF PR0-2000
24” Prof. Photo Large-Format Inkjet Printer

» Max Printable Width: 24

» Max Resolution: 2400 x 1200 dpi
» FINE Print Head Technology

» L-COA PRO High-Speed Engine

» 12 LUCIA PRO Inks; No Black Switching
» Sub-Ink Tank System; 32068 Hard Drive
» 35" LCD Touchscreen; USB Direct Print
» USB, Ethernet, & Wi-Fi Connectivity
(CAPP2000)

Canon imagePROGRAF iPF6400SE
24” Large Format Inkjet Printer

» Resolution: 2,400 x 1,200 dpi

» LUCIA EX 6-Color Ink System

» Holds 2 & 3" Rolls with 5.9" Dia.

» Maximum Print Size: 24" x 59°

» Supports Media up to 31.4 mil Thick
» Variety of Borderless Printing Options
» Replace Ink without Interrupting Print » Internal Memory: 266MB
» USB 2.0 & Ethernet Interfaces » Printer Stand & Media Basket
(CAIPF8400SE)

www.BandH.com

LARGE FORMAT PRINTERS

EPSON' SureColor P6000
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 24"

» Print Speed: 16 x 20" from 2:02
» PrecisionCore TFP Print Head

» PrecisionDot Screening Technology
» 9 UltraChrome HD Ink Set

» Auto-Switching Black Ink Technology |
» 2.7" Color LCD Screen; Built-In Cutter USB 2.0 and Ethernet

(EPSCP600OSE]........ 2,495.00

EPSON' SureColor T3270
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 24"

» Speed: 22 x 34" Plot in 28 Seconds
» Handles Media up to 59 mil Thick

» Holds Roll Media with 2" or 3" Cores
» b-Color UltraChrome Pigment Ink Set
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT3270SR)....... 2,795.00

Designjet T520

24” Color Inkjet ePrinter —

» Print Resolution: 1200dpi
» Print Speed: 275 Sq. Feet/Hour
» Ethernet & Wi-Fi Connectivity
» Qutput 24.0” Wide Sheets & Rolls
» Roll Feed With Automatic Cutter
» Print On Heavy Media Up
To 280gsm
» Internal Memory: 16B
(HETB2024) ..o

_Call or Log-On

Canon imagePROGRAF PR0-1000

17” Professional Photographic Inkjet Printer

» Resolution: 2400 x 1200 dpi

» Max Print Size: 17 x 22" (Sheet)

» Borderless Printing at
up to 17" Wide

» FINE Printing Technology

» L-COA PRO Image Processing Engine » 12 LUCIA PRO Pigment-
Based Inks » Grayscale Phato Printing; 3.0" Color LCD
» Canon PRINT App, PIXMA Cloud Link » USB, Ethernet, & Wi-Fi

1,299.99

(CAPP100D)............

Canon imagePROGRAF iPF780

36” Large Format Printer

» Max Res: 2400 x 1200 dpi

» Max Print Size: 36" x 59’

» Speed: 24 x 36" Draw in 21 sec

» Five-Color Dye / Pigment
Reactive Ink Set

» Sub-Ink Tank System

» Economy Print Mode » Optimized Module for AutoCAD

» PosterArtist Lite Software » USB 2.0 and Ethernet Connectivity

(CAIPF780)............. 3,820.75

COMPUTERS

EPSON' SureColor P7000 Standard Edition
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 24

» Print Speed: 16 x 20" from 2:02

» PrecisionCore TFP Print Head

» PrecisionDot Screening Technology
» 11 UltraChrome HDX Inks with LL Black
» Auto-Switching Black Ink Technology

» 2.7" Color LCD Screen; Built-In Cutter » USB 2.0 and Ethernet

(EPSCP7000SE)

EPSON' SureColor P5000 Standard Edition
17” Wide-Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 17"
(Borderfree) » PrecisionCore TFP
Print Head Technology

» Precision Dot Screening Tech

» 11 UltraChrome HDX Pigment Inks with LLK » Auto-Switching
Black Ink Technology » Auto-Switching Roll Feed & Front Tray
» 2.7" LCD Screen; Auto Cutter » USB 2.0 and Ethernet Connectivity

(EPSCP5000SE)

Designjet 25200
44” PostScript Printer

-

» Automatic Calibration &
Media Profiling

» Batch Print Files W/o
Loading Programs

» Save Print Jobs For Easy
Reprinting

» Large 300 ml Cartridges » Track Jobs By Customer, Cost, or Job

» Consistent & Accurate Color » Built-In PostScript Support

(HEZ5200) oo Call o Log-On

Canon imagePROGRAF PRO-4000

44” Professional Photo Large-Format Inkjet

» Print Resolution: 2400x1200dpi

» Max Printable Width: 44"

» FINE Print Head Technology

» L-COA PRO High-Speed
Processing Engine » Color
Densitometer for Calibration

» 12 LUCIA PRO Inks; No Black Switching » Sub-Ink Tank System;
32068 Hard Drive » USB 2.0, Ethernet, & Wi-Fi Connectivity

[CAPPADOO) ... 4,495.00
Canon imagePROGRAF iPF670E

24” Large Format Printer

» Resolution: 2400 x 1200 dpi sl (¥

» Max Printable Width: 24" | - |
» High-Density Print Head
Technology » 5-Color Dye
Pigment Reactive Ink Set
» Sub-Ink Tank System; Economy Print Mode » MS Office Plug-In
& AutoCAD Module » PosterArtist Lite Software » USB 2.0 and
Ethernet Connectivity » Complete 90mL Ink Cartridge Set Incl.
[CAIPF670F) ...949.00




COMPUTERS

— Introduction to Inkjet Paper —

Surface Finishes

Glossy
Instantly recognizable by its reflective, smooth appearance, a
glossy finish is most commanly thought of as the go-to paper for
printing photographs. This is due to the paper's
i ability to display deep blacks with saturated,
vibrant colors that make images pop. The
coatings used on these kinds of papers
also provide a water resistant guality that
can make sure your prints will last for a
years after your make them. Along with these
benefits, glossy papers generally provide a sharp, crisp image that
will benefit photographs and graphics with fine details.

PAPER AND INKJET MEDIA

Matte
On the oppasite end of the spectrum from glossy, matte papers
offer an appearance that more closely resembles that of traditional
art papers. Many matte papers feature a textured
appearance that can add another layer of
artistry to your final print. The texture can be
subtle or extremely obvious, as in the case
of mould-made cotton-based papers, which
allows users to choose the ideal surface for
presenting their work. Additionally, the matte
surface is less susceptible to showing fingerprints and marks during
handling, making it a somewhat easier paper type to work with.

Luster
Known by names such as satin, semi-matte/gloss, silk, pearl,
and more; Luster offers a surface in-between glossy and matte,
usually with a fine tooth and texture, and a slight
reflective quality. This type of surface gives
f the paper an excellent range from white to
black, outstanding color reproduction, and,
depending on the specific paper, the tooth
or texture to further accentuate your art's
content. Luster balances the benefits of both
glossy and matte papers, and as is a very popular
option for many professional printers.

Basic Information & Specifications

Weight & Thickness

When looking for paper, basis weight and thickness are related
specifications that tie into a paper’s overall feel and quality.
Weight refers to the heft of a paper and demonstrates a paper’s
feel and strength over time. It is important to know as not all
printers can accept thick fine art paper.

Materials and Coatings

The material the paper is made of, which could be: wood fiber,
canvas, cotton rag, vinyl, rice, bamboo, or athers, plays a large part in
how the printed images will look, due to how it holds the ink and the
physical characteristics of each. These coatings can have their own
effect on the print as well, giving each combination a unique look.

Brightness, Whiteness, & Tone

These specifications indicate the overall appearance of a paper;

each characteristic will have a significant effect on print quality. The
brightest part of your image is limited by the brightness of the paper
itself, while the overall color and tone is determined by the whiteness,
which is usually listed as a warm (natural), neutral, or cool color.

Other Considerations

Opacity

Important for display purposes, opacity tells users how transparent
a sheet of paper or banner material is. This plays a role in deciding
what types of material are best suited to your specific application.

Roll / Sheets

Many papers are found in both sheets and rolls, with each offering
its own benefits. Rolls allow for long panoramas and work wonder-
fully with large format printers for high volume printing. Sheets, on
the other hand, offer convenience for smaller formats.

Single / Double-Sided

Due to the necessity of coatings on modern papers, most are not
coated on both sides in order to save on costs. If you require double-
sided printing for a book or other application, you will need to make
sure your selected paper is optimized for two-sided printing.

To view a full listing of
all Inkjet Media & Paper

Fine Art Designed for archival purposes
and display, so-called fine art paper offers
classic materials and coatings that will
lend their own quality to the print. This can
include prints of artwork, photos, or even
important documents that require the utmost
in quality and preservation.

Canvas While not a paper, per se,
canvas offers a well-known aesthetic. It
lends a sense of gravitas to your prints
and the ability to display your artwork in
a more creative fashion. Also, recently

developed coatings, such as metallic, are

breathing new life into this classic art surface.

ICC Profiles

SCAN Q2!

B&H’s Excellent Selection

Brands

Epsan, Canon, Itford, Hahnemuhle, and more can be found at B&H,
with each brand offering their own unique paper styles, materials, and
technologies. Check back often to find the latest brands & papers.

Selection

Canvas, metallic, cotton rag, vinyl, and more are among the papers
types you'll find at B&H. With practically any type of paper for
nearly any situation, and more and more varieties being added all
the time, we have a vast selection of papers to suit your needs.

Sizes

Find everything from your standard 4 x 6" phato paper to large 72"
wide rolls for epic panoramas. Available in sheets and rolls, you
can be assured that no matter how large or small your project is
you will be able to get the paper you need at B&H.

or visit our website
BandH.com/w15103

USES

Photo Prints Astaple of modern

inkjet printing, photographs are perhaps the

most popular reason people will print at

home, and as such, photographic paper is

¥ one of the widest paper selections there is.
This includes the vast array of standard glossy

paper most people are accustomed to, as well as
heavyweight textured papers suitable for gallery exhibitions.

/m\ Office Found in practically every
workspace and home, office printing paper

£ is optimized for documents, both large and

small. [tis generally lightweight, bright

white, and has a coating designed to handle
¥ the speedy inkjet printers available today.

Specialty Users with very specific
purposes and applications require uncommon
styles and types of printing materials to
accomplish their goals. Luckily, B&H carries
" many unique options such s clear film,
adhesive vinyl, rice paper, and more that will
assist you in getting your job done.

Adhesive Vinyl

Proofing Making sample prints no longer has to cost an arm
T ~ and a leg with the availability of many different
proofing papers on the market today. This

lightweight paper type offers surfaces that

) are similar to higher-end papers, in order to

/- provide a comparably less expensive option
/ to see how a final print will turn out.

Carolina thar
C1S 18 Point

Even with the best paper in the world, digital printing still relies heavily on computing to turn your digital images and graphics into physical prints. This is where ICC profiles come in
handy. Many manufacturers offer profiles to download alongside their different papers that will help tell the printer how to manipulate the ink and colors, so that you will have a final print

that looks as close as possible to the screen that you are viewing it on. These are optimized for specific printer and paper combinations to ensure you get the best print possible.

(“'“'-"’)
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FA\ Adobe Photoshop Lightroom 6
DVD

An updated version of the comprehensive photo
management tool, Phatoshop Lightroom 6 now includes
dedicated HOR and Panorama Merge modes, Facial

Recognition for quickly finding people in your images,
Advanced Video Slideshows, HTML5-compatible web |
galleries, and a new Filter Brush for working with

IMAGING SOFTWARE [azleagelcizy\1, )4

I\ Adobe Creative Cloud Photography Plan
12 Month Subscription, Download Card

Comprising two esteemed editing and image management
tools, the CC Photography Plan is a one-year subscription
to both Photoshop and Lightroom CC. Continuous feature
upgrades are provided as well as connected access to
Lightroom Mobile and Photoshop Mix for on-the-go
editing and real-time syncing across all devices.

Graduated and Radial filters.

DVD (ADPSLe)
Download (ADPSLRAESD)

F\\ Adobe Photoshop Elements 15
DVD

New Touch Support

New Adjust Facial Features
New Photo Text Guided Edit
New Effects Collage Guided Edit
New Painterly Guided Edit

New Frame Creator Guided Edit
New Speed Pan Guided Edit

(ADPET5MW) 84.95
Photoshop & Premiere Elements 15 (ADPPET5MW) 124.99

[D><O O0pticsPro 11
DVD

Smart Lighting and Spot Corrections
PRIME 2016 Denoising Technology
Optical Corrections, Lens Softness Tool
ClearView Haze Reduction
Customizable Image Presets
Anti-Moiré and Red-Eye Correction

For Mac and Windows

Essential Edition (DX011ESSNTL)
Elite Edition (DXO11ELITE)

CDLEoft Photomatix Pro 6.0

Download

High Dynamic Range Image Processing
Bracketed Exposure Compositing

Tone Balancer HDR Rendering
Interactive Brush Tool, Blending Modes
Straightening and Perspective Controls

Preset and Customizable Qutput Styles — rr=em sy e
Standalone App, Plug-In for Lightroom phm““mﬁ
MAC/WIN (HDPMP6WM) 99.00
Photomatix Pro 4.0 Download (HDPME4WM) 39.00

Capture NX 2

Nikon. photo Editing Software

U Point Technology

Selection Control Points
Auto-Retouch Brush
Shadow/Highlight Adjustment
Supports RAW (NEF) Files
Integrates with All Nikon Software
Redesigned Interface

149.95

[NICNX2FV)

142.99
142.99

COREL PaintShop Pro X9 Ultimate
DVD
Photo Management and Editing Software
Non-Destructive Layer-Based Editing
Camera RAW Lab
HDR and Lens Correction Tools
Scripting Engine and XMP Support
Support for 3rd-Party Plug-Ins & Brushes
Discovery and Learning Center Tutorials

(COSPXIENMBAM) 79.99
PaintShop Pro X9 (COPSPXIENMBA) 70.99

D><0O ViewPoint 3
DVD
Perspective Distortion Correction
Automated and Manual Adjustments
Miniature Mode for Tilt Effects
Horizon Straightening
Optical Distortion Corrections
Enhanced Anchor Point Control
Use as Standalone or as a Plug-In
Mac and Windows

(DXVP3) 79.00

Photo Creator Kit
- Digital Photography Kit
Enhances Your Digital Photography
Uses Green Screen Technology =3

Photo Creator

720 Digital Backgrounds
Places Your Subject i' o - ? ih-""‘- '
in any Background B SR !

il

Wide Choice of Themed Locales
Changes Backgrounds Effortlessly
Easy to Use Includes Green Screen Cloth/Software

(SADBSK100) 63.95

CyberLink, PhotoDirector 8 Ultra

Photo Editing Software

Exrnr e,
Intuitive and Versatile, Easy-to-Use = q
Layers-Based Editing Interface
New Express Layer Templates
New Video-to-Photo Editing
New Create Multi-Exposure Images
New Overlays, Color Splash, and More pry'c'ﬁODi"edo"

-y

Local and Global Retouching Tools
256B CyberLink Cloud Service for 1 Year

DVD (CYPDBULTRA) 74.99

12 Month Subscription, Download Card (ADCCPP12)
Student & Teacher Edition (ADCCPP12MSTE)

119.88

I Pro Photo

Optimization Software

Reduce Phato File Sizes Up to 80%
Maintain Image Quality and Resolution
Utilizes ALl Computer Cores

Supports JPEG Files Up To 50 MP

For Windows and Mac

Plug-in for Lightroom Included

[JPMINIPRORT) 99.00
Photo Optimization Software (JPJPEGMINIRT) 29.99

PHASE ONE Capture OnePro 10

Download

Image Processing and Raw File Conversion
Instant Tethered Capture and Live View
Catalogs and Sessions, EIP Export
Three-Phase Sharpening Tools

Halo Suppression and Output Proofing
Rewritten for Fast & Stable Performance
Keyword Tool, Sortable Keyword Libraries
Over 400 Cameras & Raw Files Supported

299.00

[PHC1PRO10)

Photographers Photoshop
Photoshop Lightroom
Cinematic Presets

Suite of 70 One-Click Presets

Creatively Refine the Look of Phatos

Adjust Presets, Grain &

Vignette Add-Ons

Includes Movie Tutorial

For Mac/Windows,

Lightroom 4,5, 6, CC

[PHLCP) 39.95

MATT KLOSKOWSKI PHOTOGRAPHY
Lightroom Presets
for Landscape Photography
QOver 100 Presets and 700 Combinations
One-Click Presets and Custom Brushes
Graduated Sky Filters
More Than 100 Workflow Presets
Print Templates
For Lightroom CC, 6, 5, 4
on Mac/Windows

p ...--5*-—

LIGHTROOM

Download (MATPRO1) 49.00




dalegelcl . M@ GRAPHIC TABLETS AND DIGITAL PENS

WaCOM' Bamboo
Smartpads
Digitize your Notes and Drawings
Enhance, Color, and Edit Content
Export in Multiple File Formats
Sync to Cloud Services
Wacom Inkspace App Compatible

Slate Small (WACDS610S) 129.95
Folio Large (WACDS8106) 199.95

WJCOIM' Cintiq 27 QHD

27" Pen & Touch Display

23.5%13.2" Active Area
2,048 Levels of Pressure Sensitivity
97% Adobe RGB, 1.07 Billion Colors

330 cd/m? Brightness Mac & Windows
Cintiq 27 QHD Touch (WAC270HDT).........2,399.95
Cintiq 27 QHD (WAC270HD) 1,899.95

WaCOM' CintigPro

Creative Pen & Touch Display

USB Interface
8192 Levels of Pen Pressure Sensitivity

IPS Touchscreen

96% Adobe RGB Built-In Stand

A

WAICOM' Intuos
Creative Pen Series
6.0x3.7" Active Area
4 Programmable ExpressKeys
Mac & Windows Compatible

-
-

Draw - Mint Blue (WAIDPSTBL) 79.95
Draw - White (WAIDPSTW) 79.95
Phato - Black (WAIPPTSBK) 99.95
Comic - Black (WAICPTSBK) 99.95
Comic - Mint Blue (WAICPTSBL) 99.95

WACOM' Cintig 22HD

22" Pen Display

2,048 Levels of Pressure Sensitivity
USB/ DVI- Connectivity  » 230 cdm? Brightness
16-User Assignable ExpressKeys

(WAC22) 1,699.95

WaACOM' Cintiq 13HD

13.3" Pen & Touch Display

11.8x6.8" Active Area
2048 Levels of Pressure Sensitivity
76% Adobe RGB, 16.7 Million Colors

WaACOM’ Intuos Pro

Creative Pen Tablets

1,024 Levels of Pressure Sensitivity
Pressure-Sensitive, Battery-Free Pen

USB Interface
Painter Essentials

-

Art Small- Black (WAIAPTSBK) 99.95
Art Small - Mint Blue (WAIAPTSBL) 99.95
Art Medium- Black (WAIAPTTMBK) 199.95

Art Medium - Mint Blue (WAIAPTTMBL) 199.95
3D Pen & Touch Digitally Sculpt and
Paint 30 Models (WACTH690TK) 199.95

WACOM' MobileStudio Pro
Graphics Tablets

Stylus with 8192 Levels of Pressure
Built-In Hotkeys for Convenience

Intel Core i7 CPU 166B RAM + SSD
802.11ac Wi-Fi & Bluetooth 4.1

USB Type-C / SDXC Media Card Reader
Built-In Intel 3D Camera and Speakers
Windows 10 Pro

MobileStudio Pro 13
13.3" WQHD 2560 x 1440 1PS Display
Integrated Intel Iris Graphics 550

128GB (WADTHW1320L) 1,799.95
25668 (WADTHW1320L) 1,799.95
5126B (WADTHW1320L) 1,799.95

WACOM' Bamboo Slate

Smartpad

Digitize your Notes and Drawings
Enhance, Color, and Edit Content
Export in Multiple File Formats

25668 (WAW1620M)
512GaB (WAW1620H)

With the Wacom Pro Pen 2, you can sketch
with up to 8192 levels of pressure sensitivity

8 Express

Keys

USB &

Bluetooth

Touch

Ring

amm——

Medium (8.82 X 5.83") (WAIPM) 349.95
Large (12.24 X 8.57) (WAIPL) 499.95
Paper Edition with Pro Pen 2 & Finetip Pen
Medium (8.82 X 5.83") (WAIPMP) 399.95
Large (12.24 X 8.57) (WAIPLP) 549.95

MobileStudio Pro 16
15.6" UHD 3840 x 2160 IPS Display
NVIDIA Quadro M1000M 4GB GDDRS

2,399.95
2,999.95

ADESSI CyberTablet T12

=W 10x6" Graphic Tablet

2048 Levels of Pressure Sensitivity
8 Programmable Hotkeys

16.7 Million Colors Supported 250 cd/m? Brightness 178° Viewing Angle Sync to Cloud Services USB Interface Bundled Software
13.3 (WADTHWI320K0) 999,95 Programmable ExpressKeys & Touch Strips Small (WACDS610S) 129.95 Windows and Mac Compatible
16" (WADTH1620K0) 1,499.95 (WAC13) 799.95 Large (WACDS6105) 149.95 T1210x6" (ADCYBRTT12) 79.69
WJICOM' Classic Pen WJICOM' ProPen WaCOM' ArtPen Mg IRISNotes 3
for Intuos4/5 for Intuos & Cintig for Intuos4/5 smeeconeee Digital Pen

Slim, Classic Look 8192 Levels of Pressure Sensitivity Unique 360 Degree Captures Handwritten Notes & Graphs

with a Natural Feel Compatible with Intuas Pro, Rotation Sensitivity Converts Notes into Editable Text

Draw, Erase, and Cintig Pro& MobileStudio Pro Chisel and Bullet Tipped Nibs Recognizes 30 Languages

Mouse Functions Color Identification Rings Pressure / Tilt Stores up to 100 A4/

Pressure and Carrying Case Sensitivity Letter Size Pages

Tilt Sensitivities Spare Nibs Replacement Nibs Learns Your

Weighted Stand Digital Eraser Handwriting

Extra Nibs (WAKP504E) 74.23 Nib Extractor

Pro Pen (WAPPCC) 77.50

(WAICP) 61.99 Finetip Pen for Intuos Pro (WAKP132000) ... 79.95 (WAIAMP) 84.00 (IR457489) 119.95
Inking Pen for Intuosé (WAIIP) 67.99 Ballpoint Pen for Intuos Pro (WAKP133000) 83.39 Airbrush Pen with Stand (WAIAP) 97.95 Notes 2 Executive (IR457489) 119.95
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CF COMPACT FLASH

XQD HIGH-SPEED

SDXC UHS-1

SDHC UHS-1

microSDHC UHS-1

MEMORY CARDS [d leafelci 7.\ ;)4

LEXAR SANDISK
500x 1050x 1066x Ultra 50MBs Extreme 120MBs Extreme Pro 160MBs 400x
1668 (DECF500X166B) _ (LECF1066X166) (SAUCF166B0) (SAECF166B0) (SAEPCF166B0) (TRCF400X166)
2.9 31.00 16.90 27.95 Callor Log-0n 26.99
3268 (DECF500X326B) (DECF1050X326) (LECF1066X326) (SAUCF326B0) (SAECF326B0) (SAEPCF326B0) (TRCF400X326)
38.95 26.10 3.47 95 .
64GB (DECF500X646B) (DECF1050X646) _ _ (SAECF646BQ) (SAEPCF64GB0) (TRCF400X646)
56.95 84.95 4495 Callor Log-0n 56.99
12068 B (DECF1050X128) (LECFI066X178) _ (SAECF126680) (SAEPCF128680) -
119.95 109.95 84.95 Callor Log-0n
25668 (DECF1050X25¢) (LECFI06656) (SAEPCFI5666)
- 194.95 244,95 - - 296.95
)
w
]
o
n
SONY T
2933x G Series q 3400x 3600x
2933 with Reader Version 2 M Series o CFAST2.0 CFAST
3268 (LEXQD2933X32) (LEXQD293332R) (SOXQD32GBGE) (S0XQDM32) T 4GB (LEC3500X64GB) _
74.95 8495 64.95 49.95 - 199.95
64GB (LEXQD2933X64) (LEXQD293364R) (S0XQD64GBGE) (SOXQDMé4) (7] 12868 (LEC3500X1286) (LEC3600X128)
97.95 109.99 108.49 77,50 < 138.95 364.95
12868 (LEXQD2933X12) (LEXQD293312R) (S0XQD128GBGE) (S0xQDM128J) LL 25668 (LEC3500X2566) (LEC3600X256)
156.50 159.95 169.95 126.99 o 579.95 67495
\ u =
KINGSTON LEXAR PNY TECH. SANDISK
SD10VG2  SDA10 300x SDA3 Platinum Il Professional . Ultra Extreme  Extreme Pro
266 63XW3)  acc10 Class10 Classi0(ud)  300x  e3x(u3)  EUtePert goMpe  ooMBs(U3)  95MBs
6468 (DESDC1064GB) ' (DESD633X64GB) | (KISD10VG2646)  (KISDUG4GBUT) | (KISD64GBU3) | (LESD300X64GB) (LESD633X64GU)  (PNSD64GBU3) | (SAUSD64GBA) | (SAESD64GBV3G) (SAEPSD64GVG)
795 45 %95 3095 3495 B4 2600 34.99 %95 095 349 o~
12868 (DESD266X1286) (DESD433X128G)  (KISD10VG2128)  (KISD1286BUT) | (KISD128GBU3) ' (LESD300X1286) (LESD433X128U) (PNSD128GBU3) | (SAUSD128GBD) (SAESD128GBV3) (SAEPSD1286V3) (9p]
7995 799 4895 595 65 4% 549 999 426 5995 6695 T
25668 (DESD266X2566) | (DESD633X2566) _ _ (KISD2566BU3) _ (LESD633X2566) | (PNSDZ566BU3) _ (SAESD256GBV3) | (SAEPSD2566V3) >
16995 169.95 14328 10995 12995 1695 12950 <>.<>
51268 _ (DESD633X5126) _ (KISDA1051268B) _ _ (LESD633X512) | (PNSD5126BU3) _ _ (SAEPSDB126V3) (o)
349.95 759.95 21995 26295 310.49 a

86B

LEXAR

DELKIN KINGSTON
SD10VG2 SDA10300x Platinum Il Prof. 633x
163 63U Tiast0 Class10 300x  (U1)2-Pack
(DESDC108GB) | (DESD633X8GB)
8.95 - - - -

1668 (DESDC1016GB) (DESD833X16GB) (KISD10VG2146) (KISDU16GBU1) | (LESD300X1660) (LESD633X16UT)

11.95 25.95 9.95 7.95 16.95

3268 (DESDC10326B) (DESD633X326B) (KISD10V62326)  (KISDU32GBU1) |(LESD300X326B) (LESD633X32U1)

86B
166B
326B

19.95 28.95 14.95 18.00 13.95 29.95

i \»ﬂ e WP
a 14
DELKIN  KINGSTON LEXAR
Gen 2 Platinum I 633x
IS MobilityKit 300 with Adapter | 08554
_ ~ ~ _ (SAMSDBGBA
6.95
(DEMSD500166B) (KIMK1662) (LEMSD300X16B) (LEMSDA33X16A) (SAMSD16GBA)
10.95 1.9 9.95 ] .
(DEMSD500326B) (KIMK3262) (LEMSD300X32B) = (LEMSD633X32A) (SAMSD32GBA)
19.95 16.95 14.95 17.95 11.20

perify
TRANSCEND o~
Class 4 Ultra Extreme
15MBs  8OMBs 9OMBs(U3)  SDOX AL %
(TRSD300X86B) ' (TRSDBGBU1)
- - - 6.99 7.99 -
_ (SAUSD16GBA) (SAESD16GBC) | (TRSD300X16GB) (TRSD16GBU1) (&)
] 11.99 899 13.99 T
(SASD32GBB) (SAUSD32GBA) (SAESD326BV3G) (TRSD300X326B) (TRSD32GBU1) (=]
1195 1399 18.99 1699 Log-On n
L ;
g0 W, !
w wn o
& T “
SANDISK TRANSCEND 8
Extreme
Uttra - opms (u3) ""“" E
(TRMSD8GBU1)
_ o Q beB
(SAUMSD1668) © 1268
9 - - %)
(SAUMSD3268B) (SAEMSD32v306) ~ (TRMSD326BU1) =
13.95 18.95 15.99 £ 20068

TRANSCEND
800x 1000x
_ (TRCF1000X166)
35.99
(TRCFB00X326B) (TRCF1000X326)
30.99 51.99
(TRCFBO0X64GB) (TRCF1000X646)
56.99 87.99
(TRCFB00X1286)
110.99 B
(TRCFB00X2566)
231.99 B
e 20 2
128« i
/
SANDISK TRANSCEND
Extreme Pro CFAST 2.0 CFX650
Canon & BlackMagic CFAST 2.0
(SAEPC64GBD)

199.95 -
(SAEPC128GBD) (TRCFX6501286)
349.95 259.95
(SAEPC2566BB) (TRCFX8502566)
679.99 477.50

LEXAR SANDISK

2000x (U3)  Extreme Pro
with Reader  300MBs (U3)

(LESD1000X64G) (LESD2000X64G) | (SAEPSDUG4GBR)

1000x

646B

0895 9.8 119.95
12868 (LESD1000X128) (LESD2000X128)  (SAEPSDU128GA)
995 21995 249.99
(LESD1000X256)
25668 179 0p - -

326B

326B
2-Pack

AT [ §

KINGSTON

Gen 2
Mobility Kit
(KID64GBMMK)

29.95

LEXAR SANDISK
2000x Extreme Pro
1000¢ yith Reader  300MBs (U3)
(LESD1000X326) (LESD2000X326) (SAEPSDU32GBR)
27.50 54.95 59.95
(LESD1000X32P) -~ _
53.70

LEXAR SANDISK ~ TRANSCEND

633x
with Adapter Ultra 400x
(LEMSD633X64A) | (SAUMSD64GB) | (TRMSD64GBUT)

27.95 25.10 31.99
(LEMSD633128A) | (SAUMSD12868B) | (TRMSD1286BU1)

54, 49.95 73.99

(SAMSDU20068)
B 81.95 B
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Canon PowerShot 69 X Mark I
Digital Camera
20.1MP 1" High-Sensitivity CMOS Sensor
DIGIC 7 Image Pracessor
3x Optical Zoom f/2-4.9 Lens
28-84mm (35mm Equivalent)
3.0" 1.04m-Dot Touchscreen LCD Monitor
Full HD 1080p Video Recording at 60 fps
Built-In Wi-Fi with NFC and Bluetooth
Extended 1S0 12800 and 8.2 fps Shooting
Dynamic IS and Time-Lapse Video Function

Canon PowerShot 67 X Mark Il
Digital Camera
20.TMP 1" CMOS Sensor
DIGIC 7 Image Processor
4.2x Optical Zoom f/1.8-2.8 Lens
24-100mm (35mm Equivalent)
3.0 1.04m-Dot Tilting LCD Touchscreen
Full HD 1080p Video Recording at 60 fps
Built-In Wi-Fi with NFC
Expanded IS0 25600, Up to 8 fps Shooting
Intelligent IS Image Stabilization

Manual Control Ring, Time Lapse Movie In-Camera Raw Conversion, Picture Style
(CAPSG7X28) 699.00 Black (CAPSG9X28) ................529.00  Silver (CAPSG9X2S)... ... 529.00
Canon PowerShot 65 X Canon PowerShot 63 X Canon PowerShot 61X Markll

Canon

Canon

20.2MP 1" High-Sensitivity CMOS Sensor 20.2MP 1" High-Sensitivity CMOS Sensor 12.8MP High-Sensitivity 1.5" CMOS Sensor
4.2x Optical Zoom f/1.8-2.8 Lens, 24-100mm (35mm Equivalent) 25x Optical Zoom f/2.8-5.6 1S Lens, 24-600mm (35mm Equivalent) DIGIC 6 Image Processor
2.36m-Dot Electronic Viewfinder 3.2" 1.62M-Dot Tilting Touchscreen LCD bx Optical Zoom Lens, 24-120mm f/2-3.9 (35mm Equivalent)
3.0" 1.04m-Dot Multi-Angle Touchscreen High-Speed AF with 31 Focus Points 3.0" 1,040k-Dot Tilting Touchscreen LCD
(CAPSBEX) . 199.00 (CAPSB3K) . 999.00 [CAPSGIXZ) e 19900

Canon PowerShotSX730HS  Camnon PowerShot SX420 IS Canon PowerShotSX540HS  CamoO1n PowerShot SX530 HS

20.3MP 1/2.3" CMOS Sensor 20.0MP 1.2.3" CCD Image Sensor 20.3MP 1/2.3" CMOS Image Sensor 16MP 1/2.3" High-Sensitivity CMOS Sensor
DIGIC 6 Image Processor 3.0 Tilting LCD DIGIC 4+ Image Processor DIGIC 6 Image Processor DIGIC 4+ Image Processor
40x Zoom Lens, 24-960mm (35mm Equivalent) 42x Optical Zoom Lens 50x Optical Zoom Lens 50x Optical Zoom Lens
Full HD 1080p Video Recording at 60 fps 24-1008mm (35mm Equivalent) 24-1200mm (35mm Equivalent) 24-1200mm (35mm Equivalent)
(CAPSSX730HSB) 399.00 (CAPSSX4201SB) 299.00 [CAPSSX540HS) 349.95 (CAPSSX530HS) 379.00
Canon Canon
PowerShot SX620 HS

PowerShot ELPH 360 HS

LA-DC58L
20.2MP 1/2.3" CMOS Sensor NB-4L e i 20.2MP 1/2.3" CMOS Image Sensor
25x Optical Zoom Lens [25-625mm) PSC-3300 Lithium-lon Lens Adapter High-Pawer DIGIC 4+ Image Processor
DIGIC 4+ Image Processor Deluxe Soft Case Battery Pack 31.20 Wirelss Flash 12x Optical Zoom Lens
. . 48.24 -
3.0" 922k-Dot LCD Monitor 15.99 129.00 25-300mm (35mm Equivalent)
(CAPSSX620HSR) ...ooooooooo. 279.00 (CAPSE360HSP) ... 209.00
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Canon Canon FUJIFILM X100F FUJIFILM FinePix XP120
PowerShot ELPH 190 IS PowerShot ELPH 180 IS

24.3MP APS-C X-Trans CMOS Il Sensor 16.4MP 1/2.3" BSI-CMOS Sensor

20.0MP 1/2.3" CCD Image Sensor 20.0MP 1/2.3" CCD Image Sensor Fujinon 23mm /2 Lens 5x Optical Zoom (28-140mm]
DIGIC 4+ Image Processor DIGIC 4+ Image Processor Hybrid Optical and Electronic Viewfinder Waltlef, Shock, Freeze, and Dustproof
10x Optical Zoom Lens 8x Optical Zoom Lens 3.0" 1.04m-Dot LCD Monitor 3.0" 920k-Dot LCD Monitor
24-240mm (35mm Equivalent] 24-224mm (35mm Equivalent) Parallax-Correct Electronic Rangefinder Built-In Wi-Fi Connectivity
(CAPSE190ISBL) ..o 159.00 (CAPSET80R) 119.00 [FUX100FS) 1,299.00 Yellow (FUFPXP120Y) 199.00
Kodak Kodak
PIXPRO FZ43 PIXPRO FZ53 Google Clips
) Capture and store photos and clips of
= 2 moments with your friends and family automatically. With machine
learning built in, Google Clips recognizes and saves your best mo-

ments. A ‘clip'is a short, looping motion photo that is several seconds
long. Google Clips can use any frame from that video and save it as a
high-resolution still image. Your clips and images can be fast trans-
ferred wirelessly from Google Clips' 16 GB internal memory to your

16.15MP 1/2.3" CCD Sensor 16.15MP 1/2.3" CCD Sensor smartphone. Swipe to save and share clips and stills on Google Photos.
4x Optical Zoom Lens 5 Optical Zoom Lens Extract Still Images from Clips  Built-In Machine Learning  Includes Clip Stand
27-108mm (35mm Equivalent) 28-140mm (35mm Equivalent) Auto-Enhanced Stills  Fast Transfer to your Phone
2.7" 230k-Dot LCD Monitor 2.7" 230k-Dot LCD Monitor Live Preview  Easily Store and Share with Google Photos ~ (60CLIPS).......cc.ccc... 249.00
(KOFZ43BK).oo oo 65,00 (KOFZ53BK).oo oo 79,00
For all Canon Point &

Shoot accessories

. BT Canon NB-9L
i cgmg " NP9 Ricoh GH-3 Lithium-lon Battery . El%
Lithium-lon or visit BandH.com/w15118
l_E - Battery Pack Hood & Adapter Pack (3.5V)
i 29.33 for Ricoh GR 39.95 For all Fujifitm Point & ;o
49.65 Shoot accessories Feo

or visit BandH.com/w15119 %

Ricoh GV-2
- Mini External For all Ricoh Point & et
Fujifitm RR-90 Viewfinder Shoot accessories .I-E] 5
Remote Release
38,99 249.95 . -E-\a
- or visit BandH.com/w15124
RICOH GRIl RICOH Theta$ RICOH ThetaSC RICOH ThetaV
Spherical Digital Camera Spherical Digital Camera 360 4K Spherical VR Camera
Record 360° Spherical Photos/Videos Record 360° Spherical Photos/Videos Capture Immersive 360° Content & Audio

2x 12MP 1/2.3" Sensors, 2x 12MP 1/2.3" Sensors, 360° 4K Videos and 12MP Photos
14.4MP Output 14.4MP Output 360 Live Streaming in 4K —7
Twin Lens System, Twin Lens System, Built-In 4-Channel Microphone

16.2MP APS-C CMOS Sensor f/2 Maximum Aperture /2 Maximum Aperture . Dual 12MP Sensors and

No Optical Low-Pass Filter Full HD 1080p Video Recording Full HD 1080p Video Twin-Lens System

GR ENGINE V Image Processor at 30 fps Recording at 30 fps 196B of Internal Memory

Ricoh GR 28mm f/2.8 Fixed Lens Live Streaming via USB or HOMI Interval Shooting and . THETA i0S/Android App

3.0" LCD Screen » Built-In Wi-Fi with NFC Built-In Wi-Fi Self-Timer Setting Minimal Stitching Artifacts

Full HD Video Recording at 30 fps 8GB Internal Memory Built-In Wi-Fi Includes Theta Selfie Stick

(RIGR2) oo 589,99 [RITSB) 326.95 [RITSC*) . 199.95 RITV) o 429,95
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uo,,

[Nil@m. cooLPIX B7Uﬂ [Vilc@m. cooLPIXA900 [\Ifc@rm. COOLPIX B500

/0. COOLPIX P00

17
/ r’LU, Af

T6MP 1/2.3" BSI CMOS Sensor

NIKKOR f/3.0-6.5mm ED Lens
22.5-900mm (35mm Equivalent)

40x Optical Zoom Lens, 80x Dynamic Zoom

20MP 1/2.3" BSI CMOS Sensor

NIKKOR f/3.4-6.9 ED Lens

24-840mm (35mm Equivalent)

3bx Optical Zoom Lens, 70x Dynamic Zoom

20.2MP 1/2.3" BSI CMOS Sensor
NIKKOR Super ED 60x Optical Zoom Lens
24-1460mm (35mm Equivalent)
921k-Dot Electranic Viewfinder

16MP CMOS Sensor Produces Full HD 1080p
83 (24-2000mm) Optical Zoom
3" Vari-Angle TFT LCD Screen

Dual Detect Optical VR~ Wi-Fi, NFC, and GPS 3.0" 921k-Dot Vari-Angle LCD Monitor 3" 921k-Dot Tilting LCD 3" 921k-Dot Tilting LCD
(NICPP900B) 696.95 (NICPB700B] ... Call o Log-On [NICPA900S)........cc....Call or Log-On (NICPBBOOR) ... Call or Log-On
[\ife@rm. COOLPIX W300 i@, COOLPIX W100 [nJilia@rm. COOLPIX A300 [Nife@rm. cOOLPIXA10

16.TMP 1/2.3" CCD Sensor
bx Optical (26-130mm) Zoom Lens
2.7" 230k-Dat LCD Monitor

20.1MP 1/2.3" CCD Sensor
8x Optical Zoom, 16x Dynamic Fine Zoom
HD 720p Video Recording

16MP 1/2.3 BSI CMOS Sensor
NIKKOR 5x Optical Zoom Lens
24-120mm (35mm Equivalent)

13.2MP 1/3.1" CMOS Image Sensor
3x (30-90mm] Optical Zoom f/3.3-5.9 Lens
2.7" 230k-Dot Rear LCD Monitor

3.0" 921k-Dot LCD Monitor Water, Shock, Freeze & Dustproof 2.7" 230k-Dot LD Monitor HD 720p Video Recording .
Waterproof to 100", Shockproof to 7.9' SnapBridge with Wi-Fi, NFC, & Bluetooth SnapBridge Bluetooth and Wi-Fi with NFC 150 80-1600 ~ Electronic Vibration Reduction
(NICPW3000) ..o 386.95 (NICPW100BL) ... 15695 (NICPA300S). o 136.95 (NICPATOS) oo 86,95
* For all Nikon Point &
- Shoot accessories
-1 I p_— or visit BandH.com/w15121
For all Leica Point &
Nikon LD-1000 Nikon ME-W1 Leica Ever Ready Case Shoot accessories
LED Light Wireless Microphone Set Nikon Compact Camera Bag SF 40 Flash for X Vario
96.95 219.00 44.95 495.00 199.00 or visit BandH.com/w15127

feica (Typ116) feica yulrypn3) feica V-LUX(TypTie) Seica DLUX(Typ109)

24.2 MP Full-Frame CMOS Sensor

Leica Maestro Il Image Pracessor

Leica Summilux 28mm f/1.7 ASPH Lens
3.68 MP LCOS Electronic Viewfinder

3.0" 1,040k-Dot Touchscreen LCD Monitor

[LEQTTT6B) .. 4,250.00
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(LEXUTTR)

16.2MP APS-C CMOS Sensor

Summilux 23mm /1.7 ASPH. Lens

35mm (35mm Equivalent)

Water, Dust, and Shockproof Construction

3.0" 920k-Dot LCD Monitor

Full HD 1080p Video Recording at 30 fps
.3,295.00

20MP 1" MOS Sensor
DC Vario-Elmarit f/2.8-4.0 Lens
25-400mm Equivalent, 16x Optical Zoom
3" 920k-Dot Rotatable LCD Screen
UHD 4K 3840x2160
Built-in Wi-Fi and NFC

(LEVLUXB)

1,195.00

12.8MP 4/3" MOS Sensor

Leica DC Vario-Summilux f/1.7-2.8 Leica Lens
3.1% Zoom (24-75mm)

3.0" 920k-Dot LCD Monitor

Wi-Fi and NFC Connectivity

Includes Leica CF D External Flash

(LEDL109B) 1,095.00
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Panasonic.

Lumix DMC-LX10

20.TMP 1" MOS Sensor

20x (24-480mm) £/2.8-4.5 Lens

4K Ultra HD Video Recording plus 4K Phato
Modes and Post Focus

(PADMCFZ2500)

Panasonic.
Lumix DMC-ZS100

20.1MP 1" High Sensitivity MOS Sensor

10x (25-250mm) f/2.8-5.9 Optical Zoom Lens
1,166k-Dot Live View Finder

3.0" 1.04m-Dot Touchscreen LCD Monitor

[PADMCZS100S) ..o

Panasonic.
Lumix DMC-TS30

1,197.99

v 697.99

20.1MP HS MOS Sensor

T6x (25-400mm) £/2.8 Zoom Lens

3" 921k-dot Free-Angle LCD

Built-in Wi-Fi with NFC
(PADMCFZ1000B)

Panasonic.
Lumix DC-ZS70

797.99

12.8MP 4/3" Type Multi-Aspect MOS Sensor
Leica DC Vario-Summilux f/1.7-2.8 Lens
24-75mm (35mm Equivalent)

Built-in Wi-Fi Connectivity with NFC

(PADMCLX100S) . 197,99 (PADMCLXT0B) oo
Panasonic. Panasonic.
Lumix DMC-FZ300 Lumix DC-FZ80

20.1TMP 1" MOS Sensor
3x (24-72mm) £/1.4-2.8 Lens

3.0" 1.04m-Dot Tilting Touchscreen Monitor

4K Ultra HD Video Recording

.697.99

20.3MP 1/2.3" MOS Sensor
Leica DC Vario-Elmar 30x Zoom Lens
24-720mm (35mm Equivalent)
1.166m-Dot Live View Finder
(PADCZSTOS)..o oo 64T 99

RICOH
WG-50

16.1MP 1/2.3" CCD Sensor

4x Optical Zoom 25-100mm DC Vario Lens
2.7" 230k-dot TFT Color LCD Display
Waterproof to 26", Shock / Freeze / Dust Proof

(PADMCTS30BL) oo 177,99

SIGMA dp Quattro Series

dp0 Quattro: 14mm f/4 (SIC83900)............999.00
DP1 Quattro: 19mm f/2.8 (SIDP1Q) ......... 999.00
dp2 Quattro: 30mm f/2.8 (SIDP2Q) ... 879.00

dp3 Quattro: 50mm /2.8 (SIDP3) ............ Log-On
DPO Quattro/LVF-01 (SID0900) 1,099.00
dp1 Quattro/LVF-01(SIZE900) ... 999.00
dp?2 Quattro/LVF-01 (SIZF900) 999.00
dp3 Quattro/LVF-01(SIZ6900)..................999.00

16MP 1/2.3" CMOS Sensor

Ricoh bx Optical Zoom Lens

28-140mm (35mm Equivalent)

Water, Crush, Shock, Freeze & Dustproof

[RIWG500) 276.95

DMW-BCM13 DMW-FL360L
Lithium-lon External Flash
Battery Pack 209.00

39.95

12.1MP 1/2.3" MOS Sensor

24x (25-600mm) /2.8 Zoom Lens

3.0" 1.04m-Dot Free Angle Touchscreen
Built-In Wi-Fi Connectivity

[PADMCFZ300) ...occcoc

i 997,99

18.TMP 1/2.3" MOS Sensor

60x Zoom (35mm Equivalent: 20-1200mm)
3.0" 1.04m-Dot Touchscreen LCD Monitor

4K UHD Video Recording at 30 fps

(PADCFZ80B)

397.99

sqiiare

frade

$99.99

$124.99
$149.99
$174.99
$199.99
$249.99
$299.99
$349.99
$399.99
$449.99
$499.99
$599.99
$699.99

PROTECT YOUR CAMERA
WITH SQUARETRADE

2YEAR 3 YEAR
Drops & Spills Drops & Spills
WARRANTY WARRANTY

$16.99 $22.99

$19.99 $26.99

$23.99 $29.99

$29.99 $39.99

$33.99 $44.99

$39.99 $52.99

$46.99 $54.99

$49.99 $74.99

$60.99 $80.99

$71.99 $95.99

$78.99 $104.99

$95.99 $114.99

$100.99 $134.99

24/7 CUSTOMER SUPPORT

#1 TOP RATED

2 DAY SERVICE GUARANTEED
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SONY Cyber-shot DSC-RX10 IV

20.TMP 1" Exmor RS BSI CMOS Sensor

BIONZ X Image Processor & Front-End LSI

Zeiss Vario-Sonnar T* /2.4-4 Zoom Lens

24-600mm (35mm Equivalent)

2.36m-Dot OLED Tru-Finder EVF

3.0 Tilting Touchscreen LCD

UHD 4K30 Video, Full HD 1080p

at 960 fps

Fast Hybrid AF System with 315 Points
(SODSCRX10M4)

Cyber-shot DSC-RX10 1 (SODSCRXTOMB).........coocoooe

SONY
Cyber-shot DSC-RX10 11

20.2MP 1" Exmor RS BSI CMOS Sensor
3.0" 1228K-Dot Tilting Xtra Fine TFT LCD
Internal UHD 4K Video & S-Log2 Gamma
Carl Zeiss 24-200mm f/2.8 Lens (35mm Eq)

[SODSCRXT02) . 1,198.00

SONY
Cyber-shot DSC-HX80

18.2MP BSI Exmor R CMOS Sensor

BIONZ X Image Processor

Zeiss Vario-Sonnar 30x Optical Zoom Lens
24-720mm (35mm Equivalent)

(SODSCHXB0B) ... 368.00

SONY
Cyber-shot DSC-W830

20.1MP 1/2.3" Super HAD CCD Image Sensor
25-200mm Zeiss Vario Lens (35mm Equivalent)
2.7" 230k-Dot Clear Photo LCD Monitor

HD 1280 x 720 Video at 30 fps

[SODSCIWB30S) ... 118,00

108

20.TMP 1" Exmor RS BSI CMOS Sensor
BIONZ X Image Processor & Front-End LSI
Internal UHD 4K Video & S-Log2 Gamma
Zeiss Vario-Sonnar T* f/1.8-2.8 Lens
24-70mm (35mm Equivalent)

Fast Hybrid AF System with 315 Points
HFR Mode for Full HD Video up to 960 fps
3.0"1.23m-Dot 180° Tilting LCD

IS0 12800 and 24 fps Continuous Shooting
................................ 1,698.00

139800 Cyber-shotRXI00 IV (SODSCRKIOUA) ... 898.00
SONY SONY
Cyber-shot DSC-HX400V Cyber-shot DSC-H400

20.TMP 1/2.3" Super HAD CCD Sensor
63x Optical Zoom 24.5-1550mm Equivalent
360° Sweep Panorama

3" Clear Photo 460k-Dot LCD & Viewfinder

20.4MP 1/2.3" Exmor R CMOS Sensor
BIONZ X Image Processor

50x Optical Zoom Carl Zeiss Lens
24-1200mm Equiv. Focal Length

(SODSCHX400VB) 448.00 (SODSCHA400B) 268.00
SONY SONY
Cyber-shot DSC-WX500 Cyber-shot DSC-WX350

18.2MP Exmor R CMOS Sensor

20x Optical Zoom 4.3-86mm f/3.5-6.5 Lens
3" Clear Phato LCD 460k-Dot Monitor
Built-In Wi-Fi Connectivity & NFC

18.2MP BSI Exmor R CMOS Sensor

Zeiss Vario-Sonnar 30x Optical Zoom Lens
24-720mm (35mm Equivalent)
Built-in Wi-Fi and NFC

(SODSCWXB00B) oo 348.00

NP-BX1/M8
64GB High Speed UHS-I Rechargeable Lithium-lon
SDXC U3 Memory Card Battery Pack HVL-F20M External Flash
52.99 37.99 148.00

SONY Cyber-shot DSC-RX100V

Cyber-shot RX100 V (SODSCRX1005B) ... 998.00

(SODSCWX350B) .o 268.00

Cyber-shat RX100 Il (SODSCRX100M3) ... 748.00
Cyber-shot RX100 (SODSCRX1008) 448.00

SONY
Cyber-shot DSC-HX90V

18.2MP BSI Exmor R CMOS Sensor

Ieiss Vario-Sonnar 30 Optical Zoom Lens
24-720mm (35mm Equivalent)

Built-in Wi-Fiand GPS

(SODSCHX90VB) 448.00

SONY
Cyber-shot DSC-WX220

18.2MP Exmor R CMOS Sensor
BIONZ X Image Pracessor

10x Optical Zoom Sony G Lens
BBuilt-In Wi-Fi Connectivity & NFC

(SODSCWX2208) ..o 198.00

SONY
Cyber-shot DSC-W800

20.1 MP 1/2.3" Super HAD CCD Sensor
Optical 5x Zoom Lens & 10x Digital Zoom
Equivalent 35mm Focal Length: 26-130mm
2.7" Clear Photo LCD 230k-Dot Manitor

(SODSCW8008) 89.99





